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SYMANTEC LICENSE AND WARRANTY
IMPORTANT:  PLEASE READ THE TERMS AND CONDITIONS OF 
THIS LICENSE AGREEMENT CAREFULLY BEFORE USING THE 
SOFTWARE.  SYMANTEC CORPORATION AND/OR ITS 
SUBSIDIARIES ("SYMANTEC") IS WILLING TO LICENSE THE 
SOFTWARE TO YOU AS THE INDIVIDUAL, THE COMPANY, OR 
THE LEGAL ENTITY THAT WILL BE UTILIZING THE SOFTWARE 
(REFERENCED BELOW AS "YOU OR YOUR") ONLY ON THE 
CONDITION THAT YOU ACCEPT ALL OF THE TERMS OF THIS 
LICENSE AGREEMENT.  THIS IS A LEGAL AND ENFORCEABLE 
CONTRACT BETWEEN YOU AND SYMANTEC.  BY OPENING 
THIS PACKAGE, BREAKING THE SEAL, CLICKING ON THE 
"AGREE" OR "YES" BUTTON OR OTHERWISE INDICATING 
ASSENT ELECTRONICALLY, OR LOADING THE SOFTWARE, 
YOU AGREE TO THE TERMS AND CONDITIONS OF THIS 
AGREEMENT.  IF YOU DO NOT AGREE TO THESE TERMS AND 
CONDITIONS, CLICK ON THE "I DO NOT AGREE", "NO" 
BUTTON, OR OTHERWISE INDICATE REFUSAL, MAKE NO 
FURTHER USE OF THE SOFTWARE, AND RETURN THE FULL 
PRODUCT WITH PROOF OF PURCHASE TO THE DEALER FROM 
WHOM IT WAS ACQUIRED WITHIN SIXTY (60) DAYS OF 
PURCHASE, AND YOUR MONEY WILL BE REFUNDED.

1. LICENSE:
The software which accompanies this license (collectively the 
"Software") is the property of Symantec or its licensors and is protected 
by copyright law.  While Symantec continues to own the Software, You 
will have certain rights to use the Software after Your acceptance of this 
license.  This license governs any releases, revisions, or enhancements 
to the Software that Symantec may furnish to You.  Except as may be 
modified by a Symantec license certificate, license coupon, or license 
key (each a "License Module")  which accompanies, precedes, or 
follows this license, Your rights and obligations with respect to the use 
of this Software are as follows:

YOU MAY:
A. use one copy of the Software on a single computer.  If a License 
Module accompanies, precedes, or follows this license, You may make 
that number of copies of the Software licensed to You by Symantec as 
provided in Your License Module. Your License Module shall 
constitute proof of Your right to make such copies.
B. make one copy of the Software for archival purposes, or copy the 
Software onto the hard disk of Your computer and retain the original 
for archival purposes;
C. use the Software on a network, provided that You have a licensed 
copy of the Software for each computer that can access the Software 
over that network;
D. after written notice to Symantec, transfer the Software on a 
permanent basis to another person or entity, provided that You retain 
no copies of the Software and the transferee agrees to the terms of this 
license; and
E. use the Software in accordance with any additional permitted uses 
set forth in Section 9, below.

YOU MAY NOT:
A. copy the printed documentation which accompanies the Software; 
B. sublicense, rent or lease any portion of the Software; reverse 
engineer, decompile, disassemble, modify, translate, make any attempt 
to discover the source code of the Software, or create derivative works 
from the Software; 
C. use a previous version or copy of the Software after You have 
received a disk replacement set or an upgraded version. Upon 
upgrading the Software, all copies of the prior version must be 
destroyed; 

D. use a later version of the Software than is provided herewith unless 
You have purchased upgrade insurance or have otherwise separately 
acquired the right to use such later version;
E. use, if You received the software distributed on media containing 
multiple Symantec products, any Symantec software on the media for 
which You have not received a permission in a License Module;  
F. use the Software in any manner not authorized by this license; nor
G. use the Software in any manner that contradicts any additional 
restrictions set forth in Section 9, below.

2. CONTENT UPDATES:
Certain Symantec software products utilize content that is updated 
from time to time (antivirus products utilize updated virus definitions; 
content filtering products utilize updated URL lists; firewall products 
utilize updated firewall rules; vulnerability assessment products utilize 
updated vulnerability data, etc.; collectively, these are referred to as 
"Content Updates").  You may obtain Content Updates for any period 
for which You have purchased a subscription for Content Updates for 
the Software (including any subscription included with Your original 
purchase of the Software), purchased upgrade insurance for the 
Software, entered into a maintenance agreement that includes Content 
Updates, or otherwise separately acquired the right to obtain Content 
Updates.  This license does not otherwise permit You to obtain and use 
Content Updates.

3. SIXTY (60) DAY MONEY BACK GUARANTEE:
If You are the original licensee of this copy of the Software and are not 
completely satisfied with it for any reason, please contact Symantec 
Customer Service, for a refund of the money You paid for the Software 
(less shipping, handling, and any applicable taxes) at any time during 
the sixty (60) day period following the date of purchase.

.4. LIMITED WARRANTY:
Symantec warrants that the media on which the Software is distributed 
will be free from defects for a period of sixty (60) days from the date of 
delivery of the Software to You. Your sole remedy in the event of a 
breach of this warranty will be that Symantec will, at its option, replace 
any defective media returned to Symantec within the warranty period 
or refund the money You paid for the Software.  Symantec does not 
warrant that the Software will meet Your requirements or that 
operation of the Software will be uninterrupted or that the Software 
will be error-free.
THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL 
OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT OF INTELLECTUAL PROPERTY 
RIGHTS.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM 
STATE TO STATE AND COUNTRY TO COUNTRY.

5. DISCLAIMER OF DAMAGES:
SOME STATES AND COUNTRIES, INCLUDING MEMBER 
COUNTRIES OF THE EUROPEAN ECONOMIC AREA, DO NOT 
ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE BELOW 
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW 
AND REGARDLESS OF WHETHER ANY REMEDY SET FORTH 
HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT WILL 
SYMANTEC OR ITS LICENSORS BE LIABLE TO YOU FOR ANY 
SPECIAL, CONSEQUENTIAL, INDIRECT OR SIMILAR DAMAGES, 
INCLUDING ANY LOST PROFITS OR LOST DATA ARISING OUT 



OF THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF 
SYMANTEC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.
IN NO CASE SHALL SYMANTEC'S OR ITS LICENSORS' LIABILITY 
EXCEED THE PURCHASE PRICE FOR THE SOFTWARE.  The 
disclaimers and limitations set forth above will apply regardless of 
whether You accept the Software.

6. U.S. GOVERNMENT RESTRICTED RIGHTS:
RESTRICTED RIGHTS LEGEND. All Symantec products and 
documentation are commercial in nature.  The software and software 
documentation are "Commercial Items", as that term is defined in 48 
C.F.R. section 2.101, consisting of "Commercial Computer Software" 
and "Commercial Computer Software Documentation", as such terms 
are defined in 48 C.F.R. section 252.227-7014(a)(5) and 48 C.F.R. 
section 252.227-7014(a)(1), and used in 48 C.F.R. section 12.212 and 
48 C.F.R. section 227.7202, as applicable.  Consistent with 48 C.F.R. 
section 12.212, 48 C.F.R. section 252.227-7015, 48 C.F.R. section 
227.7202 through 227.7202-4, 48 C.F.R. section 52.227-14, and other 
relevant sections of the Code of Federal Regulations, as applicable, 
Symantec's computer software and computer software documentation 
are licensed to United States Government end users with only those 
rights as granted to all other end users, according to the terms and 
conditions contained in this license agreement.  Manufacturer is 
Symantec Corporation, 20330 Stevens Creek Blvd., Cupertino, CA  
95014.

7. EXPORT REGULATION:
Export, re-export of this Software is governed by the laws and 
regulations of the United States and import laws and regulations of 
certain other countries.  Export or re-export of Software to any entity 
on the Denied Parties List and other lists promulgated by various 
agencies of the United States Federal Government is strictly prohibited.

8. GENERAL:
If You are located in North America or Latin America, this Agreement 
will be governed by the laws of the State of California, United States of 
America. Otherwise, this Agreement will be governed by the laws of 
England.  This Agreement and any related License Module is the entire 
agreement between You and Symantec relating to the Software and:  (i) 
supersedes all prior or contemporaneous oral or written 
communications, proposals and representations with respect to its 
subject matter; and (ii) prevails over any conflicting or additional 
terms of any quote, order, acknowledgment or similar 
communications between the parties.  This Agreement may only be 
modified by a License Module or by a written document which has 
been signed by both You and Symantec.  This Agreement shall 
terminate upon Your breach of any term contained herein and You 
shall cease use of and destroy all copies of the Software.  The 
disclaimers of warranties and damages and limitations on liability shall 
survive termination.  Should You have any questions concerning this 
Agreement, or if You desire to contact Symantec for any reason, please 
write: (i) Symantec Customer Service, 555 International Way, 
Springfield, OR 97477, USA, or (ii) Symantec Customer Service 
Center, PO BOX 5689, Dublin 15, Ireland.  

9. ADDITIONAL USES AND RESTRICTIONS:
Notwithstanding any of the terms and conditions contained in the 
Symantec Corporation Software License Agreement, the following 
additional terms apply to the product you have purchased.  You may:
(i) use the Software on one computer to clone, or apply an image of, a 
hard drive on that computer, or a portion thereof, to another hard 
drive on the same computer, a replacement computer, secondary 

media, or network drive.  If a License Module accompanies, precedes, 
or follows this license, you may make and use that number of copies of 
the Software licensed to you by Symantec as provided in your License 
Module on an equal number of individual computers pursuant to the 
terms of this license. Your License Module shall constitute proof of 
your right to make and use such copies;
(ii) use the Software on that same computer to create an image file of a 
hard drive on that computer and store the image file on removable 
media for disaster recovery purposes;
(iii) use the Software to create a boot disk as described in the 
documentation for reapplying the hard drive image that was created 
for disaster recovery purposes to the hard drive on that same 
computer; and
(iv) use the Software to clone a hard drive from that same computer to 
a replacement computer, in the manner described in the software 
documentation, and to use the Software on the replacement computer 
provided that the Software has been removed from the original 
computer.
You may not use the Software commercially or non-commercially for 
the purpose of creating multiple computers or hard drives not 
connected to the original computer, with similar or identical 
configurations to that of the original computer or hard drive.
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Chapter
 1
About Norton Ghost

This chapter includes the following topics:

■ Introducing Norton Ghost

■ What’s new in Norton Ghost 2003

■ How Norton Ghost works

■ Norton Ghost components
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Introducing Norton Ghost
Introducing Norton Ghost
Norton Ghost protects your data from computer disasters. The intuitive 
Windows interface lets you create backup images of your hard disk or selected 
partitions. You can clone directly between two computers using a network, USB, 
or parallel connection. Norton Ghost is based on the robust cloning technology 
of Symantec Ghost Enterprise. 

Norton Ghost includes the following features:

■ Backup flexibility: Back up directly to a wide range of hard drives and 
removable media, including CD-R/RW drives, FireWire and USB hard 
drives, DVD devices, Iomega, ZIP, and JAZ drives.

■ Peer-to-peer communication: Fast peer-to-peer communication using high-
speed parallel, USB, or network IP connections.

■ Operating system support: You can back up, restore, or clone computers 
installed with DOS, Windows 2000/XP/NT/9x, OS/2, or Linux.

■ File system support: You can back up, restore, or clone FAT, FAT32, NTFS, 
and Linux Ext2/3 file systems.

■ Image file editing: Ghost Explorer lets you edit FAT and FAT32 image files.

■ Restore individual files: Ghost Explorer lets you restore individual files from 
an image file.

■ Disk and partition management: You can run GDisk from DOS or in a 
command shell from within Windows to manage partitions and disks.

■ Tutorials: A set of tutorials is included in Norton Ghost to provide a 
demonstration of the most commonly used functions.

What’s new in Norton Ghost 2003
■ Windows user interface: You can launch Norton Ghost directly from 

Windows without having to restart your computer. 

■ Virtual Partition: Eliminates the need for a boot disk in most situations.

■ Linux support: You can back up, restore, and clone EXT3 file systems. 

■ NTFS support: Norton Ghost now writes to NTFS partitions. You can store 
an image file on an NTFS drive and restore from an image file located on an 
NTFS drive.
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How Norton Ghost works
■ Mapped network drives: A computer on a network can be mapped to a drive 
letter. This lets Norton Ghost see the computer as a local drive and back up to 
and restore from it.

■ Ghost Walker: This utility lets you update Security Identifiers (SID) and 
computer names. Ghost Walker was previously available only in Symantec 
Ghost, the corporate version of Norton Ghost.

■ Support for FireWire, USB 1.1, USB 2.0: You can now use Norton Ghost to 
back up, restore, and clone to and from FireWire, USB 1.1, and 2.0 devices, 
including hard disks and supported CD-R/RW and DVD drives.

■ DVD support: You can use Norton Ghost to back up to and restore from 
supported DVD+ R/RW and DVD-R/RW drives.

■ Expanded CD-R/RW support: The CD-R/RW drives supported by Norton 
Ghost have been increased to include most new drives.

■ Large drive support: Norton Ghost supports backing up, restoring, and 
cloning IDE drives larger than 128 GB.

How Norton Ghost works
The basis of Norton Ghost is a cloning function that creates an image file that 
contains all of the information required to recreate a complete disk or partition. 
Image files contain a backup copy of an entire drive or one or more partitions. 
The image file can be restored to one or more partitions or disks, replacing 
existing data. 

Virtual Partition
The Virtual Partition is a partition that is created when you perform a backup, 
restore, clone, or other operation from Windows. All the files required for the 
backup, restore, or clone are automatically installed into the Virtual Partition and 
the task performed. Most of the Virtual Partition operation is not apparent to 
you. However, there may be some occasions when you must know what the 
Virtual Partition is and what it does, such as if you want to run Ghost.exe or 
another application from the Virtual Partition.

One primary partition slot must be available in the MBR for the Virtual Partition.
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How Norton Ghost works
Hardware restrictions
Norton Ghost is designed to restore to and clone identical hardware. When 
Microsoft Windows is installed, drivers necessary to support your hardware are 
installed to the hard disk and recorded in the Windows Registry. If you move an 
installation of Windows to another computer, either by directly moving the hard 
disk or copying it using a Ghost operation, there is no guarantee that it will boot 
or function correctly. Although Microsoft provides tools, such as Sysprep, that 
may alleviate these problems to volume license holders, these tools are usually 
unavailable to consumer or small business users. 

A computer with Windows installed should be copied to a computer with 
identical hardware. Moving or cloning file systems that do not contain an 
operating system does not usually present a problem.

Preparing for an emergency
After you have installed Norton Ghost and created a backup image, you must 
create and test a recovery boot disk for use in an emergency. If you experience a 
critical failure and cannot start your computer, then you must have a recovery 
boot disk. This lets you start your computer in DOS and run Norton Ghost to 
restore your computer.

Note: If you saved your image file directly to CD or DVD, then you do not need a 
recovery boot disk. Norton Ghost includes Ghost.exe if you save the image file to 
CD or DVD.
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Norton Ghost components
There are two methods of restoring your computer:

■ Norton Ghost

If you are able to start in Windows, then you may be able to run Norton 
Ghost from Windows on your hard disk and restore your computer with the 
latest backup image file that you have created.

See “Restoring your computer from an image file” on page 37.

■ Ghost.exe

If you cannot start Windows, then you must start your computer from a 
recovery boot disk or CD/DVD. This starts your computer and starts Norton 
Ghost in DOS. From Norton Ghost, you can access your image file and 
restore your computer to the latest backup image file.

See “Restoring from an image file” on page 101.

The Ghost Boot Wizard helps you create a recovery boot disk.

See “Creating boot disks and boot images” on page 75.

Warning: Create and test a recovery boot disk before you need it. If your 
computer crashes and you do not have a recovery boot disk, then you will have to 
find another computer on which to create a boot disk.

Norton Ghost components
Norton Ghost includes a number of products and utilities. 

Norton Ghost wizards
Norton Ghost includes Windows wizards to guide you through the basic tasks.
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Norton Ghost components
These wizards include:

Backup Wizard
The Backup Wizard lets you select a hard disk or partition to back up to an image 
file.

Restore Wizard
The Restore Wizard lets you restore a hard disk or partition from an image file.
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Clone Wizard
The Clone Wizard lets you clone a hard disk or partition directly from another 
hard disk or partition.

Peer-to-Peer Wizard
The Peer-to-Peer Wizard starts Ghost.exe in the Virtual Partition with the peer-
to-peer drivers loaded.
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Create Virtual Partition Wizard
The Create Virtual Partition Wizard restarts your computer in the Virtual 
Partition in DOS with files from a selected directory. This enables you to run 
DOS applications.

Run Ghost Interactively Wizard
The Run Ghost Interactively Wizard restarts your computer in DOS and runs 
Ghost.exe.

Integrity Check
The image integrity check runs an integrity check on backup image files.
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View Log
View Log lets you view logs created during Norton Ghost operations.

Norton Ghost executable
Ghost.exe runs in DOS and lets you back up, restore, and clone. Because the 
executable is small with minimal conventional memory requirements, you can 
run it easily from a DOS boot disk or hard drive. 



22 About Norton Ghost
Norton Ghost components
Ghost Boot Wizard
The Ghost Boot Wizard is a Windows application that creates boot disks that 
start Norton Ghost when you turn on your computer. You can create boot disks 
for various cloning tasks. The wizard guides you through adding the drivers that 
are needed to create a boot disk.

Ghost Explorer
Ghost Explorer is a Windows application that lets you view directories and files in 
an image file. You can also add, recover, and delete individual directories and files 
from a FAT16/32 file system image file.
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Note: You can restore individual files from NTFS images, but you cannot update 
NTFS images.

GDisk
GDisk is a complete replacement for the Microsoft FDISK and FORMAT utilities 
that allows the following:

■ FAT file system formatting

■ Batch mode operation

■ Hiding and unhiding of partitions

■ Secure disk wiping to US Department of Defense standards

■ Extensive partition reporting 

■ Boot.ini manipulation (GDisk32 only)

Two versions of GDisk are supplied:

■ GDisk: Runs in DOS

■ GDisk32: Runs from the command prompt in a Windows operating system
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Ghost Walker
Ghost Walker assigns a statistically unique security identifier (SID) and a unique 
computer name to cloned Microsoft Windows NT/2000/XP workstations. The 
SID is an important part of the Windows NT/2000/XP security architecture as it 
provides a unique identifier when these computers are networked. If you are 
cloning more than one computer using the multiuser pack, you can use Ghost 
Walker to set up each computer on a network with a unique identification, which 
is mandatory on a Microsoft network.



Chapter
 2
Installing Norton Ghost

This chapter includes the following topics:

■ Minimum system requirements

■ Installing Norton Ghost

■ Updating Norton Ghost

■ Uninstalling Norton Ghost
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Minimum system requirements
To install and run Norton Ghost, the minimum requirements are as follows:

■ IBM computer or 100% compatible

■ 486 processor

■ VGA monitor (Super VGA recommended)

■ 16 MB RAM (32 MB RAM recommended)

■ Microsoft-compatible mouse recommended

■ Microsoft Windows 98/2000/Me/XP or Microsoft Windows NT4 SP6a

■ Internet Explorer 5

Ghost.exe
Ghost.exe must be installed on a computer with the Norton Ghost minimum 
requirements. However, you can run Ghost.exe on a computer with the following 
minimum requirements:

■ IBM PC computer or 100% compatible

■ 486 processor

■ 16 MB RAM

■ VGA monitor

■ Microsoft-compatible mouse recommended

CD and DVD writing
■ CD or DVD writer supported by Norton Ghost

Supported backup media
In addition to saving a backup to a secondary partition or an internal hard disk, 
Norton Ghost can also save a backup to the following external media devices:

■ CD-R/RW

■ DVD+RW/-RW/+R/-R

■ USB 1.1/2.0 hard drive and CD/DVD recordable devices

■ FireWire (iEEE) 1394 hard drive and CD/DVD recordable devices
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■ Atapi tape (QIC157) devices

■ SCSI tape

■ A second computer using a peer-to-peer connection

■ Mapped network drive

■ ZIP drive

■ JAZ drive

To determine whether your device is supported by Norton Ghost, check that your 
device is listed on the Symantec support Web site.

http:\\www.ghost.com

File systems supported for backup, restore, and cloning tasks
■ All FAT

■ All NTFS

■ EXT2/3

See “Cloning with Linux” on page 187.

Disaster recovery requirements
To restore a backup image in the event of an operating system or hard disk 
failure, you must have one of the following recovery mechanisms in place before 
the emergency occurs:

■ Floppy disk drive and floppy disk with the correct drivers for the selected 
backup device

■ CD or DVD device and a bootable CD-ROM with the backup image created 
by Norton Ghost

See “Preparing for an emergency” on page 16.

Installing Norton Ghost
The installation instructions for Norton Ghost differ depending on how you have 
purchased Norton Ghost:

■ As a part of Norton SystemWorks Pro

■ Norton Ghost 2003
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Installing Norton Ghost if purchased with Norton SystemWorks Pro
If you have purchased Norton Ghost as part of Norton SystemWorks Pro, then 
Norton Ghost is installed from the Norton SystemWorks Pro CD.

To install Norton Ghost from Norton SystemWorks

1 Insert the Norton SystemWorks 2003 CD into the CD-ROM drive.

2 In the Norton SystemWorks 2003 window, click Install Norton SystemWorks 
2003.

3 Click OK to accept the Virus detection message.

4 Click Next.

5 In the License Agreement window, click I accept the license agreement, and 
then click Next.

If you select I do not accept the license agreement, you cannot continue with 
the installation.

6 Confirm the installation location.

To select a different location for the installed files, click Browse.

7 Click Next.

8 Select an installation type:

■ Typical: The most common programs are installed. This is the best 
choice for most users. 

■ Complete: All programs are installed. This is the best choice for users 
who want to take advantage of all the product features. 

■ Express: The most common programs are installed with the default 
settings and fewer prompts.

9 In the Select Features window, select Norton Ghost 2003 and click one of the 
following:

■ Will be installed on local hard drive

■ Entire feature will be installed on local hard drive

To install only Norton Ghost, click the other Norton SystemWorks 
components and select Entire feature will be unavailable.

10 Click Next.

11 Continue with the type of installation you chose. After installation, you may 
receive a prompt telling you that your computer needs to be restarted for the 
updates to take effect.
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Installing Norton Ghost
If you have purchased Norton Ghost separately from Norton SystemWorks Pro, 
then Norton Ghost is installed from the Norton Ghost CD.

To install Norton Ghost from the Norton Ghost CD

1 Insert the Norton Ghost CD into the CD-ROM drive.

2 In the Norton Ghost 2003 window, click Install Norton Ghost 2003.

3 In the Norton Ghost 2003 - InstallShield Wizard window, click Next.

4 In the License Agreement window, click I accept the license agreement, and 
then click Next.

If you select I do not accept the license agreement, you cannot continue with 
the installation.

5 In the User name field, type a user name.

6 In the Organization field, type an organization, if you belong to one.

7 Click Next.

8 Confirm the installation location.

To select a different location for the installed files, click Change.

9 Click Next.

10 Click Install to start the installation.

If the opening screen does not appear
Sometimes, a computer’s CD-ROM drive does not automatically start a CD. 

To start the installation from the Norton Ghost CD

1 On your desktop, double-click My Computer.

2 In the My Computer dialog box, double-click the icon for your CD-ROM 
drive.

3 From the list of files, double-click Ncdstart.exe.

Registering Norton Ghost
To stay informed of upcoming Symantec products, please fill out the details for 
registration of Norton Ghost. If you choose not to register the software using the 
Information Wizard or if registration fails for some reason, you can register on 
the Symantec Web site at www.symantec.com or by using the Product 
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Registration option in the Help menu in the Norton Ghost window. On the Web 
site, go to the Products page for the registration link. 

To register Norton Ghost

1 In the first Registration window, select the country from which you are 
registering and the country in which you live (if different), and then click 
Next.

2 If you would like information from Symantec about Norton Ghost, select the 
method by which you want to receive that information, and then click Next.

3 Type your name and whether you want Norton Ghost registered to you or 
your company, and then click Next.

4 Type your address, and then click Next.

5 Do one of the following:

■ Answer the survey questions to help Symantec improve its products and 
services, and then click Next.

■ Skip the survey by clicking Next.

6 Select whether you want to register Norton Ghost through the Internet or by 
mail. 

■ If you want to register by mail, your computer must be connected to a 
printer that the Information Wizard can use to print the registration 
form. 

■ If you want to register using the Internet, you must be connected to the 
Internet.

7 Click Next.

If you submitted your registration through the Internet, the Information 
Wizard displays the serial number for your product.

8 Write down the serial number or click Print to get a copy of your registration 
information for future reference.

9 Click Next.

10 Select whether you want to use your existing profile the next time you 
register a Symantec product or type the information as part of registration. 

11 Click Finish.
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Updating Norton Ghost
Symantec may provide updates for Norton Ghost. Symantec does not charge for 
these updates. However, your normal Internet access fees apply.

To update Norton Ghost using LiveUpdate

1 On the Windows taskbar, click Start > Programs > Norton Ghost 2003 > 
Norton Ghost.

2 Click LiveUpdate.

3 Follow the on-screen instructions.

Uninstalling Norton Ghost
Norton Ghost is uninstalled from the Control Panel in Windows.

To uninstall Norton Ghost

1 On the Windows taskbar, click Start > Settings > Control Panel.

2 In the Control Panel window, double-click Add/Remove Programs.

3 Click Norton Ghost.

4 Click Remove.
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Uninstalling Norton Ghost



Chapter
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Backing up, restoring, 
and cloning from Norton 
Ghost

This chapter includes the following topics:

■ When to use Norton Ghost in Windows

■ Starting Norton Ghost in Windows

■ Creating a backup image file

■ Restoring your computer from an image file

■ Cloning a hard disk or partition

■ Launching Ghost.exe peer-to-peer

■ Identifying a hard disk
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When to use Norton Ghost in Windows
When to use Norton Ghost in Windows
Use Norton Ghost in Windows to do the following:

■ Back up your computer

■ Restore an image file onto your computer

You can use the Restore Wizard to restore an image file if you can still start 
Windows.

■ Clone a hard disk or partition directly to another hard disk or partition

Do not use Norton Ghost in Windows for the following tasks. Use Ghost.exe in 
DOS for any of the following:

■ If you cannot start Windows on your computer

See “Restoring from an image file” on page 101.

■ Cloning a computer that does not have Windows installed

See “Cloning disks and partitions” on page 104.

Note: Sometimes the drive letter in Norton Ghost in DOS does not match the 
drive letter in Windows. 

For example: 

You back up to a file, F:\test.gho. When you execute a backup task, the backup 
appears in Ghost.exe as E:\test.gho.

Starting Norton Ghost in Windows
Before starting Norton Ghost, close all open programs.
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Starting Norton Ghost in Windows
To start Norton Ghost in Windows

◆ Do one of the following:

■ On the Windows taskbar, click Start > Programs > Norton Ghost 2003 
> Norton Ghost.

■ On the Windows XP taskbar, click Start > All Programs > Norton 
Ghost 2003 > Norton Ghost.

Starting Norton Ghost from the tray icon
By default, Norton Ghost displays a single Windows tray icon in the system 
notification area at the end of the Windows 9x/Me/NT/2000/XP taskbar. Use the 
tray icon as a shortcut to open the Backup, Restore, and Clone Wizards. 
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Creating a backup image file
From the tray icon you can initiate any of the following tasks:

■ Launch Norton Ghost

■ Run the Restore Wizard

■ Run the Backup Wizard

■ View the task log

To start Norton Ghost from the tray icon

1 Move your mouse cursor over the Norton Ghost tray icon.

2 Right-click the tray icon.

3 On the tray icon menu, click the option that you want.

Creating a backup image file
You can create a backup image file of your hard disk or one or more partitions 
using the Backup Wizard.

To back up a hard disk or partition

1 In the Ghost Basic window, click Backup, and then click Next.

2 In the Backup Wizard window, in the Source pane, do one of the following:

■ Select a whole disk to back up.

■ Select one or more partitions to back up.

The partitions must reside on the same disk.

3 Do one of the following:

■ Click File to back up to a file.

■ Click Recordable CD or DVD to back up to a CD or DVD drive.

Norton Ghost selects the CD or DVD drive that contains writable 
media.

4 Click Next.

5 If you selected to back up to a file, click Browse to select a destination and file 
name to which the disk or partition(s) is to be backed up.

6 Click Next.
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7 If this is the first time that you have used Norton Ghost on this computer, in 
the Add Ghost Disk Identification dialog box, identify the disk.

See “Identifying a hard disk” on page 43.

If you have previously used Norton Ghost on this computer, then this dialog 
box does not appear.

8 If you want to set advanced settings for the backup, then click Advanced 
Settings.

See “Setting Norton Ghost options and defaults” on page 46.

9 Click Next.

10 In the Important Information dialog box, if you do not want to view this 
warning again, click Don’t show this screen again, and then click Next.

11 In the Disaster Recovery dialog box, click Continue.

This dialog box warns you to ensure that you can run Ghost.exe and access 
your image file once it has been created. You may need to create a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

12 Select one of the following:

■ Run Now: Creates the backup image file.

Your computer is restarted and the backup image file is created.

■ Disaster Recovery: Starts the Ghost Boot Wizard and creates a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

Restoring your computer from an image file
You can restore a hard disk or a partition from an image file stored on another 
hard disk, partition, or external media using the Restore Wizard from within 
Windows.

If you cannot start Windows, then you must use Ghost.exe to restore your hard 
disk or partition.

See “Restoring from an image file” on page 101.
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To restore a disk or partition

1 In the Ghost Basic window, click Restore, and then click Next.

2 In the Restore Wizard window, click Browse, and find the image file from 
which to restore.

3 If you want to view the contents of the image file in Ghost Explorer, click 
Open image in Ghost Explorer.

See “Viewing image files” on page 119.

4 Click Next.

5 In the left pane, select the image file or partition within the image file to 
restore.

6 In the right pane, select the destination hard disk or partition that is to be 
overwritten.

7 Click Next.

8 The Overwrite partition warning dialog box appears if you are overwriting 
any of the following:

■ The current Windows partition

■ The Ghost installation

Click Next to continue.

9 If this is the first time that you have used Norton Ghost on this computer, in 
the Add Ghost Disk Identification dialog box, identify the disk.

See “Identifying a hard disk” on page 43.

If you have previously used Norton Ghost on this computer, then this dialog 
box does not appear.

10 If you want to set advanced settings for the restore, then click Advanced 
Settings.

See “Setting Norton Ghost options and defaults” on page 46.

11 Click Next.

12 In the Important Information dialog box, if you do not want to view this 
warning again, click Don’t show this screen again, and then click Next.

13 Click Run Now to restore the image file to the selected hard disk or partition.

Your computer is rebooted and the restore operation completed.

Warning: The destination disk or partition is completely overwritten with 
no chance of recovering any data.
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Cloning a hard disk or partition
You can clone a hard disk directly to another hard disk or a partition directly to 
another partition.

To create a clone task

1 In the Ghost Advanced window, click Clone, and then click Next.

2 In the Clone Wizard window, in the left pane, do one of the following:

■ Click a disk to select it as the source for the clone operation.

■ Click a partition to select it as the source for the clone operation.

3 In the right pane, do one of the following:

■ Click a disk to select it as the destination for the clone operation.

■ Click a partition to select it as the destination for the clone operation.

Warning: The destination disk or partition is completely overwritten with 
no chance of recovering any data.

4 Click Next.

5 The Overwrite partition warning dialog box appears if you are overwriting 
any of the following:

■ The current Windows partition

■ The Ghost installation

Click Next to continue.

6 If this is the first time that you have used Norton Ghost on this computer, in 
the Add Ghost Disk Identification dialog box, identify the disk.

See “Identifying a hard disk” on page 43.

If you have previously used Norton Ghost on this computer, then this dialog 
box does not appear.

7 If you want to set advanced settings for the clone, then click Advanced 
Settings.

See “Setting Norton Ghost options and defaults” on page 46.

8 Click Next.
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9 In the Important Information dialog box, if you do not want to view this 
warning again, click Don’t show this screen again, and then click Next.

10 Click Run Now to start the clone operation.

Ensure that all applications on your computer are closed before you run the 
clone operation.

Your computer is restarted and the destination hard disk or partition is 
cloned from the source hard disk or partition.

Launching Ghost.exe peer-to-peer
From Norton Ghost you can launch Ghost.exe over a USB, LPT, or TCP/IP peer-
to-peer connection. Once you have established the settings for the connection, 
Ghost.exe launches ready for you to establish a connection.

Both computers must be running Ghost.exe for you to make the peer-to-peer 
connection. On your second computer, you can run Norton Ghost as described 
in this section, or you can restart it from a Peer-to-Peer Network Boot Disk or 
Standard Boot Disk.

See “Boot disks with network support” on page 79 and “Standard boot disks” on 
page 76.

To run Ghost.exe peer-to-peer

To run Ghost.exe peer-to-peer using USB

1 In the Ghost Basic window, click Ghost Advanced, and then click Peer-to-
Peer.

2 Click USB peer-to-peer.

3 Click Next.

4 If you want to set advanced settings, then click Advanced Settings.

See “Setting Norton Ghost options and defaults” on page 46.

5 If you want to set advanced USB peer-to-peer settings, then click USB driver 
settings.

See “Installing USB peer-to-peer drivers” on page 57.

6 In the Important Information dialog box, if you do not want to view this 
warning again, click Don’t show this screen again, and then click Next.
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7 In the Disaster Recovery window, select one of the following:

■ Launch Tutorials: Opens the tutorial index.

From the tutorials, you can select a tutorial that demonstrates how to 
create a recovery boot disk.

■ Continue: Returns to the Create Task dialog box.

This dialog box warns you to ensure that you can run Ghost.exe and access 
your image file once it has been created. You may need to create a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

8 Select one of the following:

■ Run Now: Restarts your computer into DOS and starts Ghost.exe.

■ Disaster Recovery: Starts the Ghost Boot Wizard and creates a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

To run Ghost.exe peer-to-peer using TCP

1 In the Ghost Basic window, click Ghost Advanced, and then click Peer-to-
Peer.

2 Click TCP peer-to-peer.

3 Click Next.

4 If you want to set advanced settings, then click Advanced Settings.

See “Setting Norton Ghost options and defaults” on page 46.

5 If you want to set TCP/IP driver settings, then click TCP/IP Driver Settings.

See “Setting TCP/IP drivers” on page 54.

6 In the Important Information dialog box, if you do not want to view this 
warning again, click Don’t show this screen again, and then click Next.
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7 In the Disaster Recovery window, select one of the following:

■ Launch Tutorials: Opens the tutorial index.

From the tutorials, you can select a tutorial that demonstrates how to 
create a recovery boot disk.

■ Continue: Returns to the Create Task dialog box.

This dialog box warns you to ensure that you can run Ghost.exe and access 
your image file once it has been created. You may need to create a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

8 Select one of the following:

■ Run Now: Restarts your computer into DOS and starts Ghost.exe.

■ Disaster Recovery: Starts the Ghost Boot Wizard and creates a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

To run Ghost.exe peer-to-peer using LPT

1 In the Ghost Basic window, click Ghost Advanced, and then click Peer-to-
Peer.

2 Click LPT peer-to-peer.

3 Click Next.

4 If you want to set advanced settings, then click Advanced Settings.

See “Setting Norton Ghost options and defaults” on page 46.

5 If you want to set advanced LPT peer-to-peer driver settings, then click LPT 
driver settings.

See “Setting LPT peer-to-peer drivers” on page 55.

6 In the Important Information dialog box, if you do not want to view this 
warning again, click Don’t show this screen again, and then click Next.
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7 In the Disaster Recovery window, select one of the following:

■ Launch Tutorials: Opens the tutorial index.

From the tutorials you can select a tutorial that demonstrates how to 
create a recovery boot disk.

■ Continue: Returns to the Create Task dialog box.

This dialog box warns you to ensure that you can run Ghost.exe and access 
your image file once it has been created. You may need to create a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

8 Select one of the following:

■ Run Now: Restarts your computer into DOS and starts Ghost.exe.

■ Disaster Recovery: Starts the Ghost Boot Wizard and creates a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

Identifying a hard disk
Before you can use Norton Ghost on a hard disk, Norton Ghost must identify the 
disk. You can do this during any backup, restore, or clone operation.

This dialog box appears during a backup, restore, or clone operation if you have 
not previously identified the hard disk.

To identify a disk

◆ In the Add Ghost Disk Identification dialog box, click OK to identify all hard 
disks.
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Identifying a hard disk
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Setting options and 
defaults

This chapter includes the following topics:

■ Setting Norton Ghost options and defaults

■ Running your computer from the Virtual Partition

■ Checking the integrity of an image file

■ Viewing the task log

■ Starting Ghost.exe

■ What to do if a task fails
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Setting Norton Ghost options and defaults
Norton Ghost lets you set defaults for the tasks that you run from the wizards. 
You can change many of these defaults in the wizards as you create a task. 

Some options can only be set as you create the task in the wizard.

The options and defaults include the following:

■ Adding command-line switches to a task

■ Assigning a drive letter to a CD/DVD drive

■ Setting the options for a mapped network drive

■ Setting display options

■ Setting the DOS version

■ Setting the image integrity check default

■ Setting a compression level

■ Assigning a password to an image file

■ Adding free space to the Virtual Partition

■ Installing SCSI drivers

■ Setting external storage device drivers

■ Setting TCP/IP drivers

■ Setting LPT peer-to-peer drivers

■ Installing extra drivers

■ Installing USB peer-to-peer drivers

Norton Ghost 
default options
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Adding command-line switches to a task
You can add command-line switches to a task to alter its operation. 

To add command-line switches to a task

1 Do one of the following:

■ To set this option as a default, in the Ghost Basic window, click Options.

■ To add command-line switches while running a Windows wizard task, 
in the settings window, click Advanced Settings.

2 On the Ghost Command Line tab, type the extra command-line switches.

See “Using Norton Ghost with switches” on page 154.

3 Click OK.

Warning: The syntax of your command line is not checked when the task 
runs. Therefore, review these instructions carefully to avoid errors. The 
consequences of an error could be serious.

Assigning a drive letter to a CD/DVD drive
You can assign a drive letter to a CD or DVD drive. This lets you select a drive 
letter when restoring an image file from a CD/DVD.

Use this option if you are restoring an image file that was written to a CD/DVD 
using a tool other than Norton Ghost.

To assign a drive letter to a CD/DVD drive

1 Do one of the following:

■ To set this option as a default, in the Ghost Basic window, click Options.

■ To assign a drive letter to a CD or DVD drive while running a Windows 
wizard task, in the Advanced Settings window, click Advanced Settings.

2 On the CD Driver tab, click Assign drive letters to CD/DVD drives.

3 Click OK.

Setting the options for a mapped network drive
You can set the options for connecting to a mapped network drive.
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To set the options for a mapped network drive

1 While running a Windows wizard task, in the Advanced Settings window, 
click Advanced Settings.

2 Click Map network drive.

3 Do one of the following:

■ Select a network card from the drop-down list.

Norton Ghost displays any installed drivers that it detects. Select the 
network driver for the particular make and model of the network card 
that is installed on the computer. 

See “Selecting a template” on page 84.

■ Click Browse to open the Ghost Boot Wizard and select a network card.

From the Ghost Boot Wizard, you can add a network card. If your 
network card is not on the list, you can modify a network card template.

See “Selecting a template” on page 84 and “Adding network drivers to 
the Ghost Boot Wizard” on page 86.

4 Select one of the following:

■ Use DHCP: Use this option if your network contains a DHCP server.

■ Static IP Address: Complete the fields below this option if your network 
does not contain a DHCP server. 

5 In the Network resource field, type a network resource.

6 In the User name field, type a user name.

7 In the Domain field, type a domain name.

8 Click OK.

Setting display options
You can set some default display options.

To set display options

1 In the Ghost Basic window, click Options.

2 Click Display.

3 Check Show Norton Ghost tray icon on start up to display the Norton Ghost 
icon in the taskbar.

4 Check Show disaster recovery warning before running a Norton Ghost task 
to display the Disaster Recovery dialog box before running a task.
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5 Check Show information screen about the DOS version of Ghost to display 
the warning that Norton Ghost restarts into DOS while running a task.

6 Click OK.

Setting the DOS version
By default, Norton Ghost includes PC-DOS in the Virtual Partition. However, 
some computer models may not start from a Virtual Partition that contains PC-
DOS. If your computer does not start from the Virtual Partition, set the default 
option to MS-DOS. 

You must provide MS-DOS on a floppy disk formatted on a Windows 95/98 
computer before you can run Norton Ghost with MS-DOS. 

See “Providing MS-DOS” on page 89.

To set DOS files

To select a DOS version

1 In the Ghost Basic window, click Options.

2 On the DOS Type tab, select one of the following:

■ Use PC-DOS: Includes PC-DOS in the Virtual Partition.

■ Use MS-DOS: Includes MS-DOS in the Virtual Partition.

3 Click OK.

To install MS-DOS

1 Insert the MS-DOS formatted floppy disk into drive A of the computer on 
which Norton Ghost is running.

2 In the DOS Type window, click Get MS-DOS Files.

3 Click OK.

To uninstall MS-DOS

1 In the DOS Type window, click Remove MS-DOS Files.

2 Click OK.

Installing MS-DOS Client files
If you are using the mapped network drive functionality and MS-DOS, you must 
include the Microsoft DOS Client files. You must install the files on the computer 
before you can include them in the Virtual Partition. 
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The following files are required:

■ EMSBFR.EXE

■ LMHOSTS

■ NEMM.DOS

■ NET.EXE

■ NET.MSG

■ NETBIND.COM

■ NETH.MSG

■ NETWORKS

■ NMTSR.EXE

■ PROTMAN.DOS

■ PROTMAN.EXE

■ PROTOCOL

■ TCPDRV.DOS

■ TCPTSR.EXE

■ TCPUTILS.INI

■ TINYRFC.EXE

■ UMB.COM

■ IFSHLP.SYS

■ EMM386.EXE

■ HIMEM.SYS

■ WFWSYS.CFG
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To install the Microsoft DOS Client files

1 In the Ghost Basic window, click Options.

2 In the Norton Ghost 2003 Options dialog box, click DOS Type.

3 Insert a floppy disk containing the MS-DOS LAN Client files into drive A, 
and then click Supply MS-DOS LAN Client Files.

Setting the image integrity check default
You can set a default option for Norton Ghost to perform an integrity check of an 
image file after it has been created and before it is restored.

Some CD-RW drives eject a CD once an image has been saved to it. If this is 
preventing the integrity check, then ensure that this option is not selected, and 
perform an integrity check using the Image Integrity Check Wizard.

See “Checking the integrity of an image file” on page 58.

To set Norton Ghost to perform an integrity check on an image file

1 In the Ghost Basic window, click Options.

2 In the Norton Ghost 2003 Options dialog box, click Image Integrity check.

3 Check Always perform an image integrity check to set the default.

4 Click OK.

Setting a compression level
A compression level can be set as a default or from a wizard. You can set the 
compression level to None, Fast, or High. Compression is set to Fast by default.

See “Image files and compression” on page 62.
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To set the compression level

1 Do one of the following:

■ To set the default compression level, in the Ghost Basic window, click 
Options.

■ To set the compression level while running a Windows wizard task, in 
the Advanced Settings window, click Advanced Settings.

2 On the Compression tab, select one of the following:

■ None: No compression (high speed)

■ Fast: Low compression (medium speed)

■ High: High compression (slower speed)

3 Click OK.

Assigning a password to an image file
You can assign a password to an image file. The password is entered when the 
image file is created. Then, each time the image file is accessed in Ghost.exe, you 
are prompted to enter the password.

To assign a password

1 Do one of the following:

■ To set the default to create an image password, in the Ghost Basic 
window, click Options.

■ To set the option to create an image password while running a Windows 
wizard task, in the Advanced Settings window, click Advanced Settings.

2 On the Image password tab, check Prompt for an image password to set the 
option to prompt for a password when the image file is created.

Adding free space to the Virtual Partition
You can specify additional space to be added to the Virtual Partition. This is 
added to the Virtual Partition when it is created.
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To specify additional free space in the Virtual Partition

1 Do one of the following:

■ To set the default to specify additional free space, in the Ghost Basic 
window, click Options.

■ To specify additional free space while running a Windows wizard task, 
in the Advanced Settings window, click Advanced Settings.

2 In the Norton Ghost 2003 Options window, on the Virtual Partition Free 
Space tab, in the Required Free Space field, select an additional amount of 
free space (in MB) to add to the Virtual Partition.

3 Click OK.

Installing SCSI drivers
Norton Ghost automatically installs Adaptec SCSI drivers in the Virtual Partition 
if it finds a SCSI hard disk. The SCSI drivers allow Norton Ghost to access any 
SCSI device. If you want to install SCSI drivers manually, you can set this as a 
default preference or install the drivers from a wizard. You can scan for Adaptec 
SCSI cards and let Norton Ghost select the correct drives.

If you are using a card other than Adaptec, then you must manually install the 
correct drivers.

See “Installing extra drivers” on page 56.

To install SCSI drivers

1 Do one of the following:

■ To set the default installation of SCSI drivers, in the Ghost Basic 
window, click Options.

■ To install the SCSI drivers while running a task, in the Advanced 
Settings window, click Advanced Settings.

2 Check the SCSI drivers that you want to install.

3 To let Norton Ghost scan for Adaptec SCSI cards, click Auto-Detect for SCSI 
drivers.

4 Click OK.
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Setting external storage device drivers
Norton Ghost usually installs USB and FireWire drivers in the Virtual Partition if 
it finds a USB or FireWire external device. You may need to install these drivers 
manually as a default option or while running a Windows wizard task.

Note: Do not use this option if you want to connect to another computer using 
peer-to-peer.

See “Installing USB peer-to-peer drivers” on page 57.

To install external device drivers

1 Do one of the following:

■ To set the default installation of external drivers, in the Ghost Basic 
window, click Options.

■ To install the external device drivers while running a Windows wizard 
task, in the Advanced Settings window, click Advanced Settings.

2 On the External Storage tab, select one of the following:

■ No USB Drivers: Does not install USB drivers

■ USB 1.1 Drivers: Installs USB 1.1 drivers

Select this option if any of your cards or chipsets are USB 1.1.

■ USB 2.0 Drivers: Installs USB 2.0 drivers

Do not select this option if any of your cards or chipsets are USB 1.1.

3 If you want to install FireWire drivers to the Virtual Partition, then click 
Firewire Support.

4 If you want to assign a drive letter to the external storage device, then click 
Assign drive letters.

By default, a drive letter is assigned to an external storage device. This option 
assigns a drive letter to USB and FireWire devices in DOS.

5 Click OK.

Setting TCP/IP drivers
Norton Ghost automatically searches for and installs the correct TCP/IP drivers 
for your hardware setup. However, you can set the TCP/IP configuration 
manually if your task fails or you need settings that are different from the 
automatic setup. If your computer is running Windows NT 4 and you are using 
TCP/IP, then you must manually set the network driver.
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To install TCP/IP drivers

1 To set the default installation of TCP/IP drivers, in the Ghost Basic window, 
click Options.

2 In the Norton Ghost 2003 Options dialog box, click TCP/IP Driver Settings.

3 Do one of the following:

■ Select a network card from the drop-down list.

Norton Ghost displays any detected installed drivers. Select the network 
driver for the particular make and model of the network card that is 
installed on the computer. 

See “Selecting a template” on page 84.

■ Click Browse to open the Ghost Boot Wizard and select a network card.

From the Ghost Boot Wizard you can add a network card. If your 
network card is not on the list, you can modify a network card template.

See “Selecting a template” on page 84 and “Adding network drivers to 
the Ghost Boot Wizard” on page 86.

4 Select one of the following:

■ Use DHCP: Use this option if your network contains a DHCP server.

■ Static IP Address: Complete the fields below this option if your network 
does not contain a DHCP server. 

5 Click OK.

Setting LPT peer-to-peer drivers
Norton Ghost automatically installs default LPT peer-to-peer drivers for your 
hardware setup. However, you can set the LPT configuration manually if your 
task fails or you need settings that are different from the automatic setup.
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To install LPT peer-to-peer drivers

1 To set the default installation of LPT drivers, in the Ghost Basic window, click 
Options.

2 In the Norton Ghost 2003 Options dialog box, click LPT Driver Settings.

3 Select a mode.

The default mode for an LPT connection is ECP/EPP High Speed. If you are 
having problems with your LPT connection, set the mode to Bidirectional 
8bit or Bidirectional 4bit. The next time that you create a boot disk, the mode 
is reset to the default, ECP/EPP High Speed.

4 Select a port.

If you have multiple parallel ports and want to connect using a port other 
than the default LPT1, use the LPT port option to specify the port into which 
your cable is plugged. 

5 Click OK.

Installing extra drivers
You can install drivers that are not included with Norton Ghost. You can also 
modify Autoexec.bat and Config.sys, which are installed in the Virtual Partition.

To install extra drivers

1 Do one of the following:

■ To set the default installation of extra drivers, in the Ghost Basic 
window, click Options.

■ To install the extra drivers while running a Windows wizard task, in the 
Advanced Settings window, click Advanced Settings.

2 On the User files tab, click Add Files to add additional drivers.

3 Click Add Directory to add additional directories.

4 In the AUTOEXEC.BAT Additions field, type any additional Autoexec.bat 
entries for the driver.

5 In the CONFIG.SYS Additions field, type any additional Config.sys entries 
for the driver.

6 Click OK.
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Installing USB peer-to-peer drivers
You can select USB peer-to-peer drivers to install into the Virtual Partition. In 
most cases, you do not need to alter the driver’s default. However, if you have 
problems connecting using peer-to-peer, then select the other options and retry 
the task.

To select USB peer-to-peer drivers

1 Do one of the following:

■ To set the default installation of extra drivers, in the Ghost Basic 
window, click Options, and then click USB peer-to-peer settings.

■ To install the USB drivers while running a Peer-to-Peer Wizard task, in 
the Advanced Settings window, click USB peer-to-peer settings.

2 Select one of the following:

■ All drivers: Installs all USB peer-to-peer drivers into the Virtual 
Partition.

■ UHCI driver: Installs only UHCI drivers into the Virtual Partition.

■ OHCI driver: Installs only OHCI drivers into the Virtual Partition.

3 Click OK.

Running your computer from the Virtual Partition
From Norton Ghost you can restart your computer into the Virtual Partition. 
The Virtual Partition is created in DOS and includes the files that you have saved 
in a selected folder. Once you have created a Virtual Partition from a folder, you 
can run any application that you have provided in the selected folder.

The Virtual Partition is created with the following files:

■ Ghreboot.exe

This executable file lets you restart your computer back into Windows.

■ Selected driver settings

You can select drivers to include in the Virtual Partition that will let you 
access external hardware.

■ DOS applications stored in the selected folder

Any DOS applications that you provided in the selected folder are bundled 
and included in the Virtual Partition.

If you include Autoexec.bat and Config.sys in the selected folder, then they are 
modified by Norton Ghost when the Virtual Partition is created.
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Before you create the Virtual Partition, you must create a folder that contains the 
files that you want included in the Virtual Partition.

To create the Virtual Partition from a folder

1 In the Ghost Basic window, click Ghost Advanced, and then click Create 
Virtual Partition.

2 Click Next.

3 Click Browse to select a directory from which to create the Virtual Partition.

4 In the Required Free Space field, set the size in MB of the Virtual Partition.

5 Click Next.

6 If you want to set advanced driver settings, then click Advanced Settings.

See “Setting Norton Ghost options and defaults” on page 46.

7 Click Next.

8 Click Run Now to restart your computer in the Virtual Partition.

The task summary displays the size of the folder that you have selected. The 
Virtual Partition cannot be smaller than the folder size.

Restarting your computer from the Virtual Partition
To restart your computer back into Windows from the Virtual Partition, you 
must run the Ghreboot executable.

You may also need to run Ghreboot if a task has failed and your computer is left 
in the Virtual Partition.

To restart your computer in Windows

1 At the command line, type ghreboot.

2 Press Enter.

Checking the integrity of an image file
You can check the integrity of a Ghost image file. An integrity check ensures that 
the data read from the image file is the same as the data written to the image file. 
Norton Ghost performs a dummy restore of the image file. It does not check that 
the data on the disk is the same as the data in the image file.
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To check the integrity of an image file

1 In the Ghost Basic window, click Ghost Advanced, and then click Image 
Integrity Check.

2 Click Next.

3 In the Create Image Integrity Check Wizard window, click Browse and find 
the image file that you want to verify.

4 If you want to view the contents of the image file in Ghost Explorer, click 
Open image in Ghost Explorer.

See “Viewing image files” on page 119.

5 Click Next.

6 If you want to set advanced settings for the verification, then click Advanced 
Settings.

See “Adding command-line switches to a task” on page 47.

7 Click Next.

8 In the Important Information dialog box, if you do not want to view this 
warning again, click Don’t show this screen again, and then click Next.

9 Click Run Now to start the image verification.

Viewing the task log
The task log displays the tasks performed from the Norton Ghost wizards.

To view the task log

1 In the Ghost Basic window, click View Log.

2 In the Task Log Viewer window, select a log entry and click View Log.

Starting Ghost.exe
You can start Ghost.exe from Windows. This option restarts your computer in 
DOS and opens Ghost.exe, which lets you run Norton Ghost interactively.
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To start Ghost.exe

1 In the Ghost Basic window, click Ghost Advanced, and then click Run Ghost 
Interactively.

2 Click Next.

3 If you want to set advanced settings for the backup, then click Advanced 
Settings.

See “Setting Norton Ghost options and defaults” on page 46.

4 Click Next.

5 In the Important Information dialog box, if you do not want to view this 
warning again, click Don’t show this screen again, and then click Next.

6 In the Disaster Recovery window, select one of the following:

■ Launch Tutorials: Opens the tutorial index.

From the tutorials, you can select a tutorial that demonstrates how to 
create a recovery boot disk.

■ Continue: Returns to the Run Ghost Interactively Wizard.

This dialog box warns you to ensure that you can run Ghost.exe and access 
your image file once it has been created. You may need to create a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

7 Select one of the following:

■ Run Now: Restarts your computer into DOS and launches Ghost.exe.

■ Disaster Recovery: Starts the Ghost Boot Wizard and creates a recovery 
boot disk.

See “Creating a recovery boot disk” on page 73.

What to do if a task fails
If a Norton Ghost task fails, you are prompted to select one of the following 
options:

■ Exit to DOS: Closes Ghost.exe and returns to DOS.

■ Return to Windows: Restarts your computer into Windows.

■ Retry the operation: Executes the task again.
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Image file options

This chapter includes the following topics:

■ About Norton Ghost image files

■ Image files and compression

■ Image files and CRC32

■ Image files and volume spanning

■ Image files and tape drives

■ GoBack and Norton Ghost

■ Dynamic disks in Windows 2000/XP

■ Hibernation and swap files
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About Norton Ghost image files
The image files created with Norton Ghost have a .gho or .ghs extension by 
default. They contain the entire disk or partitions of the disk. Image files support 
the following:

■ Various levels of compression

■ CRC32 data integrity checking

■ Splitting of media files

■ Spanning across volumes

Norton Ghost images contain only the actual data on a disk. If you have a 9 GB 
drive with only 600 MB of data, the Norton Ghost image is approximately 600 
MB, and is smaller if you use compression.

If you also use the Ghost Explorer application, an image file companion utility, 
you can recover individual files selectively from these image files without 
restoring the complete disk or partition.

Image files and compression
Image files created in Norton Ghost support several levels of data compression. 
When Norton Ghost is in interactive mode, three compression options are 
available: none, fast, and high. The Norton Ghost command-line switch -z 
provides access to nine levels of compression. 

See “Command-line switches” on page 153.

As a rule, the more compression you use, the slower Norton Ghost operates. 
However, compression can improve speed when there is a data transfer 
bottleneck. There is a big difference in speed between high compression and no 
compression when creating an image file on a local disk. Over a network 
connection, fast compression is often as fast as, or faster than, no compression. 
Over a parallel cable, high compression is often faster than no compression 
because fewer bytes are sent over the cable. Decompression of high-compressed 
images is much faster than the original compression. The level of compression 
that you select depends on your individual requirements.
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Performance expectations on a network
One advantage of Norton Ghost is speed. Many factors affect performance. There 
are ways to gauge whether Norton Ghost is running optimally.

When you use Norton Ghost across a network, use the fast compression option. 
If disk space is at a premium, you can use higher compression, but it can affect 
speed. 

Image files and CRC32
Cyclic Redundancy Checking (CRC) is a data error checking technique. CRC 
ensures that the original data written to the image file is the same as the data on 
the disk. CRC32 is a CRC technique that uses a 32-bit value to store error 
checking information. 

When an image file is created, CRC32 details are embedded into the file to ensure 
that image file corruption is detected when the image is restored to disk. CRC32 
is currently included on a file-by-file basis with FAT partitions and on a volume 
basis for NTFS partitions. 

In addition to image file error detection, the CRC values are used to verify that 
image files and partitions or disks are identical. This offers an additional method 
to detect bad sector writes and other drive anomalies that may be missed during 
normal imaging checks.

You can generate a text file that contains CRC values and associated file attributes 
using the -CRC32 command-line switch. 

See “Command-line switches” on page 153.

Image files and volume spanning
Images can be contained in a single file or spanned across a number of files.

Standard image files
Standard image files consist of a single file that contains the contents of the 
complete disk or required partitions. This type of image file is stored on other 
hard drives, tape, CD, or DVD drives where the volume is large enough to hold 
the complete image file.
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Limitations on the image file size
The default (and maximum) image file size is 2GB. However, by using 
size-limited, multisegment image files, you can take an image of a disk or 
partition that is larger than 2 GB. 

Norton Ghost does support IDE drives larger than 128 GB. However, at the time 
of this printing, no operating system supports these large drives.

Size-limited image files
There are situations in which it is not practical to have a standard image file. 
Norton Ghost can split an image file into segments (known as spans) that are 
limited to a user-specified size. This option is most commonly used to limit span 
sizes to 620 MB for later transfer to a CD-ROM disc. 

Spanned image files
Spanned image files are similar to size-limited image files. The difference is that 
each segment file (or span) of the image file is limited by the actual volume size of 
the media to which the image is being saved. This lets you specify a drive and file 
name and lets Norton Ghost determine when to request another volume or 
location for the remaining data. This is very useful when using ZIP, JAZ, LS120 
Superdisk, CD-R/RW, and other drive types.

Spanning must be executed locally. If you try to span over a peer-to-peer 
connection (LPT, USB, TCP/IP), a disk full error message appears. However, size 
limiting can be used in all situations.

Norton Ghost also allows size limiting of spans when spanning volumes to ensure 
that no span exceeds the maximum size.

With all image files, the only constraint on the selection of the destination volume 
is that it must not be part of the source selection. For example, it cannot be on a 
source disk or partition if that disk or partition is to be included in the image.

The spanned files are named according to Microsoft application guidelines. For 
example:

■ First file: Filename.gho

■ Second file: Filen001.ghs

■ Third file: Filen002.ghs
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You can use the -cns switch for an alternative naming standard. For example:

■ First file: Image.gho

■ Second file: Image.001

■ Third file: Image.002

Spanning across multiple volumes and limiting span sizes
When you create an image file from a disk or partition, the destination drive 
might have insufficient space to store the image file. If Norton Ghost determines 
that this is the case, it alerts you and asks whether to enable spanning. Norton 
Ghost assumes that compression reduces the size of the image by one-third when 
it determines whether the image will fit. Alternatively, you can use the -span and 
-split command-line switches to configure Norton Ghost to use image file size 
limiting. 

See “Command-line switches” on page 153.

Before it saves the disk contents to the image file, Norton Ghost shows the source 
and destination details and offers a chance to cancel. The default is to cancel.

Once the process starts, the image file creation continues until the destination 
volume is full. 

If you started spanning onto a JAZ disk and want to span a 3.0 GB drive onto JAZ 
disks, you can choose to continue on JAZ disks. If you want to span across 
different forms of media, you can select a different type of media once the first 
portion of the span has completed. You cannot mix CD/DVD media with other 
types of media, such as JAZ or hard disk.

Record where the span segments are saved and the segment file names. Norton 
Ghost does not record the locations and file names you selected.

Information about the partitions is stored at the start of the image file. This is 
updated at the end of the Ghost process, which might require you to reinsert the 
first disk in the span set. Norton Ghost prompts you for the first disk in the span 
set and for subsequent volumes when restoring from an image.

Restoring from a spanned image
The process when restoring a disk or partition from a spanned image file is the 
same as restoring from an unspanned image file. However, during the restoration 
of the spanned image file, you are prompted for the locations of the image file 
spans. You must know the span segment locations and file names.
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You can continue on the same form of media. For example, if you originally 
spanned onto a JAZ disk and want to restore a 3.0 GB drive from JAZ disks, you 
can replace the disk and continue from JAZ disks. Alternatively, you can restore 
from different media types.

Norton Ghost automatically restores spanned images without prompting if it can 
find the next span. 

See “Adding switches to your Ghost operation” on page 108.

Image files and tape drives
The Backup, Restore, and Clone Wizards do not support tape drives. You can 
back up, restore, and clone using Ghost.exe. Ghost.exe support of SCSI tape 
drives allows the storage of a single image file on a tape. When the image is 
written to the tape, Ghost.exe uses no associated file system, which means that 
you are unable to access the tape from a drive letter as if it were another storage 
drive. SCSI tapes do not support spanning to multiple tapes.

When you use tape drives with Ghost.exe, you can select the tape drive as the 
source or destination device in the File Locator window. Each SCSI tape device is 
shown as MTx, where x is a number starting at 0 and increasing incrementally for 
each drive present. For example, the following screen shows a tape drive MT0 
available for use.

For Ghost.exe to access SCSI tape drives, a DOS ASPI driver must be installed 
prior to use. 

See “Standard boot disks” on page 76.
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Ghost.exe in its default mode performs well with most SCSI tape devices. In some 
situations with older SCSI tape devices and possibly with unreliable tapes, 
Ghost.exe may need to be configured to slow down or alter the way it uses the 
tape device. 

See “Command-line switches” on page 153.

Note: Ghost Explorer cannot access an image stored on tape.

GoBack and Norton Ghost
If GoBack is installed on your computer, then you cannot directly create image 
files or restore your computer. 

You must disable GoBack before you use Norton Ghost wizards.

GoBack and Ghost.exe
To run Ghost.exe with GoBack, do one of the following:

■ Uninstall GoBack and then run Ghost.exe as usual to take an image or restore 
a computer.

■ To take an image of your computer, in the GoBack Boot Screen, select the 
option to start your computer from a floppy disk with the GoBack drivers 
loaded. You can then use a Ghost boot disk to start Ghost.exe and take an 
image file.

See the GoBack user documentation.

See “Creating a backup image file” on page 97.

■ To restore your computer, start your computer from a floppy disk. You can 
then use a Ghost boot disk to start Ghost.exe and restore your computer.

See “Restoring from an image file” on page 101.
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Dynamic disks in Windows 2000/XP
Norton Ghost supports backing up, restoring, and cloning simple or mirrored 
volumes on dynamic disks. Spanned, striped, and RAID-5 volumes are not 
supported by Norton Ghost. You can back up an image of a partition on a disk in 
a dynamic disk set to an image file. If you back up a disk, then all of the partitions 
that Ghost supports on the disk, and only those partitions, are backed up to an 
image file.

Note: Norton Ghost supports simple volumes in a contiguous space. If a 
partition is not of this type, then it is not included in the image file.

Operations that support dynamic disks are as follows:

■ Partition to partition

■ Partition to image

■ Disk to disk

■ Disk to image

■ Check image

■ Check disk

■ CRC32 

■ CRC32 verify

You can restore an image of a dynamic disk only to a basic disk, not to a dynamic 
disk. After you have restored the image file to a basic disk, you can then use 
Windows 2000 Disk Manager to convert the disk to a dynamic disk.

To delete a dynamic disk, use GDisk. Use the switch gdisk /mbr /wipe to delete all 
partitions from the disk. This method destroys all data on the disk.

See “Reinitializing the Master Boot Record” on page 132.

You can also take a disk image of a dynamic disk if you use the image all (-ia) 
switch. The -ia switch performs a sector-by-sector copy of the entire disk. The 
disk on which the image is to be restored must be identical to the source disk in 
every way. This function is only useful for creating a backup. If you restore an 
image created using -ia onto a drive with different geometry, Windows 2000 
cannot interpret the dynamic disk.
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If you restore an -ia disk image of a dynamic disk onto a SCSI hard drive and you 
see a Destination drive too small message, you must load the ASPI driver for the 
SCSI card. Without an ASPI driver, Norton Ghost does not always detect the 
correct size of the SCSI drive and cannot determine whether the drive is large 
enough to hold the image.

Note: You should not take an image all of a dynamic disk because the method is 
slow and the image file would be very large.

Hibernation and swap files
When Norton Ghost creates image files or clones, it does not include hibernation 
and swap files. These files are valid only for one Windows session, and when they 
are included in an image file, they make it significantly larger.

Norton Ghost implements file skipping differently for each type of file system.

■ FAT file systems: Files are not included on the image file or destination disk.

■ NTFS file systems: A file with the same name is created on the image file or 
destination disk, but the contents of the file are not copied.

The following files are skipped on all file systems:

■ 386Spart.par

■ Amizvsus.pmf

■ Dos data.sf

■ Ghost.dta

■ Hiberfil.sys

■ Hibrn8.dat

■ Hybern8

■ Navsysl.dat

■ Navsysr.dat

■ Pagefile.sys

■ Pm_hiber.bin

■ Save2dsk.bin

■ Saveto.dsk
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■ Spart.par

■ Swapper.dat

■ Toshiber.dat

■ Virtpart.dat

■ Win386.swp
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Creating boot disks with 
the Ghost Boot Wizard

This chapter includes the following topics:

■ Introducing the Norton Ghost Boot Wizard

■ What is a Ghost boot disk

■ When to create a Ghost boot disk

■ How to use a Ghost boot disk

■ Files included on a Ghost boot disk

■ Creating a recovery boot disk

■ Opening the Ghost Boot Wizard

■ Creating boot disks and boot images

■ Selecting a template

■ Multicard templates and the boot disk

■ Adding network drivers to the Ghost Boot Wizard

■ Adding command-line parameters to a boot package

■ Providing MS-DOS
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Introducing the Norton Ghost Boot Wizard
Introducing the Norton Ghost Boot Wizard
The Ghost Boot Wizard creates Ghost boot disks that let you complete various 
Ghost tasks when starting Norton Ghost from DOS. For any task, the Ghost Boot 
Wizard guides you through the different steps to select the settings and drivers 
that are needed to create the boot disk.

What is a Ghost boot disk
A Ghost boot disk can be created using the Ghost Boot Wizard, a utility supplied 
with Norton Ghost. A boot disk is a floppy disk that loads DOS and driver files to 
let you run Ghost.exe on your computer.

Depending upon the driver files included on your boot disk, more than one 
floppy disk may be required to create a boot disk set.

When to create a Ghost boot disk
If you start and run Norton Ghost from Windows, then the only boot disk you 
need is a recovery boot disk. If you are running Norton Ghost from Windows, 
then the system files and drivers required to perform the backup, restore, or clone 
are provided for you.

Note: If you saved your image file directly to CD or DVD, then you do not need a 
recovery boot disk. Norton Ghost includes Ghost.exe if you save the image file to 
CD or DVD.

To use Ghost.exe you must have a Ghost boot disk. The following tasks require a 
boot disk:

■ Restoring your computer with Ghost.exe after software or hardware failure

■ Cloning a computer that does not have Windows installed

How to use a Ghost boot disk
Once you have created the necessary boot disks, you can insert a boot disk into 
your computer and restart your computer. This starts the computer in DOS and 
starts Ghost.exe. You can then run Ghost.exe to back up, restore, and clone on 
your computer from DOS. 

See “Starting the Norton Ghost executable” on page 93.
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Files included on a Ghost boot disk
A Ghost boot disk contains the files required to run Ghost.exe. This includes the 
following:

■ Ghost.exe

The Norton Ghost for DOS executable.

■ DOS system files 

PC-DOS is supplied for the purpose of creating Ghost boot disks. The DOS 
files are installed automatically when you create the boot disk in Ghost Boot 
Wizard.

■ Any files and drivers required to access the selected hardware

This includes CD-R/RW drivers, network protocol files, or network interface 
card drivers.

Note: In previous versions of Norton Ghost, MSCDEX was required to read an 
image from a CD. This is no longer necessary in Norton Ghost 2003.

When to include MS-DOS on a boot disk
By default, Norton Ghost includes PC-DOS on a Ghost boot disk. However, 
some computer models may not start from a Ghost boot disk that contains PC-
DOS. If your computer does not start from a Ghost boot disk, create a new Ghost 
boot disk from the Ghost Boot Wizard and include Windows 95/98 MS-DOS. 

You must provide Windows 95/98 MS-DOS for the computer running the Ghost 
Boot Wizard before you create an MS-DOS Ghost boot disk.

See “Providing MS-DOS” on page 89.

Creating a recovery boot disk
When you have created your first backup image, you must create a recovery boot 
disk and ensure that you can start your computer and access the backup image 
using the boot disk. 

Note: If you saved your image file directly to CD or DVD, then you do not need a 
recovery boot disk. Norton Ghost includes Ghost.exe if you save the image file to 
CD or DVD.
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See Table 6-1 to determine which type of boot disk you should create as a disaster 
recovery disk. 

Once you have created a recovery boot disk, ensure that your computer starts 
with the boot disk or the CD/DVD.

To test your recovery boot disk or CD/DVD

1 Turn off your computer.

2 Insert the boot disk or CD/DVD into the disk drive of your computer and 
start your computer.

3 Ensure that Ghost.exe starts and that you can access your backup image file.

See “Restoring a hard disk from an image file” on page 101.

4 Remove the disk from the disk drive of your computer and restart your 
computer.

Opening the Ghost Boot Wizard
The procedures in this chapter assume that you know how to open the Ghost 
Boot Wizard.

To open the Ghost Boot Wizard

1 On the Windows taskbar, click Start > Programs > Norton Ghost.

2 In the Ghost Basic window, click Ghost Utilities.

3 In the Ghost Advanced window, click Norton Ghost Boot Wizard.
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Creating boot disks and boot images
The processes for creating boot images and disks can include any of the following 
features:

■ Support for CD-R/RW, DVD, LPT, USB, and FireWire

■ Network support for TCP/IP peer-to-peer connections

■ Support for reading an image from a CD-ROM

■ Support for mapping network drives

See Table 6-1 to decide which boot disk you should make.

Table 6-1 Boot disk types

Intended use of boot disk Ghost Boot Wizard options to select

Local use of Norton Ghost:

■ Disk-to-disk clone

■ Partition-to-partition clone

■ Disk or partition backup to local 
disk or partition

■ Disk or partition backup to local 
JAZ or ZIP drive

■ Disk or partition restore from local 
disk or partition

■ Disk or partition restore from local 
JAZ or ZIP drive

You can use either of the following options:

■ Standard Ghost Boot Disk
See “Standard boot disks” on page 76.

■ Peer-to-Peer Network Boot Disk
See “Boot disks with network support” 
on page 79.

■ Clone, back up, or restore over peer-
to-peer connection between two 
computers using LPT or USB cable.

Standard Ghost Boot Disk

See “Standard boot disks” on page 76.

■ Clone, back up, or restore over TCP/
IP peer-to-peer connection with 
network support between two 
computers

Peer-to-Peer Network Boot Disk

See “Boot disks with network support” on 
page 79.

■ Back up a computer directly to an 
image file on a CD-ROM on a CD 
writer supported by Norton Ghost.

■ Restore a computer from an image 
file on a CD-ROM on a CD-R/RW 
drive supported by Norton Ghost. 
See “Image files and CD/DVD 
writers” on page 112.

Standard Ghost Boot Disk

See “Standard boot disks” on page 76.
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Standard boot disks
The Ghost Boot Wizard creates a boot disk that does any one or a combination of 
the following:

■ Runs Ghost.exe for local operations.

■ Lets you write Ghost images directly to a CD-R/RW on a CD writer 
supported by Norton Ghost.

See “Image files and CD/DVD writers” on page 112.

■ Lets you write Ghost images directly to a DVD on a DVD writer supported 
by Norton Ghost.

■ Back up a computer directly to an 
image file on a DVD on a DVD 
writer supported by Norton Ghost.

■ Restore a computer from an image 
file on a DVD on a DVD drive 
supported by Norton Ghost.

Standard Ghost Boot Disk

See “Standard boot disks” on page 76.

■ Restore a computer from a Ghost 
image file on a CD-ROM on a CD-
R/RW drive not supported by 
Norton Ghost. The image file was 
not stored on the CD-ROM using 
Norton Ghost. Contains generic 
CD-ROM drivers.

CD/DVD Startup Disk with Ghost

See “Boot disks with CD-ROM and DVD 
support” on page 81.

■ Access files other than a Ghost image 
file on a CD-ROM.

CD/DVD Startup Disk with Ghost

See “Boot disks with CD-ROM and DVD 
support” on page 81.

■ Map a drive on a workstation to a 
shared resource on a server and use 
Norton Ghost to clone, back up, or 
restore.

Drive Mapping Boot Disk

See “Boot disks with drive mapping network 
support” on page 82.

Table 6-1 Boot disk types

Intended use of boot disk Ghost Boot Wizard options to select
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■ Runs Ghost.exe on two computers connected by either an LPT or USB cable.

The default mode for an LPT connection is ECP/EPP High Speed. If you are 
having problems with your LPT connection, set the mode to Bidirectional 
8bit or Bidirectional 4bit. The next time that you create a boot disk, the 
mode is reset to the default, ECP/EPP High Speed.

If you have multiple parallel ports and want to connect using a port other 
than the default LPT1, use the LPT port option to specify the port into which 
your cable is plugged. 

■ Lets you use Ghost.exe to back up to or restore from an external device 
connected by USB or FireWire.

To create a boot disk to run Ghost.exe, or with support for LPT, USB, or 
FireWire cables

1 In the Ghost Boot Wizard window, click Standard Ghost Boot Disk.

2 Click Next.

3 Do one or more of the following:

■ Check USB support to add support for USB peer-to-peer to the boot 
disk.

■ Click Advanced to set the USB peer-to-peer drivers.

See “Setting the USB peer-to-peer drivers” on page 79.

■ Check LPT support to add support for LPT peer-to-peer to the boot 
disk.

■ Click Advanced to change the LPT mode or port.

■ Click No USB support to exclude support for USB external devices.

■ Click USB 1.1 support to add support for USB 1.1 external devices to the 
boot disk.

If any of your USB cards/chipsets are USB 1.1, then you must select this 
option.

■ Click USB 2.0 support to add support for USB 2.0 external devices to the 
boot disk.

If any of your USB cards/chipsets are USB 1.1, then do not select this 
option. Select the USB 1.1 support option.

■ Click Firewire Support to add support for FireWire external devices to 
the boot disk.



78 Creating boot disks with the Ghost Boot Wizard
Creating boot disks and boot images
■ Click Assign DOS drive letters to assign a DOS drive letter to a USB or 
FireWire external device.

■ Click Include Adaptec ASPI drivers to add Adaptec ASPI drivers to the 
boot disk.

These drivers are required to write an image directly to a SCSI CD-R 
that is supported by Norton Ghost.

4 Click Next.

5 Select one of the following:

■ Use PC-DOS: Includes PC-DOS on the boot disk.

■ Use MS-DOS: Includes MS-DOS on the boot disk.

See “Providing MS-DOS” on page 89.

6 Click Next.

7 In the Ghost.exe field, type the correct path if the executable has been moved 
or you want to use a different version of Norton Ghost.

The default path to the Norton Ghost executable appears in the Ghost.exe 
field.

8 In the Parameters field, type any required command-line parameters.

See “Adding command-line parameters to a boot package” on page 88.

9 Click Next.

10 In the Floppy Disk Drive field, select the appropriate drive letter.

11 In the Number of disks to create field, select the number of disks that you 
want to create.

12 Ensure that Format disk(s) first is checked to format the disks before disk 
creation.

Ensure that this option is checked unless you are creating a custom boot disk 
with custom system files. If this option is unchecked, the boot disk is not 
bootable.

13 Ensure that Quick Format is checked to perform a quick format.

14 Click Next.

15 Review the boot disk details and click Next to start creating the boot disks.

Follow the prompts to format the disks and create a boot disk set.
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Setting the USB peer-to-peer drivers
You can select USB peer-to-peer drivers to include on the boot disk. In most 
cases, you do not need to alter the driver default. However, if you have problems 
connecting using peer-to-peer, then select the other options and retry the task.

To select USB peer-to-peer drivers

1 Select one of the following:

■ All drivers: Includes all USB peer-to-peer drivers on the boot disk.

■ UHCI driver: Includes only UHCI drivers on the boot disk.

■ OHCI driver: Includes only OHCI drivers on the boot disk.

2 Click OK.

Boot disks with network support
The Ghost Boot Wizard helps you create boot disks that provide network support 
for TCP/IP peer-to-peer connections. You can use these boot disks to clone, 
restore, or back up using Norton Ghost on computers that are connected over a 
TCP/IP peer-to-peer connection.

Before you start this process, you need to know the types of network cards that 
are installed on your client computers. Unless you use the multicard template, 
you must create a boot disk for each network card.

To create a boot disk with network support

1 In the Ghost Boot Wizard window, click Peer-to-Peer Network Boot Disk. 

2 Click Next.

3 Select the network driver for the make and model of the network card 
installed on the client computer. 

See “Selecting a template” on page 84.

If the correct driver is not in the list, add the driver. 

See “Adding network drivers to the Ghost Boot Wizard” on page 86.

You can add more than one driver to the boot package. 

See “Multicard templates and the boot disk” on page 85.

4 Click Next.



80 Creating boot disks with the Ghost Boot Wizard
Creating boot disks and boot images
5 Select one of the following:

■ Use PC-DOS: Includes PC-DOS on the boot disk.

■ Use MS-DOS: Includes MS-DOS on the boot disk.

See “Providing MS-DOS” on page 89.

6 In the Ghost.exe field, type the correct path if the executable has been moved 
or you want to use a different version of Ghost.

The default path to the Norton Ghost executable appears in the Ghost.exe 
field.

7 In the Parameters field, type any required command-line parameters.

See “Adding command-line parameters to a boot package” on page 88.

8 Click Next.

9 Do one of the following:

■ Click DHCP will assign the IP settings if your network contains a 
DHCP server.

■ Click The IP settings will be statically defined and complete the fields 
below this option if your network does not contain a DHCP server. 

If you create more than one boot disk, then the static IP address 
incrementally increases as each boot disk is created.

10 Click Next.

11 In the Floppy Disk Drive field, select the appropriate drive letter.

12 In the Number of disks to create field, select the number of disks that you 
want to create.

13 Ensure that Format disk(s) first is checked to format the disks before disk 
creation.

Ensure that this option is checked unless you are creating a custom boot disk 
with custom system files. If this option is unchecked, the boot disk is not 
bootable.

14 Ensure that Quick Format is checked to perform a quick format.

15 Click Next.

16 Review the boot disk details and click Next to start creating the boot disks.

Follow the prompts to format the disks and create a boot disk set.
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Boot disks with CD-ROM and DVD support
A boot disk with CD-ROM and DVD support lets you access images and other 
files stored on CD-R/RW and DVD drives that are not supported by Norton 
Ghost.

This kind of disk also contains the DOS system files and Norton Ghost.

To create a boot disk with CD-ROM and DVD support

1 In the Ghost Boot Wizard window, click CD/DVD Startup Disk with Ghost.

2 Click Next.

3 Select one of the following:

■ Use PC-DOS: Includes PC-DOS on the boot disk.

■ Use MS-DOS: Includes MS-DOS on the boot disk.

See “Providing MS-DOS” on page 89.

4 Click Next.

5 In the Ghost.exe field, type the correct path if the executable has been moved 
or you want to use a different version of Ghost.

The default path to the Ghost executable appears in the Ghost.exe field.

6 In the Parameters field, type any required command-line parameters.

See “Adding command-line parameters to a boot package” on page 88.

7 Click Next.

8 In the Floppy Disk Drive field, select the appropriate drive letter.

9 In the Number of disks to create field, select the number of disks that you 
want to create.

10 Ensure that Format disk(s) first is checked to format the disks before disk 
creation.

Ensure that this option is checked unless you are creating a custom boot disk 
with custom system files. If this option is unchecked, the boot disk is not 
bootable.

11 Ensure that Quick Format is checked to perform a quick format.

12 Click Next.

13 Review the boot disk details and click Next to start creating the boot disks.

Follow the prompts to format the disks and create a boot disk set.
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Boot disks with drive mapping network support
When your computers need to access a network drive, use the Ghost Boot Wizard 
to create boot disks that map a drive letter to a shared resource on a network 
server. This lets you use the local option in Ghost.exe to access a network drive.

To create a boot disk that supports mapping network drives

1 In the Ghost Boot Wizard window, click Drive Mapping Boot Disk. 

2 Click Next.

3 Select the network driver for the particular make and model of the network 
card installed on the computer. 

See “Selecting a template” on page 84.

If the correct driver is not in the list, add the driver. 

See “Adding network drivers to the Ghost Boot Wizard” on page 86.

You can add more than one driver to the boot package. 

See “Multicard templates and the boot disk” on page 85.

4 Click Next.

5 Select one of the following:

■ Use PC-DOS: Includes PC-DOS on the boot disk.

■ Use MS-DOS: Includes MS-DOS on the boot disk.

See “Providing MS-DOS” on page 89.

6 Click Get MS Client and browse to the MS-DOS Client files to include the 
Microsoft Client files if you are using MS-DOS.

If you are using MS-DOS, you must include the Microsoft DOS Client files. 
You must install the files on the Ghost Boot Wizard computer before you can 
include them in the boot package. 

See “Installing MS-DOS Client files” on page 49.

7 Click Next.

8 In the Computer Name field, type the name of the client computer.

This specifies the name of the computer after it starts from the floppy disk 
and does not have to be the same name given to the computer in Windows. If 
you create more than one disk, a number is added to the computer name so 
that the names for subsequent disks are unique.

9 In the User Name field, type the user name that the boot disk will use to log 
on to the network. 

This user must exist on the network and have sufficient access rights to the 
files and directories that you want to use.
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10 In the Domain field, type the domain to which the user belongs.

11 In the Drive Letter field, select a drive letter to access a network share through 
a mapped drive. 

Select a drive letter greater than any existing drive letter. 

12 If you want to prevent the boot package from mapping a drive when the 
computer starts, click None. 

In this case, map a drive from the DOS prompt after the computer has 
started.

13 In the Maps To field, type the complete UNC path to the network share. 

For example, to access a shared folder named Ghost on a computer named 
Boss, the UNC path is \\Boss\Ghost.

14 Click Next.

15 Do one of the following:

■ Click DHCP will assign the IP settings if your network contains a 
DHCP server.

■ Click The IP settings will be statically defined and complete the fields 
below this option if your network does not contain a DHCP server. Your 
network administrator can provide the values for these fields.

16 Click Next.

17 In the Floppy Disk Drive field, select the appropriate drive letter.

18 In the Number of disks to create field, select the number of disks that you 
want to create.

19 Ensure that Format disk(s) first is checked to format the disks before disk 
creation.

Ensure that this option is checked unless you are creating a custom boot disk 
with custom system files. If this option is unchecked, the boot disk is not 
bootable.

20 Ensure that Quick Format is checked to perform a quick format.

21 Click Next.

22 Review the boot disk details and click Next to start creating the boot disks.

Follow the prompts to format the disks and create a boot disk set.
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Selecting a template
For the boot disk to work correctly, it is important that you select the correct 
template. When you create a boot disk for client computers, the template that 
you select must be suitable for the network cards installed in the computers that 
are to start from the package.

To determine which network interface card is installed in a computer, find the 
name of the driver from Network Properties within Windows. This must be done 
on the client computer for which you are preparing the boot disk.

To determine which network interface card is installed

To determine which network interface card is installed on a Windows 98 
computer

1 On the Windows taskbar, click Start > Settings > Control Panel.

2 Double-click System.

3 Click Device Manager.

4 Expand Network Adapter.

The make and model of the installed network interface card are listed.

To determine which network interface card is installed on a Windows NT 4 
computer

1 On the Windows taskbar, click Start > Settings > Control Panel. 

2 Double-click Network.

The make and model of the installed network interface card are listed on the 
Adapters tab. 

To determine which network interface card is installed on a Windows 2000 
computer

1 On the Windows taskbar, click Start > Settings > Control Panel. 

2 Double-click System.

3 On the Hardware tab, click Device Manager.

4 Expand Network adapters.

The make and model of the installed network interface card are listed.

The name of the network interface card as shown in Windows may not exactly 
match the name of the correct template in the Ghost Boot Wizard. 
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For example, Windows may list the card as 3Com Fast EtherLink XL 10/100Mb 
TX Ethernet NIC (3C905B-TX). In this case the text in paraenthesis is the actual 
model number of the card, which indicates that the Ghost Boot Wizard template 
named 3COM 3C90X (which works for all 3C90- cards) is the correct template.

In some cases you may have a choice between an NDIS2 driver and a packet 
driver version of the same template. Both templates should work, but you may 
find that one gives better performance. Experiment to see which one works 
better. 

It is possible that there is no existing template in the Ghost Boot Wizard that is 
suitable for the network interface card installed in your computer. In this case, 
obtain the DOS drivers for the network interface card either from the disk 
supplied with the card or from the manufacturer's Web site, and add a new 
template to the Ghost Boot Wizard.

See “Adding network drivers to the Ghost Boot Wizard” on page 86.

If you have different network interface cards installed in client computers, then 
you may be able to use the multicard template to create a single boot package that 
works on each of your computers without modification.

Multicard templates and the boot disk
You can use multicard templates to create a boot disk package containing several 
NDIS2 drivers. When the computer starts from the boot disk, a special multicard 
driver checks the computer’s hardware to see if any of the NDIS2 drivers can be 
used to access the installed network card.

Multicard templates are useful because several makes and models of network 
cards are often used in a single LAN. You can create a single boot disk for use with 
all of your computers without modification.

Refer to the Software License Agreement for use restrictions.

The Network Interface Card window is available when creating a Peer-to-Peer 

Network Boot Disk or a Drive Mapping Boot Disk.

To create a multicard template

1 In the Network Interface Card window, click Multicard Template.

2 Click Next.

3 Select the required drivers from the list of NDIS2 drivers. 

Select no more than four or five drivers, as space is limited on a floppy disk.

4 Click Next to continue creating the boot disk.
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Adding network drivers to the Ghost Boot Wizard
The Ghost Boot Wizard includes drivers for over 130 network interface cards. If 
your driver is not in the list, you can add it to the wizard so that it is set up the 
next time that you need it.

The Network Interface Card window is available when creating a Peer-to-Peer 
Network Boot Disk or a Drive Mapping Boot Disk.

To begin adding a network driver to the Ghost Boot Wizard

1 In the Network Interface Card window, click Add.

2 Select one of the following:

■ Packet Driver

■ NDIS2 Driver

Many manufacturers ship both drivers with their network cards so you 
have a choice of which one to use.

3 Click OK to continue creating the boot disk.

Adding packet drivers to the Ghost Boot Wizard
Packet drivers are usually DOS executables (with .com or .exe file extensions) that 
load from the Autoexec.bat file before Norton Ghost loads. Norton Ghost 
communicates directly with the packet driver to use the services provided by the 
network card.

To add a packet driver to the Ghost Boot Wizard

1 In the Template Properties window, on the Packet Driver tab, in the Driver 
Executable field, click Browse to locate the packet driver so that the Ghost 
Boot Wizard can copy the file to the current template. 

Packet drivers are usually included on the driver disk supplied with the 
network card. If you are installing the packet driver from the original disks 
that came with your network interface card, the packet driver should be in a 
directory called Packet or Pktdrv.

2 In the Parameters field, type the command-line parameters if the network 
card requires them. 

These parameters vary from driver to driver and are usually optional with 
plug-and-play network cards. Consult the documentation that came with the 
network card. This is often in the form of a Readme.txt file in the same 
directory as the driver itself. 
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3 Click Select Automatically to let Ghost determine the best multicasting 
mode based on the information in the packet driver. 

If the Select Automatically mode does not work, try Receive Mode 5. If that 
does not work, try Receive Mode 6.

Adding NDIS2 drivers to the Ghost Boot Wizard
NDIS2 drivers work with the Microsoft Network Client. NDIS2 drivers are DOS 
drivers that load from the DOS Config.sys file. 

To add an NDIS2 driver to the Ghost Boot Wizard

1 In the Template Properties window, on the NDIS Driver tab, click Setup.

2 Locate the NDIS2 driver. 

In many cases Ghost can automatically determine the other parameters for 
your network.When locating the directory that contains the driver, look for a 
folder named Ndis or Ndis2. If you have a choice between DOS and OS2 
folders, select DOS.

3 Click OK.

If the setup fails to complete the driver properties, then complete the 
following fields manually:

■ Filename: Type the DOS file name for the NDIS2 driver.

■ Driver Name: Type the internal name of the driver. 

The internal name of the driver is used when generating the Protocol.ini 
configuration file and must always end with a $ character. Read the 
sample Protocol.ini file in the same directory as the driver itself to find 
the driver name.

■ Parameters: Type the parameters for the Protocol.ini configuration file. 

If you use Setup to automatically fill in this page, you will see the parameters 
that you need to adjust. For the majority of plug-and-play cards, all of the 
parameters are optional, so you can either accept the defaults or leave this 
field empty.

4 Click OK.

When you have created the template that you require, you can continue creating 
a boot disk.
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Customizing the template
You may require additional drivers and programs in order to use the network 
device attached to your computer. For example, many USB network devices must 
load an extra driver for the USB port before the driver for the network device. 

You can add files to the template and customize the Autoexec.bat and Config.sys 
files of the resulting boot disk. Usually these are either DOS drivers or executable 
programs, but you can add any type of file. Files added to the template appear in 
the list to the right of the button.

If this template is used as a multicard template, then any additional files or 
modifications are overridden by its settings.

The Template Properties window is available when creating a Peer-to-Peer Network 

Boot Disk or a Drive Mapping Boot Disk.

To modify a template

1 In the Template Properties window, on the Advanced tab, click New.

2 Click Delete to delete the selected file from the list.

3 In the Autoexec.bat field, type any additional Autoexec.bat entries for the 
driver. 

The entries appear before any network-related commands, such as 
Netbind.com or the packet driver executable.

4 In the Config.sys field, type any additional Config.sys entries for the driver. 

The entries appear before any driver-related devices to ensure that the 
enabling drivers load before the main network device drivers specified on the 
network driver page.

Adding command-line parameters to a boot package
You can add command-line parameters to a boot package to instruct Norton 
Ghost to perform certain actions.

See “Command-line switches” on page 153.

Command-line parameters can be added while creating a Standard Boot Disk, a 
Peer-to-Peer Network Boot Disk, or a CD/DVD Startup Disk with Ghost boot 
disk in the Ghost executable location window.
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In the following example, the parameters instruct Norton Ghost to back up your 
main disk to an image on another drive.

-clone,mode=create,src=1,dst=d:\backups\maindrv.gho

Providing MS-DOS
The Ghost Boot Wizard includes PC-DOS on boot disks. However, a boot disk 
that includes PC-DOS might not start all computers. When you create a boot 
disk, you can include MS-DOS instead of PC-DOS.

If you use MS-DOS, then you must provide MS-DOS files on the computer on 
which you are creating the boot disk. Using an MS-DOS system disk that was 
formatted on a Windows 95/98 computer, you can install the MS-DOS files 
during the creation of the boot disk.

To install MS-DOS on your computer

To create an MS-DOS system disk on a Windows 95/98 computer

1 Insert a blank floppy disk into drive A of a Windows 95/98 computer.

2 Click Start > Program Files > Windows Explorer.

3 Right-click drive A.

Warning: Do not right-click drive C.

4 Click Format.

5 Check Copy System Files.

6 Click Start to format the disk.

You can install or uninstall MS-DOS while you are creating a boot disk.

Table 6-2 Command parameters 

Clone Parameters Description

mode=create Creates an image file

src=1 Specifies drive 1 as the source drive

dst=D:\Backups\Maindrv.gho Saves the image to the file D:\Backups\Maindrv.gho
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To install MS-DOS on your computer

1 Insert the formatted floppy disk into drive A of the computer on which the 
Ghost Boot Wizard is running.

2 In the DOS Version window, click Get MS-DOS.

3 Click OK.

To uninstall MS-DOS from your computer

1 In the DOS Version window, click Remove MS-DOS.

2 Click OK.
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■ Establishing a peer-to-peer connection with Ghost.exe

■ Creating a backup image file
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■ Cloning disks and partitions

■ Verifying image integrity

■ Adding switches to your Ghost operation



92 Backing up, restoring, and cloning from DOS
An overview of using Ghost.exe
An overview of using Ghost.exe
You can use the Norton Ghost executable, Ghost.exe, to clone a computer, create 
a backup, and restore a computer. You can add switches to the cloning task in the 
Options window or as parameters to Ghost.exe. Ghost.exe is run within DOS. 

The following is an overview of the process of using Ghost.exe.

To use Norton Ghost

1 Start Ghost.exe.

Add command-line switches, if necessary. 

See “Command-line switches” on page 153.

2 If you want to establish a peer-to-peer connection, then set up the 
connection.

3 Select the Norton Ghost operation:

■ Disk or partition to image file

■ Disk or partition from image file

■ Disk to disk

■ Partition to partition

4 Do one of the following:

■ Select the source hard disk or partitions.

■ Select the image file.

5 Do one of the following:

■ Select the destination hard disk or partition.

■ Select the image file.

Make sure that you select the correct destination to overwrite. The 
destination disk is completely overwritten with no chance of recovering any 
data.

6 Complete the Ghost operation.

Note: On the Ghost.exe main menu, the option of GhostCast is not supported. 
The GhostCast functionality is available only with Symantec Ghost Enterprise 
Edition. If you require GhostCast functionality, see “Service and support 
solutions” on page 209.
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Starting the Norton Ghost executable
The Norton Ghost executable is a DOS-based application and runs in DOS mode 
outside of Windows. If you run the Norton Ghost executable (Ghost.exe) within 
Windows 95/98/Me, note the following:

■ Files may be in an open or changing state. If these files are cloned or backed 
up, the resulting destination files are left in an inconsistent state.

■ The partition on which Windows is installed must not be overwritten.

■ If you overwrite a disk or partition, the computer must be restarted.

■ Ghost.exe does not automatically restart the system.

■ Hard disk sizes may appear smaller than their actual sizes. The Norton Ghost 
executable can only access the shown destination size. The remaining space is 
not used.

■ The Norton Ghost executable fails if you try to overwrite any of the 
following:

■ Windows swap files

■ Registry files

■ Open files

You cannot run Ghost.exe within Windows NT, Windows 2000/XP, Linux, OS/2, 
or other non-DOS operating systems. To run Ghost.exe on a computer that runs 
a non-DOS operating system, start the computer in DOS using a Ghost boot disk.
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To start the Norton Ghost executable

◆ Do one of the following:

■ Insert a Ghost boot disk into the floppy disk drive of your computer and 
start your computer. 

See “Creating boot disks and boot images” on page 75.

■ For Windows 98 computers, start your computer in DOS. At the DOS 
prompt, type:

C:> \progra~1\symantec \Norton~1\ghost.exe

Running Norton Ghost in DOS may require additional DOS drivers to 
let Norton Ghost access and use some hardware. If you cannot access 
some hardware, such as a CD-R/RW drive, then create a boot disk that 
contains the drivers to access the hardware in DOS.

See “Creating boot disks and boot images” on page 75.

■ Use the Run Ghost Interactively Wizard.

See “Starting Ghost.exe” on page 59.

Marking your disks
The first time that you run Ghost.exe on your computer, the License agreement 
warning dialog box appears. When you click OK, Norton Ghost marks all hard 
disks to ensure that you do not see this message again.

To mark your disks

◆ In the License agreement warning dialog box, click OK to mark your hard 
disks.

Navigating without a mouse
If you have mouse drivers loaded, then you can use the mouse to navigate in 
Norton Ghost. You can also use the keyboard.

■ Use arrow keys to navigate the menu.

■ Press Tab to move from button to button.

■ Press Enter to activate the selected button.

■ Press Enter to select an item in a list.
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Establishing a peer-to-peer connection with 
Ghost.exe

If you are using an LPT, USB, or TCP peer-to-peer connection, then you must set 
up the connection between your computers before a clone, backup or restore 
operation.

The computers must be physically connected using one of the following:

■ LPT: A parallel connection cable

■ USB: A USB 1.1 cable

■ TCP peer-to-peer: A network connection

See “TCP/IP connections” on page 178.

In a peer-to-peer operation, one computer is designated the master computer, 
and the other is designated the slave computer. This table describes the possible 
Norton Ghost processes and the master/slave relationships that exist between two 
computers.

Select which computer is the master (the computer from which you control the 
connection), and which is the slave (the other computer participating in the 
connection). All operator input must occur on the master computer. 

Table 7-1 Master and slave computers

Action Master Slave

Disk-to-disk clone Computer containing source 
disk

Computer containing 
destination disk

Back up disk to image 
file

Computer containing source 
disk

Computer receiving 
destination image file

Restore disk from 
image file

Computer containing 
destination disk

Computer containing source 
image file

Partition-to-partition 
clone

Computer containing source 
partition

Computer containing 
destination partition

Back up partition to 
image file

Computer containing source 
partition

Computer receiving 
destination image file

Restore partition from 
image file

Computer containing 
destination partition

Computer containing source 
image file
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You must have two Ghost boot disks with which to start your computers. Create 
the boot disks using the Ghost Boot Wizard.

Note: Ensure that both boot disks are created with the same version of Norton 
Ghost. You cannot use one boot disk created in Norton Ghost 2002 and one boot 
disk created in Norton Ghost 2003 in the same task.

See “Creating boot disks and boot images” on page 75.

To connect two computers peer-to-peer

1 Insert a Ghost Boot Disk into the floppy disk drive of each computer.

2 Restart each computer.

3 On the slave computer, on the main menu, do one of the following:

■ Click Peer to peer > USB > Slave to start the computer as the slave 
computer in a USB connection.

■ Click Peer to peer > LPT > Slave to start the computer as the slave 
computer in an LPT connection.

■ Click Peer to peer > TCP/IP > Slave to start the computer as the slave 
computer in a TCP/IP connection.

Take note of the IP address displayed in the Slave Connect dialog box.

4 On the master computer, on the main menu, do one of the following:

■ Click Peer to peer > USB > Master to start the computer as the master 
computer in a USB connection.

■ Click Peer to peer > LPT > Master to start the computer as the master 
computer in an LPT connection.

■ Click Peer to peer > TCP/IP > Master to start the computer as the 
master computer in a TCP/IP connection and type the IP address 
displayed on the slave computer.
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Creating a backup image file
You can create a backup of either of the following:

■ A hard disk

■ A partition

The backup is saved as an image file, which you can store on one of the following:

■ A second hard disk

■ A second partition on your hard disk (partition backup only)

■ LS120 Superdisk, JAZ, or ZIP disk

■ CD-R/RW or DVD-R/RW

See “Saving an image file directly to a CD-R/RW or DVD-R/RW drive” on 
page 113.

■ Tape

■ Locally mapped network file server

■ Another computer using peer-to-peer

Compression may affect the speed of operations. When you select a compression 
level, Norton Ghost estimates the amount of space available for the destination 
image file. If there is insufficient space, Norton Ghost prompts you to enable 
spanning of image files.

Backing up a hard disk to an image file
When you back up a hard disk, a copy of the entire disk is saved as an image file.
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To back up a disk to an image file

1 On the Norton Ghost main menu, do one of the following:

■ Local: Click Local > Disk > To Image.

■ Peer-to-peer connection: Click Disk > To Image.

2 In the Source Drive dialog box, select the source disk.

The Source Drive dialog box shows details of every disk that Norton Ghost 
finds on the local computer. 

3 In the File Locator dialog box, type the image file destination and name.

4 In the Image file description dialog box, type a description of the image file. 

You can modify this description in Ghost Explorer when the image file has 
been created.

5 Click Save.

6 In the Compress Image? dialog box, do one of the following:

■ Click No for no compression (high speed).

■ Click Fast for low compression (medium speed).

■ Click High for high compression (slower speed).

See “Image files and compression” on page 62.

7 When the “Proceed with Image File Creation?” question appears, check the 
details and ensure that the correct options are selected. 
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8 Do one of the following:

■ Click Yes to proceed with the image file creation.

The system performs an integrity check of the file structure on the 
source disk and then copies the source disk to the destination image file. 
If you need to abort the process, press Ctrl+C, but be aware that this 
leaves the destination image file in an unknown state.

■ Click No to return to the menu.

9 If spanning is enabled and required, click Yes and type the location of the 
next span of the image file.

See “Image files and volume spanning” on page 63.

Note: If the image file reaches the size of 2 GB and there is not enough space to 
continue, you are prompted to insert the next media to continue. 

Verify the integrity of the image file when it has been created.

See “Verifying image integrity” on page 107.

Backing up a partition to an image file
You can create an image file from one or more partitions to use as a backup or to 
clone onto another partition or disk.

To back up a partition to an image file

1 On the main menu, do one of the following:

■ Local: Click Local > Partition > To Image.

■ Peer-to-peer connection: Click Partition > To Image.

2 In the Source Drive dialog box, select the source drive.

The Source Drive dialog box contains the details of every disk that Norton 
Ghost finds on the local computer.

3 In the Source Partition dialog box, select the source partitions to include in 
the destination image file.

The Source Partition dialog box contains the details of all the partitions on 
the selected source disk. Multiple partitions may be selected.

4 Click OK.

5 In the File Locator dialog box, select the image file destination and name.
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6 In the Image file description dialog box, type a description of the image file.

You can modify this description in Ghost Explorer when the image file has 
been created.

7 Click Save.

8 In the Compress Image? dialog box, do one of the following:

■ Click No for no compression (high speed).

■ Click Fast for low compression (medium speed).

■ Click High for high compression (slower speed).

See “Image files and compression” on page 62.

9 In the Proceed with partition image creation? dialog box, ensure that the 
correct options are selected. 

10 Do one of the following:

■ Click Yes to proceed with the image file creation.

The system performs a quick integrity check of the file structure on the 
source partitions and then copies the source partitions to the destination 
image file. If you need to abort the process, press Ctrl+C, but be aware 
that this leaves the destination image file in an unknown state.

■ Click No to return to the menu.

11 If spanning is enabled and required, click Yes and type the location of the 
next span of the image file.

See “Image files and volume spanning” on page 63.

Note: If the image file reaches the size of 2 GB and there is not enough space to 
continue, you are prompted to insert the next media to continue. 

Verify the integrity of the image file when it has been created.

See “Verifying image integrity” on page 107.
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Restoring from an image file
You can restore either of the following:

■ A hard disk

■ A partition

The restore is made from a previously created image file that has been stored on 
one of the following:

■ A second hard disk

■ A second partition on your hard disk

■ JAZ or ZIP disk

■ CD-R/RW

■ DVD

■ Tape

■ Mapped network drive

■ Drive on another computer (peer-to-peer)

Restoring a hard disk from an image file
When you restore a hard disk, it is overwritten by the contents of the image file.

To restore a disk from an image file

1 On the main menu, do one of the following:

■ Local: Click Local > Disk > From Image.

■ Peer-to-peer connection: Click Disk > From Image.

2 In the File Locator dialog box, do one of the following:

■ Type the path and file name of the image file.

■ Click Browse to locate the image file. 

Specify the drive or device and select the full path name. The image file 
may reside on a local drive or on a locally mapped network file server. 
When using peer-to-peer connections, the image file is located on the 
slave computer.

3 Press Enter.



102 Backing up, restoring, and cloning from DOS
Restoring from an image file
4 In the Destination Drive dialog box, select the destination disk.

Choose carefully as this is the disk that will be overwritten.

The Destination Drive dialog box shows the details of every drive that 
Norton Ghost finds on the local computer. If the source image file resides on 
a local disk, then this disk is not available for selection.

5 In the Destination Drive Details dialog box, confirm or change the 
destination disk partition layout.

The Destination Drive Details dialog box shows a suggested partition layout 
for the destination disk. By default, Norton Ghost tries to maintain the same 
size ratio between the new disk partitions. However, you should note the 
following:

■ You can change the size of any target FAT, NTFS, or Linux Ext2/3 
partition by entering the new size in megabytes.

■ You cannot enter a value that exceeds the available space, is beyond the 
file system’s limitations, or is not large enough to contain the data held 
in the source image.

6 Click OK.

7 Do one of the following:

■ Click Yes to proceed with the disk cloning.

Norton Ghost creates the destination disk using the source image file 
disk details. If you need to abort the process, press Ctrl+C, but be aware 
that this leaves the destination disk in an unknown state.

Warning: Only click Yes if you are sure that you want to proceed. The 
destination disk is completely overwritten with no chance of recovering any 
data.

■ Click No to return to the menu.

8 If spanning is enabled, do one of the following:

■ Click OK to continue on the same form of media.

■ Click Filename to restore from a different location, and then type the 
location and file name of the image file span.

Insert the next media, if prompted.

9 Restart the computer when the disk image restore is complete. 

Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the integrity of 
the destination disk.
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Restoring a partition from an image file
When you restore a partition, it is overwritten by the data from an image file.

To restore a partition from an image file

1 On the main menu, do one of the following:

■ Local: Click Local > Partition > From Image.

■ Peer-to-peer connection: Click Partition > From Image.

2 In the File Locator dialog box, do one of the following:

■ Type the path and file name of the image file.

■ Click Browse to locate the image file. 

Specify the drive or device and select the full path name. The image file 
may reside on a local drive or on a locally mapped network file server. 
When using peer-to-peer connections, the image file is located on the 
slave computer.

3 Press Enter.

4 In the Source Partition dialog box, select the source partition from the image 
file.

The Source Partition dialog box contains the details of all of the partitions in 
the image file.

5 In the Destination Drive dialog box, select the destination disk.

The Destination Drive dialog box contains the details of every disk that 
Norton Ghost finds on the local computer.

6 In the Destination Partition dialog box, select the destination partition. 

Select an existing partition carefully as this is the partition that will be 
overwritten.

The Destination Partition dialog box contains the details of all of the 
partitions on the selected destination disk. If this is a local partition-to-
partition copy, then the source partition is unavailable for selection. 
However, you can create a new partition if space is available. If you create a 
new partition, it can be resized during the cloning operation. 

7 In the Proceed with partition restore? dialog box, ensure that the correct 
options are selected. 
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8 Do one of the following:

■ Click Yes to proceed with the partition cloning.

Norton Ghost overwrites the destination partition using the partition 
details contained in the image file. If you need to abort the process, press 
Ctrl+C, but be aware that this leaves the destination partition in an 
unknown state.

Warning: Only click Yes if you are sure that you want to proceed. The 
destination partition is completely overwritten with no chance of recovering 
any data.

■ Click No to return to the menu. 

9 If spanning is enabled, do one of the following:

■ Click OK to continue on the same form of media.

■ Click Filename to restore from a different location, and then type the 
location and file name of the image file span.

Insert the next media if prompted.

10 Restart the destination computer when the partition copy is complete. 

Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the integrity of 
the destination partition.

Cloning disks and partitions
By default, Norton Ghost tries to maintain the same size ratio between the new 
disk partitions. However, you should note the following:

■ You can change the size of any destination FAT, NTFS, or Linux Ext2/3 
partition by entering the new size in megabytes.

■ You cannot enter a value that exceeds the available space, is beyond the file 
system’s limitations, or that is not large enough to contain the data held in 
the source partition.
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Cloning disk to disk
When you clone disk to disk, Norton Ghost copies the contents of one hard disk 
onto another.

To clone disk to disk

1 On the Norton Ghost main menu, do one of the following:

■ Local: Click Local > Disk > To Disk.

■ Peer-to-peer connection: Click Disk > To Disk.

2 In the Source Drive dialog box, select the source disk.

The Source Drive dialog box shows the details of every disk that Norton 
Ghost finds on the local computer.

3 In the Destination Drive dialog box, select the destination disk.

Choose carefully as this is the disk that will be overwritten.

If a peer-to-peer connection method is used, the destination disk can be any 
of the slave computer’s disks. However, if this is a local disk-to-disk copy, 
then the source disk is unavailable for selection.

4 Confirm the destination disk layout.

Warning: The Destination Drive Details dialog box shows a suggested 
partition layout for the destination drive once the cloning process has been 
completed. This partition layout may mirror the source drive layout. 
Therefore, the destination drive details appear similar to the source drive. 

5 Click OK.

6 When the “Proceed with disk clone?” question appears, check the details and 
ensure that the correct options are selected. 
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7 Do one of the following:

■ Click Yes to proceed with the disk cloning.

The system performs an integrity check of the file structure on the 
source disk, and then copies the source disk to the destination. If you 
need to abort the process press, Ctrl+C, but be aware that this leaves the 
destination disk in an unknown state.

Warning: Only click Yes if you are sure that you want to proceed. The 
destination disk is overwritten with no chance of recovering any data.

■ Click No to return to the menu.

8 Restart the computer. 

Warning: You should remove one of the hard disks before you restart your 
computer. If you leave two hard disks in the computer, damage can occur to 
both of the bootable operating systems.

Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the integrity of 
the destination disk.

Cloning partition to partition
When you clone partition to partition, Norton Ghost copies the contents of one 
partition onto another.

To clone from partition to partition

1 On the main menu, do one of the following:

■ Local: Click Local > Partition > To Partition.

■ Peer-to-peer connection: Click Partition > To Partition.

2 In the Source Drive dialog box, select the source disk.

The Source Drive dialog box shows details of every disk that Norton Ghost 
finds on the local computer.

3 In the Source Partition dialog box, select the source partition.

The Source Partition dialog box shows the details of all of the partitions on 
the selected source disk.

4 In the Destination Drive dialog box, select the destination disk.

The Destination Drive dialog box shows the details of every disk that Norton 
Ghost finds on the destination computer. For peer-to-peer connections, the 
slave computer is the destination. 
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5 In the Destination Partition dialog box, select the destination partition.

Select an existing partition carefully as this is the partition that is 
overwritten.

The Destination Partition dialog box shows the details of all of the partitions 
on the selected destination disk. If this is a local partition-to-partition copy, 
then the source partition is unavailable for selection. However, you can create 
a new partition if space is available. If you create a new partition, it can be 
resized during the cloning operation. 

6 Click OK.

When the final “Proceed with Partition Copy?” question appears, ensure that 
the correct options are selected. 

This is the last chance to back out. 

7 Do one of the following:

■ Click Yes to proceed with the partition copy.

If you need to abort the process, press Ctrl+C, but be aware that this 
leaves the destination disk in an unknown state.

Warning: Only click Yes if you are sure that you want to proceed. The 
destination partition is completely overwritten with no chance of recovering 
any data.

■ Click No to return to the menu.

8 Restart the destination computer when the partition copy is complete. 

Run Symantec Disk Doctor, ScanDisk, or a similar utility to verify the integrity of 
the destination partition.

Verifying image integrity
After a backup, restore, or clone, run a check to verify the integrity of the 
partition, hard disk, or computer.

To verify an image file or disk

To verify the integrity of an image file

◆ On the computer on which the image file is saved, on the main menu, do one 
of the following:

■ Local: Click Local > Check > Image File.

■ Peer-to-peer connection: Click Check > Image File.
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To verify the integrity of a disk

1 On the main menu, do one of the following:

■ Local: Click Local > Check > Disk.

■ Peer-to-peer connection: Click Check > Disk.

2 Select the source disk to verify.

3 Click OK.

4 Click Yes to continue with the disk check.

Adding switches to your Ghost operation
You can include a number of options (or switches) that can also be entered using 
the command-line. These switches are set in the Ghost.exe user interface.
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To add switches to your Ghost operation

1 On the main menu, click Options.

2 On the following tabs, select the options to include in your current cloning 
task:

See “Command-line switches” on page 153.

3 On the Save Settings tab, click Save Settings to confirm the list of active 
switches listed.

4 Click Accept to include the settings in the current task.

Table 7-2 Optional switches

Tab Command-line options

Span/CRC -span, -auto, -cns, -crcignore, -fcr

FAT 32/64 -f32,-f64, -fatlimit

Misc -sure, -fro, -rb, -fx

Image/Tape -ia, -ib, -id

-tapebuffered, -tapeeject, -tapesafe, -tapeunbuffered

HDD access -ffx, -fnx, -ffi, -fni, -ffs, -fns

Security -pwd, -locktype=type
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Chapter
 8
Backing up and restoring 
with CD-R/RW and DVD-
R/RW

This chapter includes the following topics:

■ Image files and CD/DVD writers

■ Saving an image file directly to a CD-R/RW or DVD-R/RW drive

■ Saving an image file to an unsupported CD-R/RW or DVD-R/RW drive
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Image files and CD/DVD writers
Norton Ghost support of SCSI and IDE CD and DVD writers allows the storage 
of a single image file onto one or more CD-R/RW or DVD-R/RW. Norton Ghost 
supports many CD and DVD drives. If you have problems writing to CD-R/RW 
or DVD-R/RW, then check that your drive is listed on the support Web site,

http://service1.symantec.com/SUPPORT/ghost.nsf/docid/2002030414141625

If you run Norton Ghost from a Windows wizard, it searches for a CD/DVD 
writer with media inserted and automatically selects this writer.

When you use CD/DVD writers with Ghost.exe, you can select a writer as the 
destination device in the File Locator window. Each writer is shown as CD-Rx, 
where x is a number starting at one and increasing incrementally for each writer 
present. For example, the following screen shows a CD writer available for use.

For Norton Ghost to access SCSI CD/DVD writers, a DOS ASPI driver must be 
installed prior to use. The Backup and Clone Wizards attempt to detect and 
install the driver automatically, but you may have to select the drivers in the 
Advanced Settings. When creating a Ghost boot disk from the Ghost Boot 
Wizard, you must include the Adaptec ASPI drivers.

See “Standard boot disks” on page 76.

Norton Ghost should work with most SCSI and IDE writers produced in 2000 or 
later. It may or may not work with older models. Use the latest firmware available 
for your CD/DVD writer. An IDE CD/DVD writer performs best if it is mounted 
on the secondary IDE controller. 

A list of CD/DVD writers with which Norton Ghost has been tested is available 
on the Symantec Service and Support Web site:

http://service1.symantec.com/SUPPORT/ghost.nsf/docid/2002030414141625
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If your CD/DVD device is not listed on the Web site, use the Integrity Check 
Wizard to ensure that your image can be restored. The Integrity Check Wizard 
performs a dummy restore and confirms that your CD/DVD drive is compatible 
with Norton Ghost.

Table 8-1 lists the media that you should use with CD and DVD writers and the 
action that Norton Ghost takes.

When you create an image on CD/DVD, you can make the CD/DVD bootable. 
The Backup Wizard does this automatically, but when you create an image from 
Ghost.exe, then you need an appropriate boot disk created with the Ghost Boot 
Wizard to make the CD/DVD bootable.

See “Standard boot disks” on page 76.

Saving an image file directly to a CD-R/RW or DVD-
R/RW drive

You can save an image file directly to a CD or DVD. You can also make the CD/
DVD bootable.

When writing an image file directly to a CD-R/RW or DVD-R/RW, note the 
following:

■ The CD/DVD drive must be compatible with Norton Ghost.

■ Norton Ghost automatically spans CD-R/RW disks if necessary. You do not 
need to use a spanning switch on the command line.

See “Image files and volume spanning” on page 63.

■ If the CD-RW/DVD-RW contains existing data, Norton Ghost prompts you 
to confirm that you want the data erased.

Table 8-1 CD and DVD media

Type of drive Media

CD-R Blank

CD-RW Prompts to erase existing data before writing new data

DVD-R Blank

DVD-RW Prompts to erase existing data before writing new data

DVD+R Blank

DVD+RW Prompts to overwrite existing data
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If Norton Ghost does not support your CD-R/RW drive and the image file is too 
large to fit on one CD, you can still save the image file to CD.

See “Saving an image file to an unsupported CD-R/RW or DVD-R/RW drive” on 
page 114.

Saving an image file to an unsupported CD-R/RW or 
DVD-R/RW drive

Not all CD-R/RW/DVD drives are supported by Norton Ghost. If your drive is 
unsupported, you can create an image file and then write it to CD/DVD using 
third-party software.

If your drive is unsupported, and the image file is too large to fit onto one disk, 
you can still save the image file to CD/DVD. 

There are two methods of saving an image file to an unsupported CD-R/RW/
DVD drive:

■ Splitting the image file while creating it

■ Splitting the image file after it has been created

The image file is initially saved to another partition or hard disk and then copied 
to a CD-R/RW/DVD disk using your CD/DVD recording software.

To save an image file onto a CD, you must split the image file into files that fit on 
a CD-ROM. Split the image into files that are not larger than 620 MB. This leaves 
room on a CD for any additional files that you might need or any difference in 
the capacity of the CD.

Note: Some CD/DVD writers let you write directly to the CD-RW/DVD as if to a 
drive letter. This is not supported by Norton Ghost. 

See “Using third-party software to write to the CD-R/RW disc” on page 200.
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Splitting an image file during a backup
To split an image file as it is created, run Norton Ghost from the command line in 
DOS, using the -split and -autoname switches.

To split an image file as it is created

1 Start Ghost.exe using the -split and -auto switches.

For example:

a:\ghost.exe -split=600 -auto

See “Starting the Norton Ghost executable” on page 93.

2 Create and save the image file.

See “Creating a backup image file” on page 97.

The -split command in this example limits the image size to a maximum of 600 
megabytes for any one segment. The -auto switch names each of the segments 
numerically. 

See “Command-line switches” on page 153.
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Using Ghost Explorer to 
modify image file 
contents

This chapter includes the following topics:

■ Understanding Ghost Explorer

■ Viewing image files

■ Launching a file

■ Extracting a file or directory from an image file

■ Modifying image files in Ghost Explorer

■ Listing the contents of an image file

■ Setting span file sizes

■ Splitting an image file

■ Compiling a file

■ Determining Norton Ghost image file version

■ Using Ghost Explorer from the command line
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Understanding Ghost Explorer
The Ghost Explorer utility lets you view, alter, add, and extract files from an 
image file. This means that you can add extra files to the image file, move the files 
within the image file, and extract files from the image file to copy onto client 
computers.

Note: If an image file has been created from an NTFS partition, you can view and 
extract files from the image file. You cannot add files to or delete files from the 
image file.

Ghost Explorer lets you quickly and easily extract files or directories from an 
image file. Using Ghost Explorer, you can do the following:

■ View image file contents and save a list of files within an image file.

■ Extract files or directories from an image file.

■ Add, move, copy, delete, and launch files from and within an image file.

■ Use drag-and-drop or cut-and-paste functionality to add files and directories 
from Windows Explorer to the image file.

■ Set span sizes.

■ Add a description to an image file.

Note: Right-click a file or directory in Ghost Explorer to access a list of file 
commands.

Ghost Explorer supports the following partition types:

■ FAT12

■ FAT16

■ FAT32

■ NTFS (read only)

■ Linux Ext2/3
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Viewing image files
To open Ghost Explorer

1 On the Windows taskbar, click Start > Programs > Norton Ghost 2003 > 
Norton Ghost.

2 Click Ghost Utilities.

3 Click Norton Ghost Explorer.

Viewing image files
You can view the contents of an image file, including details of the partitions, 
directories, and files. 

To view an image file

1 Open Ghost Explorer.

See “To open Ghost Explorer” on page 119.

2 On the File menu, click Open.

3 Select an image file.

4 Click Open.

5 On the File menu, click Properties to view the image file properties.

Launching a file
This command is available only when you select a file in the right pane. 

Ghost Explorer restores a file to a temporary directory and attempts to open it. If 
the file is an executable program, it is run. If it is a data file and there is an 
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application installed and associated with this file type, the application opens with 
the data file.

If you try to launch an application that depends on other files within the image 
file, it will probably fail. Ghost Explorer does not determine what dependencies 
exist. Extract the required files and then run the application file.

To launch a file

1 In Ghost Explorer, in the right pane, select a file.

2 On the File menu, click Launch. 

Extracting a file or directory from an image file
You can extract a file or directory directly from an image file using Ghost 
Explorer. This does not delete the original file, but copies it to a new location.

To extract a file or directory from an image file

1 In Ghost Explorer, open the image file.

2 Select the file or directory to be extracted.

3 On the File menu, click Extract.

4 Select the location to which you want to extract the file or directory.

5 Click Extract to save the file or directory to the chosen location.

Note: You can also drag and drop a file from Ghost Explorer to Windows 
Explorer to extract it. 

Modifying image files in Ghost Explorer
You can use Ghost Explorer to add files or directories from Windows Explorer to 
any image file that was created in Norton Ghost version 6.0 or later and is not 
NTFS. You can also delete files from any image file that was created in Norton 
Ghost 5.1d or later and is not NTFS. You can check the version of Norton Ghost 
used to create your image file in Ghost Explorer. 

See “Determining Norton Ghost image file version” on page 123.
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Adding, moving, and deleting files
Within image files, Ghost Explorer supports Windows cut-and-paste operations, 
including copying, pasting, moving, deleting, and adding files to images. You can 
also drag and drop from Windows Explorer to Ghost Explorer.

Listing the contents of an image file
You can create a text file that contains a list of the directories (and, optionally, 
files and their details) that are in the current image file. You can store this file 
with the image file to keep an easily accessible list of the image file contents.

To list the contents of an image file

1 In Ghost Explorer, open the image file.

2 On the File menu, click List Contents.

3 Do one of the following:

■ Click Directories only to include directories only.

■ Click Include Files to include files.

■ Click Include Details to include file details.

4 Select a directory to which to save the text file.

5 Type a file name.

6 Click Save.

Setting span file sizes
Norton Ghost lets you split an image file into smaller files called spans. The Span 
Split Point function in Ghost Explorer lets you set the size of each span so that 
when you add files or directories, each span file does not get bigger than the 
specified size.

To set a span file size

1 On the View menu, click Options.

2 In the Span Split Point (MB) field, type the required size.

3 Click Autoname Spans if you want Ghost Explorer to choose a default name 
for additional span files that it creates.
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Splitting an image file
You can split an existing image file into smaller spans. This function is useful if, 
for example, you need to split a file into two or more files that can then be saved 
onto a CD/DVD drive that is unsupported by Norton Ghost. Once this option is 
set, it becomes the default for all regenerated files.

See “Spanned image files” on page 64.

Note: If the CD-R/RW drive is supported by Norton Ghost, then you can save an 
image file directly to CD as it is created.

See “Creating a backup image file” on page 36.

To split an existing image file

1 In Ghost Explorer, open the image file.

2 Select one of the following:

■ The image file

■ A single partition

3 On the File menu, click Options.

4 In the Span Split Point (MB) field, type the required size.

If you are splitting the file to save onto CD, then set the size to 600 MB.

5 Click Autoname Spans if you want Ghost Explorer to choose a default name 
for additional span files that it creates.

6 Click OK.

7 Type a name and location for the first new file.

All the new files created are saved in the same location. Use a different name 
from the original image file to avoid confusion.

8 Click OK to start the regeneration.

9 Click OK each time that you are prompted to create a new span segment.

Compiling a file
If you add or delete files from within an image file, the image file becomes 
fragmented. Norton Ghost takes longer to restore a fragmented image than a 
compiled file. Compiling a file defragments it, which improves performance 
during the restore.
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Check the properties of the image file to see whether compilation is 
recommended.

To compile a file

1 On the File menu, click Compile if compilation is recommended.

2 Type a new name for the compiled file.

3 Click Save.

Determining Norton Ghost image file version
Whether you can add, delete, or view an image file, or move files within an image 
file depends on the version of Norton Ghost that was used to create the image file. 
Ghost Explorer cannot open a file created with a version of Norton Ghost earlier 
than 3.0. If the image file was created in Norton Ghost 3.0 or later, you can 
determine the version by looking at the file’s properties in Ghost Explorer.

To determine the version of Norton Ghost used to create an image file

1 In Ghost Explorer, open the image file.

2 On the File menu, click Properties.

The Properties window appears. The version of Norton Ghost used to create 
the image file appears next to Produced by Ghost version.

Using Ghost Explorer from the command line
You can start Ghost Explorer from an command prompt by typing its path and 
file name. 

To start Ghost Explorer from a command prompt

1 On the Windows taskbar, click Start > Programs > Accessories > Command 
Prompt.

2 Type Ghostexp.

3 Press Enter.

You can also provide a Ghost image file as an argument for Ghost Explorer to 
open. For example:

Ghostexp n:\Images\Myimage.gho
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If Ghost Explorer reports a corruption in your image file, you may be able to get 
further details of the nature of the corruption. Normally, you would only use 
these options when asked to do so by Ghost Explorer Technical Support.
Table 9-1 lists the arguments with which you can start the program.

The reports are presented to you as dialog boxes. You can use all switches or use 
-d7 to turn on all options. 

Ghost Explorer has a batch mode in which it carries out a single command and 
then exits. In this version, batch mode supports the saving of the contents to a 
text file only. To use this mode, specify one of the switches in Table 9-2.

See “Listing the contents of an image file” on page 121.

If Ghost Explorer reports that a spanned or split image is corrupt without 
prompting for the second part of the image, it may not recognize that the image is 
split. Starting with the -split argument forces Ghost Explorer to treat an image as 
a split image.

See “Setting span file sizes” on page 121.

Table 9-1 Ghost Explorer arguments

-d1 Reports on corruptions or significant events in FAT file systems

-d2 Reports on corruptions or significant events in NTFS file systems

-d4 Reports on corruptions or significant events in Ext2/3 files

Table 9-2 Batch mode switches

-t Saves the list of directories in the dump file to a file with the same 
name as the image file but with an extension of .txt

-tf Saves a list of directories and files

-tv Saves a verbose listing of directories and files

-t[vf]=filename Saves the list to the file specified
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Using Ghost Explorer with long file names
The image index created by versions of Norton Ghost prior to 5.1c did not handle 
long file names containing double-byte characters correctly, such as file names in 
Asian or Eastern European languages. Ghost Explorer may be able to show these 
names properly by reading them directly from the image file instead of from the 
index. However, the restoring of the image is much slower. Use the switch 
-ignoreindex to force this behavior. You must have the correct char set loaded.

To set the correct char set

1 On the Windows taskbar, click Start > Settings > Control Panel.

2 Double-click Regional Options.

3 Select the required language option, and then click OK.
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This chapter includes the following topics:

■ Introducing GDisk

■ Running GDisk

■ Overview of main command-line switches

■ Creating a partition

■ Reinitializing the Master Boot Record

■ Showing information about disks

■ Performing multiple GDisk operations using batch mode

■ FAT16 partitions in Windows NT

■ Deleting and wiping your disk

■ Activating or deactivating a partition

■ Hiding or unhiding a partition

■ Modifying the Windows NT/2000/XP boot menu

■ Support for Large Hard Disks
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Introducing GDisk
GDisk lets you create partitions, reinitialize Master Boot Records, delete data, and 
wipe your disks in many different ways.

Two versions of GDisk are supplied with Norton Ghost:

■ GDisk: Runs in DOS

■ GDisk32: Runs from the command line in a Windows operating system

Not all GDisk command-line switches can be run with GDisk32.

GDisk is a complete replacement for the Fdisk and Format utilities that offers the 
following features:

■ On-the-fly formatting

■ Extensive partition reporting

■ High-security disk wiping

■ The ability to hide a partition or make a hidden partition visible

Unlike Fdisk, which uses interactive menus and prompts, GDisk is command-
line driven. This offers quicker configuration of a disk's partitions and the ability 
to define GDisk operations in a batch file.

Running GDisk
Run either GDisk in DOS or GDisk32 in Windows.

To run GDisk

1 Start your computer in DOS mode.

2 At the DOS prompt, type GDisk followed by the required disk and switches.

Note: The default path for GDisk is progra~1\symantec\Norton~1\GDisk.

To run GDisk32

1 On the Windows taskbar, open a DOS window.

2 At the DOS prompt, type GDisk32 followed by the required disk and 
switches.
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Overview of main command-line switches
GDisk has nine main modes of operation. The first four correspond to the menu 
options on the Fdisk main menu. The mode in which GDisk operates is selected 
by one of the following switches: 

Table 10-1 GDisk main commands

Mode Switch Explanation

Create /cre Creates partitions: primary DOS partitions, extended 
DOS partitions. This switch functions with GDisk 
only.

Delete /del Deletes partitions of any type, including non-DOS 
partitions. This switch functions with GDisk only.

Status (default) /status Lists information on the specified fixed disk and its 
partitions.

Activate ■ /act

■ /-act

Activates and deactivates a partition (specifying it as 
the bootable partition).

Hide ■ /hide

■ /-hide

Hides an existing partition or unhides a hidden 
partition.

Reinitialize MBR /mbr Reinitializes the Master Boot Record. This switch 
functions with GDisk only.

Batch /batch Uses batch-mode command execution.

Disk wipe /diskwipe Wipes the contents of the whole disk. This switch 
functions with GDisk only.

Boot.ini /bootini Makes a modification to the Windows NT/2000/XP 
boot menu. This switch functions with GDisk32 only.
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Online Help for command-line switches
You can get an overview of the nine modes of operation and their switches by 
using the Help switch as follows:

■ GDisk: gdisk /?

■ GDisk32: gdisk32 /?

Note: An additional switch not shown in Help is the /VERSION switch. This 
switch shows the version information for the GDisk executable.

More detailed Help is available by qualifying the Help command with the switch 
for one of the nine main modes of operation. 

For example, to view the detailed Help file for Hide, type one of the following 
command lines:

■ GDisk: gdisk /hide /?

■ GDisk32: gdisk32 /hide /?

Switches common to all GDisk commands
You can use the following switches for any of the nine main GDisk operations:

Table 10-2 Switches common to all GDisk commands

Switch Explanation

/x Prevents GDisk from using extended disk access support. This may result in 
GDisk not being aware of the full capacity of the disk.

/i Prevents GDisk from using direct IDE disk access support. This may result 
in GDisk not being aware of the full capacity of the disk.

/s Prevents GDisk from using direct SCSI disk access support. This may result 
in GDisk not being aware of the full capacity of the disk.

/y Suppresses prompting to confirm the operation. If you do not use this 
switch, you are not necessarily prompted before a partition is deleted or 
another possibly destructive operation is executed.

/sure Suppresses prompting to confirm the operation. Same functionality as /y.

/r Causes GDisk to restart the computer if the operation is successful.
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Creating a partition
The create switch creates a partition of the specified type using the largest block of 
unused disk space. The partition is not formatted during the operation unless the 
/for switch is used. You cannot create an NTFS partition or a dynamic disk 
partition.

This switch functions with GDisk only.

Note: When GDisk creates a FAT32 partition, it aligns the first data sector to a 4 
KB boundary from the start of the partition.

The syntax for this command is as follows:

gdisk disk /cre {/pri| /ext| /log} [/sz: {MB|pcent{p|%}}]
[/end] [/for [/q] [/v[:label]]] [/-32] [/ntfat16]

For example, to create a FAT32 formatted partition that uses the entire disk, type 
the following command:

gdisk 1 /cre /pri /for /q

Table 10-3 Create switches

Switch Explanation

disk Represents the physical fixed disk, from 1 to 8.

/cre Creates a DOS partition or logical DOS drive.

/pri Creates a primary DOS partition.

/ext Creates an extended DOS partition. 

/log Creates a logical DOS drive in the extended DOS partition.

/sz:MB Specifies the size of the partition in megabytes (MB). This is 
rounded up to the nearest cylinder.

/sz:pcent{p|%} Specifies the size of the partition as a percentage of the total disk 
size, not the available disk space.

/end Creates the partition at the end of the free space. If this switch is not 
used, then the partition is created at the beginning of the free space.

If the command line specifies that all of the available space is to be 
used to create the partition, then the /end switch is ignored.
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Reinitializing the Master Boot Record
Use the /mbr switch to rewrite the boot code in the Master Boot Record (MBR). 
You may need to reinitialize the MBR to eliminate a boot sector virus residing 
there. You can also use the /mbr switch with the /wipe option to delete a dynamic 
disk.

This switch functions with GDisk only.

Note: The switch must be used when you delete Linux partitions if LILO resides 
in the MBR.

/for Formats the new partition once it has been created. Unless the 
/ntfat16 or /-32 switches are used, the partition type is determined 
by the following:

■ If the partition is less than 16MB: FAT12

■ If the partition is between 16MB and 512MB: FAT16

■ If the partition is greater than 512MB: FAT32

/q Performs a quick format if used in combination with the /for 
switch. If you do not use this switch, then GDisk performs a surface 
scan of the partition and marks any bad sectors.

/v[:label] Gives the new formatted partition the specified label when used in 
combination with the /for switch.

/-32 Indicates that the partition is not formatted as FAT32. Limits 
primary and logical partitions to 2048 MB. Partitions over 16 MB 
are formatted as FAT16. This switch is useful if the operating system 
does not support FAT32, such as Windows NT 4.

/ntfat16 Lets you create a FAT16 primary or logical partition, up to 4097 
MB. The cluster size is 64 KB. Partitions over 16 MB are formatted 
as FAT16. Windows 9x and DOS systems may be unable to access 
partitions that are created with this switch and are over 2048 MB. 

Table 10-3 Create switches

Switch Explanation
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The syntax for this command is as follows:

gdisk disk /mbr [/wipe]

Showing information about disks
The status switch shows information about the fixed disks and partitions on a 
disk, including the model of the disk. You must specify the disk number to get 
information about the partitions on a disk. 

Depending on the version of GDisk that you require, the syntax for this 
command is one of the following:

■ GDisk: gdisk [disk] [/status] [/raw] [/lba] [/ser]

■ GDisk32: gdisk32 [disk] [/status] [/raw] [/lba] [/ser]

Table 10-4 /mbr switches

Switch Explanation

disk Represents the physical fixed disk, from 1 to 8.

/mbr Reinitializes the boot code in the Master Boot Record.

/wipe Deletes the partition on the disk.

Table 10-5 /status switches

Switch Explanation

disk Represents the physical fixed disk, from 1 to 8.

/raw Shows the contents of the partition table in CHS form if used with the 
disk switch.

/lba Shows the contents of the partition table in logical block form if used 
with the disk switch.

/ser Shows the serial number of the disk.



134 Managing partitions using GDisk
Performing multiple GDisk operations using batch mode
Performing multiple GDisk operations using batch 
mode

Use the batch mode switch, /batch, to perform multiple GDisk operations with a 
single command. Using the /batch switch lets you avoid loading GDisk from the 
boot disk each time. Batch commands can either be supplied interactively at a 
prompt or in a pre-prepared text file.

If the name of a text file is supplied along with the batch mode switch, GDisk 
opens the file and executes the commands within it until all commands have been 
executed or one of the commands encounters an error.

Note: To use the Windows version of GDisk in the example commands, replace 
gdisk with gdisk32.

For example:

C:\> gdisk /batch:cmds.txt

If the batch mode switch is supplied without a file name, GDisk prompts for the 
commands to execute.

Command-line arguments that apply to all of the batch commands can be 
specified on the original command line along with the batch mode switch. The 
lines found in the batch file (or typed at the prompt) are appended to the already 
partially formed command line.

Following is a sample batch command file called Two-new.txt. Blank lines and 
lines starting with the number (hash) symbol are considered comments. These 
lines are ignored. (In this example, the commands do not specify the fixed disk on 
which to operate.)

# delete all partitions
/del /all
# create formatted FAT16 primary DOS partition and then create an extended
# partition
/cre /pri /-32 /for /q
/cre /ext
# create formatted FAT16 logical DOS partition
/cre /log /-32 /for /q

The following command deletes all partitions and creates two new ones on the 
second fixed disk with confirmation prompting turned off:

gdisk 2 /y /batch:two-new.txt 
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The four commands to be executed are a combination of the original command 
plus the commands from the batch file:

gdisk 2 /y /del /all
gdisk 2 /y /cre /pri /-32 /for /q
gdisk 2 /y /cre /ext
gdisk 2 /y /cre /log /-32 /for /q

Batch files may be nested recursively. For example, a second file called Std_init.txt 
contains the following lines:

1 /batch:two-new.txt
2 /batch:two-new.txt 

As a result, the following command performs the actions of Two-new.txt on both 
fixed disks:

gdisk /batch:std-init.txt

FAT16 partitions in Windows NT
FAT16 partitions can be up to 4 GB in size using 64 K clusters in Windows NT. 
GDisk can create a FAT16 partition using 64 K clusters when the 
/ntfat16 switch is added to the create partition command line. This switch 
disables the creation of FAT32 partitions and allows the creation of FAT16 
partitions up to 4 GB. 

Note: DOS and Windows 9x do not support FAT16 partitions using 64 K clusters 
and are limited to 2 GB FAT16 partitions.

Deleting and wiping your disk
GDisk lets you delete data and partitions on your disk or wipe your entire disk. 
You cannot delete a dynamic disk partition with the /del switch.

The switch /del /all deletes all partitions that are on the disk. Any other space that 
has not been used for creating a partition is not deleted. Deleting an extended 
partition also deletes any logical partition within it.

The /diskwipe switch wipes the entire disk, partitions, partition table, MBR, and 
all used and unused space.

These switches function with GDisk only.
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The syntax for the delete switch is as follows:

GDisk: gdisk disk /del {/pri[:nth]|/ext[:nth]|/log:nth|/p:partn-no|/all} 
[/qwipe|/dodwipe|/customwipe:n]

The syntax for the diskwipe switch is as follows:

GDisk: gdisk disk /diskwipe [dodwipe| /customwipe:n]

For example:

■ gdisk 1 /del /all /qwipe completes one pass to delete all partitions and data on 
disk 1.

■ gdisk 1 /del /p:2 /qwipe wipes partition 2 on disk 1 with one pass.

■ gdisk 1 /diskwipe /customwipe:15 wipes the entire disk with 15 passes.

Table 10-6 /diskwipe switches

Switch Explanation

disk Represents the physical fixed disk, from1 to 8.

/del Deletes a DOS partition or logical DOS drive.

/pri[:nth] Deletes the nth primary DOS partition. The default is 1.

/ext[:nth] Deletes the nth extended DOS partition. The default is 1. Also deletes 
any logical partitions in the extended partition.

/log:nth Deletes the nth logical DOS drive from the extended DOS partition.

/p:partn-no Indicates the partition to delete. Use the number reported by GDisk in 
standard display mode (not using /lba or /raw) for partn-no.

/all Deletes all partitions.

/qwipe Overwrites the partition’s data area before deleting the partition. Makes 
one pass of deleting the data on the disk.

/dodwipe Overwrites the partition’s data area before deleting the partition. Makes 
seven passes of deleting the data on the disk. This is the security 
standard for the U.S. Department of Defense.

/customwipe:n Overwrites the partition’s data area n times before deleting the 
partition. n can be set from 1 to 100. /customwipe:7 is equivalent to 
/dodwipe.
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Activating or deactivating a partition
A computer starts in an active partition. Using the /act or /-act switches, you can 
choose the partition to which the computer starts.

Depending on the version of GDisk that you require, the syntax for this 
command is one of the following:

■ GDisk: gdisk disk /[-]act /p:partn-no

■ GDisk32: gdisk32 disk /[-]act /p:partn-no

Hiding or unhiding a partition
You can hide a partition so that a user cannot see it.

Depending on the version of GDisk that you require, the syntax for this 
command is one of the following:

■ GDisk: gdisk disk /[-]hide /p:partn-no

■ GDisk32: gdisk32 disk /[-]hide /p:partn-no

Table 10-7 /act switches

Switch Explanation

disk Represents the physical fixed disk, from 1 to 8.

/act Activates a partition.

/-act Deactivates a partition.

/p:partn-no Indicates the partition to activate or deactivate. Only primary 
partitions can be activated. Use the number reported by GDisk in 
standard display mode (not using /lba or /raw) for partn-no.

Table 10-8 /hide switches

Switch Explanation

disk Represents the physical fixed disk, from 1 to 8.

/hide Hides a partition.

/-hide Unhides a partition.

/p:partn-no Indicates the partition to hide or unhide. Use the number reported by 
GDisk in standard display mode (not using /lba or /raw) for partn-no.
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Modifying the Windows NT/2000/XP boot menu
The /bootini switch lets you make a modification to a Windows NT/2000/XP 
boot menu. The following modifications are supported:

■ Displaying a list of current boot entries

■ Adding an entry to Boot.ini

■ Removing an entry from Boot.ini

■ Setting the default boot option and timeout

This switch functions with GDisk32 only. 

When GDisk32 changes the state of Boot.ini, a copy of the current Boot.ini is 
created. The copy is named either C:\boot_gdisk32_copy.ini or 
C:\boot.ini_gdisk32_copy.

Specifying the boot.ini path and file name
The /inifile switch is common to all operations performed with the /bootini 
switch. 

/inifile lets you specify the full path and file name of the current Windows NT/
2000/XP Boot.ini file. This lets you locate Boot.ini if it is not on the C drive. 

The default value for this switch is C:\boot.ini.

Displaying the list of current boot entries
Use the /bootini switch to display the existing boot menu for the current 
Windows NT/2000/XP operating system.

The syntax for this command is as follows:

gdisk32 /bootini [/inifile:filename]

Adding an entry to Boot.ini
There are two types of functions that you can add to a Boot.ini file:

■ Start another installation of Windows NT/2000/XP that resides on a different 
partition.

■ Start a non-Windows NT/2000/XP operating system that resides on a 
different partition.
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GDisk does not add an entry to Boot.ini in the following cases:

■ An entry with the description already exists in Boot.ini (case insensitive).

■ The referenced partition is of type Extended.

■ The referenced partition is hidden.

The following table describes the function of each switch for both types of entries.

Adding an entry for starting Windows NT/2000/XP
The syntax for this command is as follows:

gdisk32 /bootini /add /d:disknumber/p:partno /desc:description /winnt 
[/sysfolder:folder] [/inifile:filename] [/r]

This entry uses the Advanced RISC Computing (ARC) style path to describe the 
relative disk location for the entry. The entry has the following format:

<ARC style path>\<system folder>=“description”

For example:

multi(0)disk(0)rdisk(0)partition(1)\winnt=“Boot NT System”

Table 10-9 Boot.ini switches

Switch Explanation

/bootini Modifies Boot.ini.

/add Creates a new entry in Boot.ini.

/d:diskno Represents the physical fixed disk, from 1 to 8.

/p:partno Indicates the partition from which to boot.

/desc:description Specifies the description to appear in the NT boot loader menu.

/inifile:filename Specifies the full path and file name for Boot.ini. The default 
value is C:\boot.ini.

/bsectfile:filename Specifies the boot sector file to create. For example, C:\bsect.dat.

/winnt Adds an entry to start a Windows NT/2000/XP operating system.

/sysfolder:folder Specifies the system folder on the Windows NT/2000/XP 
operating system from which to start. The default value is Winnt.

/r Restarts after the execution of the command.
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For more information, see the Microsoft Knowledge Base article Q102873 - 
“BOOT.INI and ARC Path Naming Conventions and Usage.”

Note the following:

■ GDisk uses only MULTI(X) syntax when describing ARC style paths, as 
opposed to SCSI(X).

■ GDisk always uses multi(0)disk(0) as the beginning of the ARC style path.

■ /winnt instructs GDisk32 to create an ARC style entry and must be used if 
the target operating system is Windows NT/2000/XP. If this switch is not 
used, then GDisk32 creates an entry as if the target operating system is not 
Windows NT/2000/XP.

■ /sysfolder lets you specify the Windows system folder on the target operating 
system. The system folder is usually Winnt. If the system folder is not Winnt, 
then provide the path to this folder, but do not include the root directory.

For example, use /sysfolder:"2k\WinNt", not /sysfolder:"f:\2k\WinNt".

Adding an entry for starting a non-Windows NT/2000/XP 
operating system
The syntax for this command is as follows:

gdisk32 /bootini /add /d:diskno/p:partno /desc:description [/inifile:filename] 
[/bsectfile:filename] [/r]

This entry to Boot.ini references a boot sector file used to continue the boot up 
process.

The entry has the following format:

<full path to boot sector file>\<boot sector file>="description"

For example:

C:\bootos2s.dat="Boot OS/2 System"

When adding this entry, GDisk does the following:

■ Reads the first sector of the targeted partition (boot sector).

■ Writes out the contents of that sector to a boot sector file.

■ Adds a reference to that boot sector file to Boot.ini.

The /bsectfile switch is optional. It is used if you want the created bootsect.dat file 
to be saved somewhere other than the default location.

You must specify the full path and file name for the boot sector file that is created 
when you use the /bsectfile switch.
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GDisk32 does the following by default:

■ Builds the file name from the entry descriptions, omitting any invalid 
characters under DOS rules for 8.3 file name format.

■ Creates the boot sector file in the root directory of the C drive and gives it a 
.dat file extension.

For example: 

gdisk32 /add /d:1 /p:2 /desc:“*** Boot OS/2 ***” 

This produces a boot sector file C:\bootos2.dat.

Removing an entry from Boot.ini
The syntax to remove an entry from Boot.ini is as follows:

gdisk32 /bootini /remove /entry:nunber [/inifile:filename] [/r]

If the entry to be removed is the default boot option, then GDisk removes the 
entry and sets the first entry in the remaining list as the default boot entry.

GDisk does not remove the entry if it is the only entry in Boot.ini.

Setting the default boot option and timeout
Use the /default switch to set the default boot option and timeout.

The syntax for this command is as follows:

gdisk32 /bootini /default [/entry:nunber] [/timeout:sec] [/inifile:filename] [/r]

Table 10-10 /remove switches

Switch Explanation

/remove Removes the entry from Boot.ini.

/entry:nunber Removes the ID of the entry from Boot.ini.

Table 10-11 Default boot option and timeout switches

Switch Explanation

/default Sets the default boot option and timeout.

/entry:number Sets the ID of entry as the default boot option.

/timeout:sec Sets the number of seconds before the default boot option is selected.
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Support for Large Hard Disks
GDisk includes large disk drive support for IDE and SCSI hard drives (disks that 
exceed the 1024 cylinder BIOS limitation, which translates to a capacity greater 
than 7.8 GB). GDisk can directly access hard disks through the IDE controller or 
ASPI interface provided by an ASPI driver. Take care when creating partitions for 
operating systems with inherent partition size limitations.

Remember the following information when you create partitions for use in 
Windows 95/98:

■ On a system with a PC BIOS that does not support interrupt 13h extended 
disk services, ensure that the partitions created can be used as intended. 
When a primary partition or extended partition starts or ends past the 7.8 
GB limit of the hard drive, it is not accessible on such systems in Windows or 
in DOS-only mode. This affects all logical partitions contained within an 
extended partition that starts or ends past the limit.

Remember the following information when you create partitions for use in 
Windows NT:

■ According to the Microsoft Knowledge Base, Windows NT NTFS bootable 
partitions cannot exceed 7.8 GB (8,455,716,864 bytes). This information is 
detailed in the Microsoft Knowledge Base Article “Windows NT Boot Process 
and Hard Disk Constraints,” Article ID: Q114841.

Non-bootable NTFS partitions do not have this size limitation.

■ Windows NT cannot start from partitions that start or end beyond the 1024-
cylinder boundary. If this condition exists, Windows NT reports a “Boot 
Record Signature AA55 Not Found” error message.

Windows NT does not support drives larger than 7.8 GB unless you install 
Service Pack 4 or apply the ATAPI hot fix to Service Pack 3. This information is 
included in the Microsoft Knowledge Base Article “IBM DTTA-351010 10.1 GB 
Drive Capacity Is Inaccurate,” Article ID: Q183654.
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This chapter includes the following topics:

■ Making SID changes with Ghost Walker on Windows NT-based clients

■ Loss of access to external data objects

■ Identical user names and passwords across workstations

■ Using Ghost Walker



144 Updating Security Identifiers (SIDs) and computer names
Making SID changes with Ghost Walker on Windows NT-based clients
Making SID changes with Ghost Walker on Windows 
NT-based clients

Client computers must be uniquely identified to operate on a network. This is 
achieved using the Security Identifier (SID) and computer name. When you 
restore an image onto a number of client computers, you must assign unique 
identifiers as part of the task. You can use the Ghost Walker utility to do this.

Norton Ghost Walker capabilities
■ Runs in native DOS, allowing the SID to be changed without an additional 

restart following a clone operation.

■ Alters the computer SID to a unique and randomly generated value.

■ Alters the SIDs of all local workstation users present on the operating system 
installation.

■ Alters all local workstation user SIDs in Access Control Lists (ACLs) for file 
and registry objects so that local users retain user profiles and access rights.

■ Alters computer names for Windows 95, 98, Me, NT, XP, and 2000 operating 
systems.

Norton Ghost Walker limitations
■ Computer name change functionality is limited. The new name must contain 

the same number of characters as the original.

■ Not officially endorsed by Microsoft.
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SID changing limitations
SID changing is an approximate technology, as you can only change SIDs in 
known locations.

Problems arise because of the following factors:

■ A growing number of third-party and Microsoft applications are taking their 
own private or derived copies of the computer name and SID and storing 
them in proprietary formats in registry and file locations.

■ Microsoft technologies such as Windows 2000/XP NTFS File Encryption, 
Windows NT, and Windows 2000/XP Protected Storage make use of SIDs as 
unique tokens. They use local workstation user SIDs as part of the 
encryption key that controls access to encrypted information. Microsoft does 
not address changing local workstation user SIDs.

For these reasons, you are strongly advised to test computer environments and 
the applications on them before mass rollouts or upgrades.

Loss of access to external data objects
Changing the SID of a workstation or a clone of a workstation that has been in 
use for some time may be more problematic than changing the SID of a newly 
installed workstation or a clone of a newly installed workstation. When a 
workstation user, as opposed to a domain user, creates data objects on computers 
that are accessed by a peer-to-peer connection, security information is created for 
those data objects that is based on the user's SID (which is based on the 
workstation SID).

When Ghost Walker updates the SID, it not only changes the computer SID, but 
also all of the workstation user and group SIDs. This is done because user and 
group SIDs are assumed to be based on the workstation's computer SID (which is 
now updated). This may mean that the security information on external 
computers no longer matches the new SIDs of the workstation users, which may 
result in a loss of access to those data objects.

Identical user names and passwords across 
workstations

If there are two workstations in a domain that have two users with the same user 
name and password, the domain gives each of them access to the other’s 
resources even if their SIDs are different. This is a fairly common situation 
following cloning.
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It appears that the accessing user is given the rights that the accessed user has by 
proxy. For example, the access is performed on behalf of the accessing user by the 
accessed user, just because there is a user name/password match. This can best be 
seen when specific access rights are granted remotely by the accessing user to a 
resource on the accessed computer. The Access Control List shows that the 
accessed user is the user who has rights to the resource.

Updating the SID on a workstation does not stop this situation from occurring. 
You must change the password of one of the users.

Using Ghost Walker
Ghost Walker lets you alter identification details of Windows 95, Windows 98, 
Windows Me, Windows NT, and Windows 2000/XP computers following a clone 
operation. Each Windows 95, 98, or Me computer can be assigned a unique 
name. Each Windows NT or 2000/XP computer can be assigned a unique 
computer name and a Machine Security Identifier (SID).

When you update the SID using Ghost Walker, all existing workstation users and 
their passwords, permissions, and registry settings are maintained.

Ghost Walker can be operated from the graphical user interface or from the 
command line. Ghost Walker does not run from:

■ A Windows NT or 2000 DOS shell

■ A Windows 95, 98, or Me DOS shell

The Ghost Walker window lists all bootable Windows 95, 98, Me, NT, XP, and 
2000 systems on the computer hard drives. Ghost Walker determines that there is 
an installed operating system if a full set of registry hive files and the operating 
system kernel executable are located in their normal locations.

Ghost Walker lists the following operating system details:

■ Logical ID (system ID generated by Ghost Walker)

■ Drive number

■ Partition number

■ Volume label (partition name)

■ Partition file system type

■ Computer name

■ Operating system type, version, or build
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To alter identification details for a client computer using Ghost Walker

1 Remove any Windows NT/2000/XP workstations that are members of a 
server domain.

You must add the workstation to the Domain using the new SID and 
Computer Name once you have completed the update.

2 Run DOS. 

3 At the command line, type Ghstwalk.exe.

4 Press Enter.

Ghost Walker lists all interpretable volumes on the computer.

■ If there is one operating system on the computer, details of this 
operating system appear in the top pane and all volumes appear in the 
bottom pane.

■ If there is more than one operating system on the computer, details of all 
existing operating systems appear in the top pane.

5 If there is more than one operating system on the computer, in the Select a 
System ID field, type an ID for the operating system to appear and click V -
Change Additional Vols to add or remove non-bootable volumes to be 
updated.

You must include any additional non-bootable volumes that may have 
security information or shortcuts containing the computer name of the 
bootable operating system embedded in them. Failure to do so results in 
mismatched data and a loss of security access.

6 To change the computer name, type N, and then press Enter.

The new name must be the same length as the previous name. The field you 
type the name into is the correct length of the name. 

The name cannot contain any of the following characters: 

/\[]”:;|<>+=,?*

7 Press Enter to update. 

This lists the new name and, for Windows NT and 2000 computers, a new 
SID.

The computer name and SID updates occur in the following locations:

■ The registry of the selected operating system

■ The file system on which the operating system resides

■ Any additional volumes selected for the update

8 If you removed a Windows NT or 2000 computer from a server domain, add 
the computer back to the domain.
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Running Ghost Walker from the command line
You can run Ghost Walker from the command line in DOS.

The command-line syntax is as follows:

GHSTWALK[/CN=
<new_computer_name>|”<random_computer_name_format>”]
[/BV=<drv>:<part>[/AV=ALL|/AV=<drv>:<part> ... ]]
[/SURE][/DIAG][/IGNORE_DOMAIN][/IGNORE_ENCRYPTFILES]
[/REBOOT][/REPORT[=<report filename>]][/#E=<license file>]
[SID=<replacement SID][/FNI][/FNS][/FNX]
[/MNUPD=<registry path>][@<argumentfile>]
[LOGGING][SAFE_LOGGING][/H|/HELP|/?]

Table 11-1 describes the command-line options.

Table 11-1 Command-line options

Switch Description

/CN=

<new_computer_
name>

Specifies a new computer name.

The new name must be the same length as the original name and 
cannot contain any of the following characters: 
/\[]”:;|<>+=,?* 
To include spaces in the computer name, enclose the computer 
name in quotes. For example, /CN="EW PC 123"
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/CN=

"<random_computer_
name_format>"

Replaces the original computer name with a randomly generated 
name using the <random_computer_name_format> template. 
The <random_computer_name_format> template specifies 
which sections of the new name will be randomly generated and 
the type of random value to place in that location.

Only one instance of the following keywords is permitted in a 
template:

<RANDOM_NUMERIC> - Generate random numbers
<RANDOM_ALPHA>- Generate random letters
<RANDOM_HEX> - Generate random hex digits (0-9, A-F)

Examples: 

/CN=”PC<RANDOM_NUMERIC>” replaces the computer name 
with a name that starts with PC, followed by a series of random 
digits between 0 and 9.

/CN=”ID<RANDOM_ALPHA>X” replaces the computer name 
with a name that starts with ID, followed by a series of random 
letters, ending with the character X.

/CN=”<RANDOM_ALPHA>” replaces the computer name with 
a name that is randomly generated using letters.

The random output fills out the format string to produce a new 
computer name of the same length as the original name. Ensure 
that the format string allows enough room to embed at least one 
random character without exceeding the length of the original 
name.

/BV=<drv:part> Specifies the drive number and partition number of the bootable 
operating system installation to update.

If there is more than one operating system, then this switch must 
be included in the command.

/AV=<drv:part> Specifies the drive number and partition number of an 
additional volume containing a file system to update.

■ More than one volume may be specified by repeating the 
argument for each additional volume.

■ This switch cannot be combined with /AV=ALL.

Table 11-1 Command-line options

Switch Description
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/AV=ALL Specifies that all other volumes are to be included as additional 
volumes.

/AV=ALL cannot be combined with the /AV=<drv>:<part> 
switch.

/SURE Specifies that the update should start without user confirmation.

/DIAG Specifies that the utility can only generate diagnostic dumps and 
log files (not update the computer name or SID).

/IGNORE
_DOMAIN

Specifies that Ghost Walker should not check Windows NT or 
2000 installations for domain membership.

/REBOOT Restarts the computer after a successful update.

/REPORT
[=<filespec>]

Generates a report containing details of the update to 
\UPDATE.RPT. An alternate report file can be specified.

/LOGGING Specifies that diagnostic logging is generated to the Gwalklog.txt 
file. Recommended for Technical Support use only.

/SAFE_
LOGGING

Ensures that all diagnostic logging gets flushed to disk by closing 
and reopening the Gwalklog.txt file after every log statement. 
This results in very slow execution. Recommended for Technical 
Support use only.

/#E=<license file> Specifies a Ghost license file to activate Ghost Walker.

/H|/HELP|/? Shows command-line syntax Help.

/SID=
<replacement SID>

Specifies a replacement SID to be used instead of a randomly 
generated one. The replacement SID must be in the format S-1-
5-21-xxx-xxx-xxx and have the same number of characters as the 
original SID.

/IGNORE_
ENCRYPTFILES

Disables the warning generated by Ghost Walker when it 
encounters Windows 2000/XP NTFS encrypted files during its 
initial disk scan.

Changing the SID of a Windows 2000 installation results in 
indecipherable NTFS encrypted files. 

Table 11-1 Command-line options

Switch Description
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Following is an example of command line use:

GHSTWALK /BV=1:2 /AV=1:1 /AV=2:1 /CN=”WS4-<RANDOM_HEX>-443”/SURE

The above command line does the following:

■ Updates the Windows 95, 98, Me, NT, XP, or 2000 installation located on the 
second partition of the first disk.

■ Updates file systems on additional volumes on the first partition of the first 
and second disks.

■ Changes the computer name to one starting with WS4- and ending with -
443, placing random hexadecimal values in the remaining spaces until the 
new name is the same length as the old one. For example, WS4-53ADF76-
443.

■ Does not prompt the user for final confirmation.

/MNUPD=
<registry path>

Specifies a registry location that you want Ghost Walker to search 
for instances of the computer name to update them. This registry 
key and its subkeys are searched for wholly matched instances of 
the computer name (of the same length). If any are found, they 
are updated to the new computer name. 

Multiple registry locations may be specified with multiple 
instances of this switch. 

@<argumentfile> Specifies a file containing command-line switches that Ghost 
Walker should open and read in addition to those specified in the 
command line.

/FNI Disables the direct IDE drive access method.

/FNS Disables the direct SCSI drive access method.

/FNX Disables the Extended Int0x13 drive access method.

Table 11-1 Command-line options

Switch Description
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This chapter includes the following topics:

■ Using Norton Ghost with switches

■ Command-line switches

■ Clone switch usage

■ -CRC32 switch usage

■ Ghost.exe and the Virtual Partition
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Using Norton Ghost with switches
Norton Ghost can be run in the following ways:

■ Interactively with no command-line switches

■ Interactively with selected switches 

■ Automated in batch files (batch mode)

The Norton Ghost command-line switches are used to alter Norton Ghost 
behavior and automate procedures. 

If you are adding switches from the Advanced Options dialog box, some of these 
switches, for example, the -clone switch, are not applicable to your task. Because 
you are already performing a backup, restore, or clone operation, the -clone 
switch is redundant.

To list Norton Ghost command-line switches

◆ In the Ghost directory, type one of the following:

■ ghost.exe -h

■ ghost.exe -?

A hyphen (-) or a slash (/) must precede all switches except @. Switches are not 
case sensitive. They can be entered in upper, lower, or mixed case.

Command-line switches

@filename Specifies a file that contains additional command-line switches that Norton Ghost should 
read. Filename indicates the path and file name of the command-line switch file. The 
command-line switch file can include any Norton Ghost command-line switch, except for 
-afile and -dfile. The Norton Ghost command-line switch file must be a text file with each 
switch on a separate line. This feature lets you exceed the DOS command-line limit of 150 
characters.

For example, for the following command line:

ghost.exe @ghswitch.txt

The file Ghswitch.txt would read:

-clone,mode=pcreate,src=1:2,dst=g:\part2.gho
-fcr
-sure
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-afile=filename Replaces the default abort error log file name, Ghosterr.txt, with the directory and file 
given in filename.

-auto Automatically names spanned image files during creation. Using this switch avoids the 
user prompt that asks for confirmation of the next destination location for the remainder 
of the image file that is being loaded. This switch is the default behavior for Norton Ghost.

-batch Batch mode switch. Prevents abort messages from waiting for user acknowledgment, and 
removes user interaction prompts. The return value of Ghost.exe must be checked to 
identify whether the operation was successful. Norton Ghost returns 0 on success and 1 or 
higher on failure or error.

-bfc Handles bad FAT clusters when writing to disk. If this switch is set, and the target 
partition is FAT, Norton Ghost checks for and works around bad sectors. This option may 
slow Norton Ghost operation substantially.

-bootcd When writing an image directly to a CD/DVD writer, makes the CD/DVD bootable. You 
need a bootable floppy disk in drive A. If you use the -sure switch with -bootcd, and a 
floppy disk is not in drive A, then a non-bootable CD/DVD is created.

-buffersize=x Ghost creates an image file using a small buffer where x = number of KB. The size of the 
buffer is automatically calculated by Norton Ghost. The buffersize switch lets you override 
this size. You can set the buffer size value from 1 to 32.

-chkimg,filename Checks the integrity of the image file indicated by filename.

-clone Ghost.exe operation switch. This switch allows automation of Ghost.exe operations and 
has a series of arguments that define the operation parameters. 

See “Clone switch usage” on page 166.

-cns Reverts the naming of spanned files to the system used by versions of Norton Ghost prior 
to Symantec Ghost 6.5. If this switch is not used, then the naming of spanned files 
conforms to Microsoft application guidelines. You do not need to use this switch when 
reading an existing file. Use this switch when the first five characters in a file name must be 
unique. For example: 

With -cns Without -cns

Filename.gho Filename.gho

Filename.001 Filen001.ghs

Filename.002 Filen002.ghs
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The default settings are as follows:

-CRC32 The -CRC32 switch lets you make a list of the files on a disk or partition or create an 
image file with CRC values and then verify the list against the original or a copy. The 
purpose is to allow both quick listing of the contents of an image file and verification that 
a disk created by Norton Ghost contains the same files as the original.

See “-CRC32 switch usage” on page 172.

-crcignore Ignores CRC errors. CRC errors indicate data corruption. This switch overrides the CRC 
error detection and may let a corrupted image file be used. Using this switch leaves the 
corrupted files in an unknown state. You can use this switch to help you extract files from 
a corrupted image file.

-cvtarea Creates a file, Cvtarea.tmp, that is the location of the MFT when the FAT32 partition is 
converted to NTFS. This switch operates in a similar manner to the cvtarea program that 
Microsoft provides in Deploy.cab on the Windows XP installation CD. 

For more information, see the Microsoft Web site:

http://www.microsoft.com/hwdev/tech/storage/ntfs-preinstall.asp

The file is created in the root directory of the partition during a partition or disk restore 
and is created as a contiguous space on the disk. The largest size allowed is 4 GB. If the file 
is larger than this, it is truncated to 4 GB.

The syntax for this switch is as follows:

-cvtarea,filename=xxx,size=yyy{%disk,%free,KB,MB,GB},
firstcluster=zzz{%disk,%free,KB,MB,GB}

filename cvtarea.tmp

size 12%disk

firstcluster 1|3 GB|33%disk

Defaults to: 

■ 1/3 of the partition size if the partition size is less than 2 GB

■ 1 GB if the partition size is less than 6 GB

■ 3 GB if the partition size is equal to or greater than 6 GB

-dd Dumps disk metrics information to the dump log file, Ghststat.txt. The file location can be 
altered using the -dfile=filename switch.

-dfile=filename Changes the path and file name of the dump log file created using the -dd switch. This 
switch cannot be included in the @ Ghost switch text file
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-dl=number Specifies the number of hard disks present. Valid numbers are between 1 and 8. This may 
help when the BIOS does not report the number of drives correctly.

-dlist=drives Specifies a list of drives to search for span files. If a span file cannot be found, then the 
drive letters in dlist are substituted one by one to look for the file on other drives.

For example, the command ghost -dlist=CDEFG instructs Norton Ghost to look for files 
on C, D, E, F, and G drives. The path remains the same. 

-f32 Lets Norton Ghost convert all FAT16 volumes to FAT32 volumes when the destination 
partition to convert is larger than 256 MB in size. Ensure that the installed operating 
systems can access the volumes that will be converted to support FAT32.

-f64 Lets Norton Ghost resize FAT16 partitions to be larger than 2047 MB using 64 K clusters. 
This is only supported by Windows NT and Windows 2000. Do not use on computers 
with other operating systems

-fatlimit Limits the size of FAT16 partitions to 2047 MB. Useful when Windows NT FAT16 
partitions are present on the disk and 64 K clusters are not wanted

-fcr Creates a CRC32 file, Ghost.crc, while creating an image file.

See “-CRC32 switch usage” on page 172.

-fdsp Preserves the signature bytes on the destination disk when performing a disk-to-disk or 
image-to-disk cloning operation

-fdsz Clears the signature bytes on the destination disk when performing a disk-to-disk or 
image-to-disk cloning operation.

-femax When an extended partition is created in a disk-to-disk or image-to-disk operation, the 
femax switch ensures that the extended partition takes up all free space.

-ffatid Forces the FAT partition id. This switch changes the partition id to the recommended 
partition id for the FAT partition within the destination image file or the destination 
partition table. This switch only takes effect if the source is a disk or partition, not an 
image file.

For example, if you are cloning a partition of type 0xA0 (some unknown partition id), and 
Norton Ghost sees it as a valid FATx (FAT12/FAT16/FAT32) partition, then the partition id 
is changed from 0xA0 to FATx.

This was default Norton Ghost behavior before Symantec Ghost 7.5. This switch allows 
for backward compatibility.

-ffi Prefers the use of direct IDE access for IDE hard disk operations. This switch does not 
have any effect when running Norton Ghost in Windows 98.

-ffs Prefers the use of direct ASPI/SCSI disk access for SCSI hard disk operations.

-ffx Prefers the use of Extended Interrupt 13h disk access for hard disk operations.
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-finger Shows the fingerprint details written on a hard disk created by Norton Ghost. The 
fingerprint details include the process used to create the disk or partition and the time, 
date, and disk on which the operation was performed.

-fis Uses all available disk space when creating partitions. By default, Norton Ghost often 
leaves a small amount of free space at the end of the disk. Because partitions must be 
aligned to cylinder boundaries, Norton Ghost may leave up to 5 MB free even when -fis is 
specified.

-fni Disables direct IDE access support for IDE hard disk operations.

This switch has the same functionality as the -noide switch.

-fns Disables direct ASPI/SCSI access support for SCSI hard disk operations.

This switch has the same functionality as the -noscsi switch.

-fnx Disables extended INT13 support for hard disk operations.

-fro Forces Norton Ghost to continue cloning even if the source contains bad clusters.

-fx Causes Norton Ghost to exit to DOS after operation completion. By default, Norton Ghost 
prompts the user to restart or exit when the operation has finished. If Norton Ghost is run 
as part of a batch file, it is sometimes useful to exit back to the DOS prompt after 
completion so that further batch commands can be processed. 

See “-rb” on page 162.

-ghostoncd Includes Ghost.exe on a CD/DVD when writing an image to a CD/DVD.

-h or -? or -help Shows the Norton Ghost command-line switch Help page.

-ia The image all switch forces Norton Ghost to perform a sector-by-sector copy of all 
partitions. When copying a partition from a disk to an image file or to another disk, 
Norton Ghost examines the source partition and decides whether to copy just the files and 
directory structure, or to do a sector-by-sector copy. If it understands the internal format 
of the partition, it defaults to copying the files and directory structure. Generally this is the 
best option. However, if a disk has been set up with special hidden security files that are in 
specific positions on the partition, the only way to reproduce them accurately on the 
target partition is through a sector-by-sector copy. If you use this switch to create an 
image of a dynamic disk, then the image must be restored to a disk with identical 
geometry.

-ial Forces a sector-by-sector copy of Linux partitions. Other partitions are copied as normal.

-ib The image boot switch copies the entire boot track, including the boot sector, when 
creating a disk image file or copying disk-to-disk. Use this switch when installed 
applications, such as boot-time utilities, use the boot track to store information. By 
default, Norton Ghost copies only the boot sector, and does not copy the remainder of the 
boot track. You cannot perform partition-to-partition or partition-to-image functions 
with the -ib switch.
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-id The image disk switch is similar to -ia (image all), but also copies the boot track, as in -ib 
(image boot), extended partition tables, and unpartitioned space on the disk. When 
looking at an image with -id, you see the unpartitioned space and extended partitions in 
the list of partitions. The -id switch is primarily used by law enforcement agencies that 
require forensic images.

When Norton Ghost restores from an -id image, it relocates partitions to cylinder 
boundaries and adjusts partition tables accordingly. Head, sector, and cylinder 
information in partition tables is adjusted to match the geometry of the destination disk. 
Partitions are not resizeable. You will need an identical or larger disk than the original.

Norton Ghost does not wipe the destination disk when restoring from an -id image. 
Geometry differences between disks may leave tracks on the destination disk with their 
previous contents.

Use the -ia (image all) switch instead of the -id switch when copying partition-to-partition 
or partition-to-image. An individual partition can be restored from an image created with 
-id.

-imgdesc Adds a single-line image file description to the image file. This has the following 
restrictions:

■ Cannot include any new lines

■ Cannot be used with -imgdescfile

■ Must be used with the clone switch

■ Clone switch mode must be create, dump, prcreate, or pdump

-imgdescfile Specifies a text file that contains an image file description to be added to the image file. 
This has the following restrictions:

■ Cannot be used with -imgdesc

■ Must be used with the clone switch

■ Clone switch mode must be create, dump, prcreate, or pdump

-ir The image raw switch copies the entire disk, ignoring the partition table. This is useful 
when a disk does not contain a partition table in the standard PC format, or you do not 
want partitions to be realigned to track boundaries on the destination disk. Some 
operating systems may not be able to access unaligned partitions. Partitions cannot be 
resized during restore and you need an identical or larger disk.

-jl:x=filename Creates a log file to assist in diagnosing problems with TCP/IP connections. The amount 
of information logged is set by the log level, x. The log level x can be E (errors), S 
(statistics), W (warnings), I (information), or A (all), in increasing order of logging detail. 
The file name indicates the path and file name of the log to be created. In general, the error 
and statistic levels do not affect session performance. All other levels may reduce 
performance and should be used for diagnostic purposes only.

-lockinfo Shows the type code and information stored in the BIOS or the Pentium III Processor ID.

For example:
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Type Based On Value

M Manufacturer Compaq

P Product name Deskpro EN Series SFF

V Version Award Software

S Serial number H925CKH60020

U UUID 2DA9379B4707D31185E8C800A4F232BC

C M&P combined Compaq Deskpro EN Series SFF

I PIII ID 0000067200028E72A6994A20

-locktype= Type Lets you lock an image file for use with a specific set of computers defined by the type 
chosen and the source computer.

For example, ghost -locktype=P creates an image that can be used only on systems that 
have the same product name type as the source computer.

-lpm The LPT master mode switch causes Norton Ghost to automatically go into LPT master 
mode, and is the equivalent of selecting LPT Master from the main menu.

See “Peer-to-peer connections” on page 178.

-lps The LPT slave mode switch causes Norton Ghost to automatically go into LPT slave mode, 
and is the equivalent of selecting LPT Slave from the main menu. 

See “Peer-to-peer connections” on page 178.

-memcheck Activates internal memory usage checking for Technical Support.

-noauto Disables the automatic naming of spanned image files during creation. The user is 
prompted for confirmation of the next destination location for the remainder of the image 
file that is being restored.

-noautoskip Includes the hibernation and skip files in the image file. These files are excluded by 
default.See “Hibernation and swap files” on page 69.

-nofile Disables the Image File Selection dialog box. Useful when opening directories with large 
numbers of files and slow links.

-noide Disables access to IDE devices.

-noindex Prevents Norton Ghost from creating an index when creating an image file. This slightly 
reduces the size of the image file and saves memory but Ghost Explorer is much slower in 
reading the image file. This switch is useful if you are saving an image file from a large disk 
with very little memory.
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-nolilo Does not attempt to patch the LILO boot loader after a clone. If you use the -nolilo switch, 
you need to start from a floppy disk after the clone and then run /sbin/lilo as the root user 
to reinstall LILO.

-noscsi Disables access to SCSI devices using ASPI.

-ntc- Disables NTFS contiguous run allocation.

-ntchkdsk Sets the CHKDSK bit set on a copied NTFS volume. This causes Windows NT to check the 
integrity of the volume when it is started.

-ntd Enables NTFS internal diagnostic checking.

-ntic Ignores the NTFS volume CHKDSK bit. Norton Ghost checks the CHKDSK bit on an 
NTFS volume before performing operations. When Norton Ghost indicates that the 
CHDSK bit is set, you should run CHKDSK on the volume to ensure that the disk is in a 
sound state before cloning.

-ntiid By default, Norton Ghost copies partitions participating in an Windows NT volume set, 
stripe set, or mirror set using image all sector-by-sector copying. This switch forces Norton 
Ghost to ignore the Windows NT volume set partition status and image the partition as if 
it were an NTFS partition to let it be intelligently imaged on a file-by-file basis. Take care 
when using this switch. Do not use the -ntiid switch with volume sets and stripe sets. 

To clone mirrored partitions (also known as Windows NT software RAID partitions)

1 With Windows NT disk administrator, break the mirror set.

2 Using the -ntiid switch, clone one of the mirror partitions.

3 Resize as desired. Partitions can only be resized by Norton Ghost during a disk 

operation. When performing a partition operation, the target partition size must 

already be established. 

4 After cloning, recreate the mirror set using the Windows NT disk administrator. The 

disk administrator creates the partitions in the mirror set.

-ntil Ignores NTFS log file check (inconsistent volume).

-or The override switch allows the override of internal space and integrity checks and lets you 
put a very big image into a small partition. The operation fails if it is unable to write to the 
limited partition size. This switch lets you override spanning, which fails if there is limited 
space. Avoid using this switch. 

-pmbr Specifies that the master boot record of the destination disk is to be preserved when 
performing a disk-to-disk or image-to-disk cloning operation.

-pwd and -pwd=x Specifies that password protection be used when creating an image file.

x indicates the password for the image file. If no password is given in the switch, Norton 
Ghost prompts for one. You can enter a maximum of 10 alphanumeric characters.
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-quiet The quiet mode switch disables status updates and user intervention.

-rb Restarts after finishing a restore or copy. After completing a restore or copy operation, the 
target computer must be restarted so that the operating system can restore the new disk/
partition information. Normally, Norton Ghost prompts the user to restart or exit. -rb tells 
Norton Ghost to restart automatically after it completes the restore or copy. This is useful 
when automating Norton Ghost in a batch command file.

See “-fx” on page 158.

-script Allows you to specify a series of commands (one per line) that Norton Ghost will execute 
in sequential order.

For example:

ghost -script=script.txt

Following is an example of script.txt:

-clone,mode=create,src=2,dst=c:\drv2.gho
-chkimg,c:\drv2.gho
-clone,mode=create,src=2,dst=c:\part2.gho
-chkimg,c:\part2.gho
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-skip=x The skip file switch causes Norton Ghost to exclude the indicated files during a create or 
restore operation. A skip entry can specify a single file, a directory, or multiple files using 
the * wildcard. File names must be given in short file name format and all path names are 
absolute. Only FAT system files can be skipped. It is not possible to skip files on NTFS or 
other file systems. The skip switch may only be included in the command line once. To 
specify multiple skip entries, they must be included in a text file indicated using 
-skip=@skipfile. The format of the skip text file, skipfile, matches the format used with the 
CRC32 vexcept option.

For example:

■ -skip=\windows\user.dll
Skips the file User.dll in the Windows directory.

■ -skip=*\readme.txt
Skips any file called Readme.txt in any directory.

■ -skip=\ghost\*.dll 
Skips any file ending with .dll in the Ghost directory.

■ -skip=\progra~1\
Skips the program files directory (note the short file name).

■ -skip=@skipfile.txt
Skips files as outlined in Skipfile.txt. For example, if Skipfile.txt contains:
*\*.tmt
[partition:1]
\windows\
*\*.exe
[Partition:2]
*\*me.txt
This would skip all *.tmt files on any partition, the Windows directory, all *.exe files 
on the first partition, and any file that ends with me.txt on the second partition.

-span Enables spanning of image files across volumes.

Do not use this switch if you are running Ghost.exe to write an image file directly to a CD-
R/RW. Ghost.exe automatically spans CD-R/RW disks if required.

-split=x Splits image file into x MB spans. Use this switch to create a forced-size volume set. For 
example, if you want to force smaller image files from a 1024 MB drive, you could specify 
200 MB segments. 

For example: 

ghost.exe -split=200 

This divides the image into 200 MB segments.

-sure Use the -sure switch in conjunction with -clone to avoid being prompted with the final 
question “Proceed with disk clone - destination drive will be overwritten?” This command 
is useful in batch mode.
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-sze Sets the size for the destination partitions for either a disk restore or disk copy operation. 
When numbering partitions in the -sze switch, do not include the hidden Ghost partition.

See “Setting a destination size for the clone switch” on page 169.

-szee Forces Norton Ghost to keep the sizes of all destination partitions the same as in the source 
partition (no resizing).

This switch can be used with or without the -clone switch.

See “Setting a destination size for the clone switch” on page 169.

-szef Forces Norton Ghost to keep the sizes of all destination partitions, except for the first one, 
the same as in the source partition. The first partition uses the remaining disk space.

This switch can be used with or without the -clone switch.

See “Setting a destination size for the clone switch” on page 169.

-szel Forces Norton Ghost to keep the sizes of all destination partitions, except for the last one, 
the same as in the source partition. The last partition uses the remaining disk space.

This switch can be used with or without the -clone switch.

See “Setting a destination size for the clone switch” on page 169.

-tapebuffered Default tape mode. Sets the ASPI driver to report a read/write as successful as soon as the 
data has been transferred to memory. Useful when using older or unreliable tape devices or 
sequential media.

-tapeeject Forces Norton Ghost to eject the tape following a tape operation. If the tape drive does not 
support remote ejection you must eject and insert the tape manually before further use. 
Earlier versions ejected the tape by default. By default, Norton Ghost does not eject the 
tape. It rewinds the tape before exiting to DOS.

-tapesafe Sets the ASPI driver to report a read/write as successful only when the data has been 
transferred to the physical medium. Useful when using older or unreliable tape devices or 
sequential media.

-tapebsize=x Specifies the tape block size in units of 512 bytes, where x is 1 to 128.

-tapespeed=x Allows control of tape speed, where x is 0 to F. 0 is the default. 1 to F increase tape speed. 
Only use this when the tape does not work correctly at the speed used by Norton Ghost.

-tapeunbuffered Sets the ASPI driver to report a read/write as successful only when the data has been 
transferred to the tape drive. (It is possible that this occurs before the data is physically 
written to the medium.)

-tcpm[:slave IP address] The TCP/IP master mode switch causes Norton Ghost to go into TCP/IP master mode 
automatically, and is the equivalent of selecting TCP/IP Master from the main menu. The 
IP address of the slave computer may be specified. See “Peer-to-peer connections” on 
page 178.
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-tcps The TCP/IP slave mode switch causes Norton Ghost to go into TCP/IP slave mode 
automatically, and is the equivalent of selecting TCP/IP Slave from the main menu. 
See “Peer-to-peer connections” on page 178.

-usbm The USB master mode switch causes Norton Ghost to go into USB master mode 
automatically, and is the equivalent of selecting USB Master from the main menu. This 
switch should precede the -clone switch. For example,

ghost.exe -usbm -clone,mode=dump,src=1,dst=1:1\image.gho See “Peer-to-peer 
connections” on page 178.

-usbs The USB slave mode switch causes Norton Ghost to go into USB slave mode automatically, 
and is the equivalent of selecting USB Slave from the main menu. This switch should 
precede the -clone switch. See “Peer-to-peer connections” on page 178.

-vdw If this switch is set, Norton Ghost uses the disk’s verify command to check every sector on 
the disk before it is written. This option may slow Norton Ghost operation substantially.

-ver Shows the version number of Norton Ghost.

-z Runs compression when saving a disk or partition to an image file. The greater the 
compression, the slower the transmission.

■ -z or -z1: Low compression (fast transmission)

■ -z2: High compression (medium transmission)

■ -z3 through -z9: Higher compression (slower transmission)

See “Image files and compression” on page 62.
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Clone switch usage
The syntax for the clone switch is:

-clone,MODE={operation},SRC={source},DST={destination}, 
[SZE{size},SZE{size}.......]

Defining the type of clone command
MODE defines the type of clone command. The syntax is as follows:

MODE={copy | restore | create | pcopy | prestore | pcreate}

Table A-1 Mode commands

Switch Action

copy Disk-to-disk copy

restore

Note: The load switch has been replaced by the 
restore switch. The load switch is still fully 
functional and is interchangeable with restore.

File-to-disk restore 

create

Note: The dump switch has been replaced by 
the create switch. The dump switch is still fully 
functional and is interchangeable with create.

Disk-to-file backup

pcopy Partition-to-partition copy

prestore

Note: The pload switch has been replaced by 
the prestore switch. The pload switch is still fully 
functional and is interchangeable with prestore.

File-to-partition restore

pcreate

Note: The pdump switch has been replaced by 
the pcreate switch. The pdump switch is still 
fully functional and is interchangeable with 
pcreate.

Partition-to-file backup. This allows 
multipartition Ghost backup selection 
for file.
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Cloning combination options
Table A-2 illustrates the possible cloning operations that you can perform.

Setting a source for the clone switch
The syntax for this switch is as follows:

SRC={disk | file | tape |cd/dvdwriter }

Table A-2 Cloning operations

Mode Source Destination

copy ■ disk ■ disk

restore

Note: The load switch has been 
replaced by the restore switch. The 
load switch is still fully functional and 
is interchangeable with restore.

■ file

■ tape

■ CD-ROM

■ USB 1.1 and 2.0 
Mass Storage Device

■ DVD

■ disk

create

Note: The dump switch has been 
replaced by the create switch. The 
dump switch is still fully functional 
and is interchangeable with create.

■ disk ■ file

■ tape

■ CD writer

■ USB 1.1 and 2.0 
Mass Storage 
Device

■ DVD

pcopy ■ disk:partition ■ disk:partition

prestore

Note: The pload switch has been 
replaced by the prestore switch. The 
pload switch is still fully functional 
and is interchangeable with prestore.

■ file:partition

■ tape:partition

■ CD:image:partition

■ USB 1.1 and 2.0 
Mass Storage Device

■ disk:partition

pcreate

Note: The pdump switch has been 
replaced by the pcreate switch. The 
pdump switch is still fully functional 
and is interchangeable with pcreate.

■ disk:partition

■ partition:partition

You can specify more 
than one partition.

■ file

■ tape

■ CD writer

■ USB 1.1 and 2.0 
Mass Storage 
Device

■ DVD
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SRC defines the source for the operation selected by the clone mode option.

Table A-3 Source options for cloning

Switch Source Explanation

disk drive number Source disk drive number. Numbers start at 1. For example: 
SRC=1

A partition on a drive can also be specified. Numbers start at 
1. For example: 

SRC=1:2

file filename The source image file name. For example: 

SRC= g:\source.gho

A partition in an image file can also be specified. For 
example:

SRC=g:\source.gho:2

Files can also be read from a CD-ROM drive.

To specify a file located on a file system not recognized by 
DOS, such as, NTFS, use the same format as the disk switch, 
specifying both a disk and partition. For example:

src=1:2\image.gho

In this example, Image.gho resides on an NTFS file system on 
the second partition of the first disk.

tape @MTx The tape drive number. Numbers start at 0. For example:

SRC=@MT0

A partition on a tape can also be specified. For example:

SRC=@MT0:3

CD 
ROM

@CDx The CD or DVD drive number. If you have a CD reader and a 
CD writer, in the Ghost.exe user interface you would see 
@CD1 and @ CD2. The number is optional if you are 
specifying an operation from the command-line.

You can specify partitions for the image stored on a CD for a 
restore operation. For example: 

SRC=@CD1:2
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Setting a destination for the clone switch
The syntax for this switch is as follows:

DST={disk | file | tape | cd/dvdwriter}

DST defines the destination location for the operation. 

Setting a destination size for the clone switch
SZE sets the size of the destination partitions for either a disk restore or disk copy 
operation. This is optional. Multiple partition size switches are supported. 

Table A-4 Destination options for cloning

Switch Destination Explanation

disk drive The destination disk drive number, such as DST=2

A partition on a drive can also be specified. For example:

DST=2:1

To create a new partition, type a destination partition one 
greater than the existing number of partitions, if there is 
enough free space.

file filename The destination image file name. For example: 

DST= g:\destination.gho

To specify a file located on a file system not recognized by 
DOS, such as NTFS, use the same format as the disk switch, 
specifying both a disk and partition. For example:

dst=1:2\image.gho

In this case, Image.gho is created on the NTFS volume that 
resides on the second partition on the first disk.

tape @MTx The tape drive number. Numbers start at 0. For example:

DST=@MT0

cd/
dvdwriter

@CDx The CD or DVD writer drive number. Numbers start at 1. For 
example:

DST=@CD1

If you have a CD reader and a CD writer, in the Ghost.exe 
user interface you would see @CD1 and @ CD2. The number 
is optional if specifying an operation from the command-
line.
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The number of size switches depends on the number of partition sizes that you 
want to specify. There may be none.

SZE{E | F | L | n={xxxxM | mmP| F | V}}

Examples of clone switch usage
Table A-6 describes clone switches and their functions.

Table A-5 Destination size options for cloning

Switch Explanation

n=xxxxM Indicates that the nth destination partition is to have a size of xxxxMB 
(for example, SZE2=800M indicates partition two is to have 800 MB).

n=mmP Indicates that the nth destination partition is to have a size of mm percent 
of the target disk. Due to partition size rounding and alignment issues, 
100% physical use of disk space may not be possible.

n=F Indicates that the nth destination partition is to remain the same size on 
the destination as it was on the source. This is referred to as fixed size.

n=V Indicates that the partition may be made bigger or smaller depending on 
how much disk space is available. This is the default.

E The sizes of all partitions remain fixed.

F The sizes of all partitions except the first remain fixed. The first partition 
uses the remaining space.

L The sizes of all partitions except the last remain fixed. The last partition 
uses the remaining space.

Table A-6 Clone switch usage examples

Switch Function

ghost.exe -clone,mode=copy,src=1,dst=2 Copies local disk one to local disk 
two.

ghost.exe -lpm -clone,mode=create,src=2,dst=
c:\drive2.gho

Connects a master computer using 
LPT to another computer running 
Norton Ghost in slave mode, and save 
a disk image of local disk two to the 
remote file c:\drive2.gho. The slave 
computer can be started with 
ghost.exe -lps.
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ghost.exe -clone,mode=pcopy,src=
1:2,dst=2:1 -sure

Copies the second partition of local 
disk one to the first partition of local 
disk two, without the final warning 
prompt.

ghost.exe -clone,mode=restore,
src=e:\savedsk.gho,dst=1-sure

Restores the disk image file 
Savedsk.gho that is held on the server 
drive that is mapped locally to drive E 
onto local disk one. Performed 
without the final warning prompt. 
This example is typical of a command 
line included in a batch file to 
automate workstation installations 
from a network file server.

ghost.exe -clone,
mode=pcreate,src=1:2,dst=g:\part2.gho

Saves the second partition of disk one 
to an image file on mapped network 
drive G.

ghost -clone,
mode=prestore,src=g:\part2.gho:2,dst=1:2

Restores partition two from a two-
partition image file on mapped drive 
G onto the second partition of the 
local disk.

ghost.exe -clone,mode=restore,src=
g:\2prtdisk.gho,dst=2sze1=60P,sze2=40P

Restores disk two from an image file 
and resizes the destination partitions 
into a 60:40 allocation.

ghost.exe -clone,mode=copy,src=
1,dst=2,sze2=F

Clones a two-partition disk and keeps 
the second partition on the 
destination disk the same size as on 
the source disk, and lets the first 
partition use the remaining space, 
leaving no unallocated space.

ghost.exe -clone,
mode=create,src=1,dst=2:3\image.gho

Saves disk one to the image file 
image.gho located on the third 
partition of the second disk.

This works only if the third partition 
of the second disk is NTFS file system.

Table A-6 Clone switch usage examples

Switch Function



172 Command-line switches
-CRC32 switch usage
-CRC32 switch usage
CRC checking works file-by-file with FAT partitions. NTFS partitions are CRC-
checked within an image file by each MFT table. It is not possible at present to 
obtain a list of files failing a CRC check with an NTFS file system. When a CRC 
file is created for an NTFS partition, only a single CRC value is generated. You 
can also create a CRC file from an image file and verify it against a disk.

The full syntax for this switch is as follows:

-CRC32,action={create|verify|pcreate|pverify|dcreate|dverify},
src={{disk}|{partition}|{file}},crcfile={file}|{partition},vlist={file},vexcept={file}

ghost.exe -clone,mode=prestore,
src=2:3\image.gho:5,dst=4:2

Restores the fifth partition of the 
image file image.gho, which is located 
on the third partition of the second 
disk, to the second partition on the 
4th disk. This switch only works if the 
third partition on the second disk is 
NTFS.

ghost.exe-clone,mode=restore,
src=g:\3prtdisk.gho,dst=1,
sze1=450M,sze2=1599M,sze3=2047M

Restores disk one from an image file 
and resize the first partition to 450 
MB, the second to 1599 MB, and the 
third to 2047 MB.

ghost.exe -clone,mode=restore,src=
g:\2prtdisk.gho,dst=1,szeL

Restores a disk from an image file and 
resizes the last partition to fill the 
remaining space.

ghost.exe -clone,mode=copy,src=
2:2,dst=@MT0

Creates an image file of the second 
partition on disk 2 onto the first tape 
drive.

ghost.exe -clone,mode=pcreate,src=
2:1:4:6,dst=d:\part146.gho

Creates an image file with only the 
selected partitions.

This example selects partitions 1, 4, 
and 6 from disk 2.

Table A-6 Clone switch usage examples

Switch Function



173Command-line switches
-CRC32 switch usage
The following parameters can be used with the -CRC32 switch:

Examples of -CRC32 usage
This table provides some examples of how you can use the -CRC32 switch.

Table A-7 Parameters for the -CRC32 switches

Parameter Explanation

create Create an ASCII CRC32 file from a disk 

verify Verify a disk from a CRC32 file

pcreate Create an ASCII CRC32 file from a partition

pverify Verify a partition from an ASCII CRC32 file

dcreate Create an ASCII CRC32 file from an image file

dverify Verify an image file from an ASCII CRC32 file

crcfile ASCII CRC32 file (default=Ghost.crc)

vlist Verification list file (default=Ghost.ls)

vexcept Verification exception file (no default)

Table A-8 -CRC32 usage examples

Switch Function

ghost.exe -fcr Creates a CRC32 file (called 
Ghost.crc) while making an image 
file.

ghost.exe -fcr=d:\test.crc Creates a CRC32 file (called Test.crc) 
while making an image file.

ghost.exe -crc32,
action=create,src=1,crcfile=ghost.crc

Creates a list of files and CRC32 
values for a disk.

ghost.exe -crc32,action=dverify,src=
x:dumpfile.gho,crcfile=ghost.crc

Verifies the list against an image file.

ghost.exe -crc32,action=pverify,src=
1:2,crcfile=filename.crc:2

Verifies a partition in an image file 
with multiple partitions. This 
example verifies that partition 2 on 
disk 1 is the same as partition 2 in the 
CRC file.
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Files not checked with CRC
The switch vexcept=filename specifies files that are not checked with CRC. This is 
normally used to exclude files that are always changed on start up. A sample 
exception file follows:

[ghost exclusion list]
\PERSONAL\PHONE
[partition:1]
\WINDOWS\COOKIES\*.*
\WINDOWS\HISTORY\*
\WINDOWS\RECENT\*
\WINDOWS\USER.DAT
\WINDOWS\TEMPOR~1\CACHE1\*
\WINDOWS\TEMPOR~1\CACHE2\*
\WINDOWS\TEMPOR~1\CACHE3\*

ghost.exe -crc32,action=create Creates an ASCII CRC32 file from the 
primary hard drive. Note that the 
default disk is the primary drive. The 
default ASCII CRC32 file is Ghost.crc.

ghost.exe -crc32,action=create,src=
2,crcfile=myfile.txt

Creates an ASCII CRC32 file, 
Myfile.txt. This example uses disk 2 as 
the source drive and the output file.

ghost.exe -crc32,action=verify Verifies the contents of the primary 
disk against a default ASCII CRC32 
file, Ghost.crc (in the current 
directory). The default disk is the 
primary drive. The default 
verification list file is Ghost.ls.

ghost.exe -crc32,action=verify,src=
1,crcfile=myfile.txt,vlist=myfile.out

Verifies the contents of the primary 
disk, 1, against the CRC32 file, 
Myfile.txt. This example Myfile.out as 
the verification list file.

ghost.exe -crc32,action=verify,src=
1,crcfile=myfile.txt,vlist=myfile.out,vexcept=my
file.exc

Verifies the contents of the primary 
disk against a CRC32 file. Same as 
above with the inclusion of the 
EXCEPTION argument that excludes 
compared files based upon its entries.

Table A-8 -CRC32 usage examples

Switch Function
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\WINDOWS\TEMPOR~1\CACHE4\*
[partition:2]
*\*.1
[end of list]

The exclusion list is case-sensitive; all files should be specified in upper case. The * 
wildcard symbol follows UNIX rules, and is more powerful than the MS-DOS * 
wildcard. In particular, it matches the . as well as any other character, but other 
characters can follow the *. Therefore a wildcard of *br* matches any files 
containing the letters br, such as, Brxyz.txt, Abr.txt, and Abc.dbr.

The specification of \WINDOWS\COOKIES\*.* in the previous example means 
match all files in the \WINDOWS\COOKIES subdirectory that have extensions. 
To match all files with or without extensions, use WINDOWS\COOKIES\*.

Use short file names in exclusion files. Files specified before the first [Partition:x] 
heading are used to match files in any partition.

A directory of * matches any subdirectory, regardless of nesting. The previous 
exclusion file matches any file with an extension of .1 in any subdirectory on the 
second partition. Apart from this, use wildcards for files, not for directories.

Ghost.exe and the Virtual Partition
Ghost.exe does not see the Virtual Partition when it runs from the command line. 
The numbering of the partitions is consistent with the numbering that appears 
when you run the Ghost.exe user interface.

If you use GDisk to view the disk, the Virtual Partition is displayed with the 
volume label VPSGHBOOT. Therefore, the partition numbering that you can see 
in GDisk is not the same as the partition numbering in Ghost.exe.
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Transfer and hardware requirements
Transfer and hardware requirements
Before using Norton Ghost, consider the transfer and hardware requirements for 
the transfer method that you want to use. Ensure that all hard drives are installed 
correctly and that the BIOS of the system is configured and shows the valid 
parameters of the drives.

Peer-to-peer connections
Peer-to-peer connections enable Norton Ghost to run on two computers, 
copying drives and partitions and using image files between them.

LPT or USB connections
On an LPT/parallel port connection, use a parallel connection cable and a parallel 
port to connect the computers. For data transfer of approximately 19-25 MB/
min, Norton Ghost provides support for the Parallel Technologies universal 
DirectParallel cable. For peer-to-peer USB port connections, use a USB 1.1 cable 
that supports a host-to-host connection and a data transfer of approximately 20-
30 MB/min.

ECP is the best option for LPT connections and has a data transfer rate of 
approximately 5 MB/min. Norton Ghost must be running under DOS on both 
computers. 

See “USB and DirectParallel Cables” on page 181.

TCP/IP connections
Connect the computers with an ethernet or token ring network interface card and 
an established network connection, which includes one of the following:

■ Crossover cable 

■ Coaxial or twisted pair cable

■ Ethernet or Token Ring (Network Interface Card)

■ Ethernet or MSAU hub

Install a network interface card (NIC).
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SCSI tape drives
To use Norton Ghost with a SCSI tape device, the tape media and the tape device 
must have an Advanced SCSI Programming Interface (ASPI) driver for DOS 
installed. The driver is installed in the Config.sys file as shown in the following 
example:

device=C:\scsitape\aspi4dos.sys

The Norton Ghost wizards automatically attempt to detect and load Adaptec 
SCSI cards. If this succeeds you do not need to make any additions to Config.sys. 
If Norton Ghost does not detect the SCSI card, you can add the drivers in one of 
the following ways:

■ In the Norton Ghost wizards, in the Preferences and Options dialog box, on 
the SCSI driver settings tab.

■ In the Norton Ghost wizards, in the Preferences and Options User dialog 
box, on the User Files tab. This lets you make an addition to Config.sys.

Refer to the documentation included with the SCSI tape device for more 
information.

Removable media
The removable media drive, media, and media drivers for use in DOS are 
required.

CD/DVD usage
A CD/DVD writer and blank CD-R/RW or DVD media are required. 

See “Image files and CD/DVD writers” on page 112.
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Internal drives
To work with internal drives, ensure that each of the drives is properly 
configured. This means that if fixed IDE drives are in use, then the jumpers on 
the drives are set up correctly and the BIOS of the computer is configured for the 
disk arrangement. Both the source and the destination drives must be free from 
file corruption and physical hard drive defects.

Third-party devices
Install the DOS driver as outlined in the device documentation.
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Parallel Technologies cables
Parallel Technologies USB and DirectParallel® Universal Fast Cable provide 
high-speed data transfer and can significantly increase Norton Ghost 
performance.

USB and DirectParallel connection cables are available directly from Parallel 
Technologies.

For peer-to-peer connections, Norton Ghost supports USB 1.1 cables and USB 
1.1 controller. Some USB 2.0 controllers may work, but Norton Ghost does not 
support this configuration.

The USB and DirectParallel connection cables can also be used for high-speed 
computer-to-computer file transfer and networking in Windows 9x and 
Windows 2000. Norton Ghost contains DirectParallel driver technology from 
Parallel Technologies, Inc., the developers of the Direct Cable Connection 
computer-to-computer technology built into Windows 9x and Windows 2000. 
The DirectParallel drivers and cables contain patent-pending parallel port 
interface technology.

Other USB cables
The following USB peer-to-peer cables can also be used with Norton Ghost:

■ EzLink USB Instant Network, model 2710

■ USB LinQ Network

■ BusLink USB to USB File Transfer cable, model UFT06

■ USB Net Linq Network Bridge cable, model 2K398

■ USB Net Linq Network Bridge cable, model 00115G

Web site http://www.lpt.com

Telephone 800.789.4784 (U.S.)
425.869.1119 (International)

Fax 253.813.8730

Email sales@lpt.com
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The Wattcp.cfg configuration file 
The Wattcp.cfg configuration file contains the TCP/IP networking configuration 
details for Norton Ghost.

Wattcp.cfg is created automatically when you create a boot package using the 
Ghost Boot Wizard.

The Wattcp.cfg file specifies the IP address and the subnet mask of the computer 
and lets you set other optional network parameters. The file should be located in 
the current directory when Ghost.exe is started.

Comments in the file start with a semicolon (;). Options are set using the format 
option = value. For example:

receive_mode=5 ;set receive mode

Wattcp.cfg key words
The keywords in the Wattcp.cfg configuration file are as follows:

Table D-1 Wattcp.cfg keywords

Keyword Description

IP Specifies the IP address of the local computer. Each computer must 
have a unique IP address. Norton Ghost supports the use of DHCP 
and BOOTP servers and defaults to using them when the IP address 
is left blank or is invalid. DHCP and BOOTP provide automatic 
assignment of IP addresses to computers. This lets identical boot 
disks be used on computers with similar network cards.

Example: IP=192.168.100.10

Netmask Specifies the network IP subnet mask.

Example: NETMASK=255.255.255.0

Gateway 
(optional)

Specifies the IP address of the gateway. This option is required when 
routers are present on the network and when participating 
computers are located on different subnets.

Example: GATEWAY=192.168.100.1

Bootpto 
(optional)

Overrides the timeout value (in seconds) for BOOTP/DHCP.

Example: BOOTPTO=60
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Receive_Mode 
(Ethernet only)

Overrides the automatically configured packet driver mode used by 
Norton Ghost. The modes, in order of preference, are 4, 5, and 6. 
The default mode is 4.

Table D-1 Wattcp.cfg keywords

Keyword Description
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Supported configurations
Supported configurations
Norton Ghost can copy or clone many different Linux distributions successfully. 
However, Norton Ghost is sensitive to any possible changes in Ext2/3 file system 
and LILO specifications. If changes are made to these specifications, Norton 
Ghost may no longer support the Linux distribution. Symantec attempts to 
release new builds of Ghost promptly to address such changes. 

Norton Ghost is not sensitive to kernel versions. Use the -ial and -nolilo 
command-line switches to resolve problems with any incompatibilities.

See “Command-line switches” on page 153.

Norton Ghost copies or clones any x86-based Linux system with full support for 
Ext2/3 file systems (type 0x83) containing 1 KB, 2 KB, or 4 KB block sizes. Other 
file systems, such as reiserfs, are cloned on a sector-by-sector basis and cannot be 
resized during cloning.

Linux systems that use LILO as their boot loader in the MBR or in the active 
Ext2/3 partition are supported with some exceptions. Any references to a disk 
other than the first hard disk in the system (/dev/hda or /dev/sda) are not 
supported. The /boot and root file systems must be on the first hard disk. /boot 
can be a directory within the root file system.

Norton Ghost supports type 0 and type 1 Linux swap file systems (type 0x82).

Norton Ghost partially supports Linux extended partitions (type 0x85). It copies 
file systems inside these extended partitions, but restores them as DOS extended 
partitions. This is not known to cause problems with Linux systems after cloning.

Position of disk
Linux is sensitive to the position of the disk in hardware. A system running on the 
primary master disk does not run if the disk is mounted as the primary slave or as 
the secondary master. Norton Ghost does not resolve this issue.

Boot configuration
Norton Ghost uses the file /etc/lilo.conf to determine the boot configuration. If 
this file does not match the boot configuration, Norton Ghost may be unable to 
patch LILO during cloning. The keyword, default, is not supported in Lilo.conf, 
so the first target specified should be the default target.
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If a different boot loader, such as grub, is used, or the preceding conditions are 
not met, Norton Ghost clones the system but the new disk probably will not boot. 
The system should be started from a floppy disk or CD, and the boot loader
should be reinstalled by running /sbin/lilo or an equivalent. 

Warning: Always have a boot disk available in case of problems starting a Linux 
system after cloning.

Norton Ghost utility support
Ghost Explorer substantially supports Ext2/3 file systems within image files, 
including the restoration, deletion, and addition of files within these file systems. 
Problems arise when files that have names that are illegal on Windows are 
manipulated. Ghost Explorer cannot manipulate device files or symbolic links. 
Sparse files are expanded on restoration, and hard links are broken.

GDisk does not create any Linux file systems or recognize any partitions within a 
Linux extended partition.
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Ghost.exe error messages
A Norton Ghost error message consists of an error number, a description, and 
possibly a suggestion to remedy the problem. 

A Ghosterr.txt file is generated when an abort error occurs. 

See “Diagnostics” on page 201.

Further information is available on the Norton Ghost Technical Support Web 
site. 

See “Service and support solutions” on page 209.

Table F-1 includes some error messages that you may encounter.

Table F-1 Error message

Error code Description

10098 The partition number must be included in the command-line 
switches. 

See “Command-line switches” on page 153.

10010, 10014, 
11000

Incorrect path/file syntax. Ensure that the path and file name are 
correct. Also make sure that you have the proper user rights to read 
or create the image file.

19913 Cannot find the BOOTP/DHCP server. Ensure that the computer is 
connected to the network and that a BOOTP or DHCP server is set 
up for this subnet.

19916 Duplicate IP address detected. An IP address has been allocated that 
is already in use.

CDR101: Not 
ready reading 
drive X, Abort, 
Retry, Fail

A system error message. This error is not caused by Norton Ghost. It 
is caused by malfunctioning hardware or software configurations. 
The image file on the CD is not readable. To verify this, go into DOS 
and copy the image file off of the CD-ROM using copy verification, 
copy /v.
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Problems running Norton Ghost
Some errors may occur that do not produce an error code.

Card not found/Card not installed
This error can occur if a driver cannot find a network card installed on your 
computer. The error can occur when you start your computer with a Ghost boot 
disk or run a task in the Virtual Partition. Check the following:

■ Ensure that you selected the correct network card when you created the 
Ghost boot disk.

■ Ensure that the Plug and Play O/S setting in the BIOS does set up Plug and 
Play devices.

For example, if the setting in the BIOS is Plug and Play O/S, then the setting 
for the BIOS to set up Plug and Play devices is N. Some BIOS phrase this 
differently and require the setting to be Y. Try the generic instructions for 
accessing the BIOS included in this manual or check your computer manual 
for instructions specific to your computer.

This applies only to some cards and some BIOSs.

Creating an image on an NTFS partition
You may experience problems if you are attempting to back up in the following 
situation:

■ You have a dual-boot environment.

■ You are running Norton Ghost from a Windows 9x partition.

■ You are trying to create an image in an NTFS partition.

This cannot be achieved because of a known Windows 9x limitation of reading 
NTFS partitions.

A workaround for this is to start your computer with a Ghost boot disk and then 
run Ghost.exe to complete the backup image.

Cannot start from drive A
If your computer does not check drive A first on startup, use your computer’s 
Setup program to change its settings. 
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Be careful when you make changes using your computer’s Setup program. If you 
have never used it before, you may want to refer to your computer 
manufacturer’s documentation.

To change your computer’s settings 

1 Restart your computer.

2 A message appears telling you the key or keys to press to run Setup.

3 Press the key or keys to launch the Setup program.

4 Set the Boot Sequence to boot drive A first and drive C second.

Setup programs vary from one manufacturer to the next. If you cannot find 
the Boot Sequence option, use the Setup program’s Help system, refer to the 
documentation that came with your computer, or contact your computer 
manufacturer.

5 Save the changes, then exit the Setup program. 

Windows NT blue screen
If you are restoring, backing up, or cloning a computer onto another Windows 
NT computer with incompatible hardware, you may get a blue screen. To solve 
this problem, you must restore the computer with a previous backup image file.

Missing hibernation file
If the hibernation file is missing, the following message may appear:

Cannot hibernate because there is no hibernation file or the hibernation file has 
an error.

Recreate the hibernation files according to the instructions for your Windows 
operating system.

Computer fails to restart
If your computer fails to restart during a Norton Ghost Virtual Partition 
operation, try running the Ghreboot utility included on the Norton Ghost 
installation CD.
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To run Ghreboot.exe 

To run Ghreboot.exe if you installed Norton SystemWorks

1 Insert your Windows Startup Disk into the floppy disk drive and restart your 
computer. 

2 If you are given a restart choice, then on the boot menu select Boot with CD 
Drivers.

3 When the computer has restarted, type the following:

<drive>:\Ghost\Tools\Ghreboot

<drive> is the drive letter assigned to your CD-ROM drive.

To run Ghreboot.exe if you installed Norton Ghost only

1 Insert your Norton Ghost installation CD into your CD-ROM drive and 
restart your computer.

2 When the computer has restarted, type the following:

<drive>:\Tools\Ghreboot

<drive> is the drive letter assigned to your CD-ROM drive.

Getting out of the Virtual Partition
If your computer is in the Virtual Partition, you must use the executable 
Ghreboot to restart your computer back into Windows.

To restart your computer back into Windows

1 At the command line, type ghreboot.

2 Press Enter.

Cancelling a Ghost.exe operation
If you start a Ghost.exe operation, you can abort the process by pressing Ctrl+C. 
Be aware that this leaves the destination image file in an unknown state.

Installing and uninstalling Norton Ghost
If you are having problems installing or uninstalling Norton Ghost, providing a 
log file of the installation or uninstallation assists Technical Support in analyzing 
the problem.
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Add the following to the end of a command line to create a Logfile.txt file in the 
root directory of your computer   -  /l*v c:\logfile.txt 

See “Installing from the command line” on page 207.

To add logging to the end of a command line for Windows NT/2000/XP 
installations, use the following command line:

Msiexec.exe /i "d:\install\norton ghost.msi" /q INSTALLDIR="c:\program 
files\symantec\norton ghost 2003\"  USERNAME="Me" 
COMPANYNAME="Symantec"  /l*v c:\logfile.txt

Msiexec.exe /x "d:\install\norton ghost.msi" /q /l*v c:\logfile.txt

To add logging to the end of a command line for Windows 9x/Me and XPH 
installations, use the following command line:

d:\install\setup.exe /s /v"/l*v c:\logfile.txt"

d:\install\setup /x /s /v"/l*v c:\logfile.txt" 

Connecting using USB peer-to-peer
If you cannot connect using USB peer-to-peer, then try altering the drivers that 
are installed into the Virtual Partition.

See “Installing USB peer-to-peer drivers” on page 57.

Writing to a recordable CD or DVD
If you are having problems saving a file directly to a CD-R/RW or DVD, there are 
a number of possible solutions.

Supported CD-R/RW and DVD drives
Norton Ghost supports a large number of CD-R/RW and DVD drives. Ensure 
that your drive is listed on the following support Web site:

http://service1.symantec.com/SUPPORT/ghost.nsf/docid/2002030414141625
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Inaccessible CD-ROM drive
When writing to a compatible CD-R/RW drive, the drive may not be accessible to 
Norton Ghost. To discover whether this is a problem, check one of the following:

■ Ghosterr.txt: Ghosterr.txt is located in the same directory as the Ghost 
executable.

See “Diagnostics” on page 201.

■ Log file: A log file may have been created that can be viewed in the View Log.

See “Viewing the task log” on page 59.

IDE CD-ROM drives
To see if an IDE CD-R/RW drive is inaccessible to Norton Ghost, open 
Ghosterr.txt or the log file. 

The IDE sections are named one or more of the following:

■ IDE

■ IDE for PIO

■ IDE for UDMA 

If the word Unavailable appears under these headings, then check the following:

■ Ensure that the firmware for your CD-R/RW drive is current.

Check the Web site for the CD-R/RW drive manufacturer for the most 
current firmware.

■ Update the computer BIOS with the latest version.

The computer BIOS may not be enabled to detect the IDE drive.

■ Check the controller to which the IDE drive is attached.

The IDE drive might be attached to a controller that requires a driver for 
access. Check the documentation for the controller to determine whether 
you need to load an IDE driver when starting your computer. Drivers may be 
needed for controllers that are included on the computer’s motherboard. 

Reading and writing from a CD-R/RW drive are different processes. You 
may be able to access a CD-R/RW drive from DOS to read the drive, but not 
to write to the drive.

SCSI CD-R/RW drives
To see if a SCSI CD-R/RW drive is inaccessible to Norton Ghost, open 
Ghosterr.txt or the log file. The SCSI section is named ASPI. 
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If the word Unavailable appears under the ASPI heading, then check the ASPI 
files loaded from Config.sys. The following files must be loaded:

■ aspi2dos.sys

■ aspi4dos.sys

■ aspi8dos.sys

■ aspi8u2.sys

These drivers can be included in a task from the Advanced Settings dialog box in 
the Windows wizards.

All SCSI controllers require an ASPI driver. The listed ASPI files are sufficient for 
most SCSI controllers. The controller might require a driver that is usually 
supplied with the controller. Copy the driver to the bootable floppy disk and edit 
Config.sys to load the driver. The contoller’s documentation should include the 
correct syntax for loading the driver from DOS. If you do not have the driver, 
then contact the controller’s manufacturer.

If the correct ASPI drivers are loaded, then update the computer BIOS and the 
controller BIOS with the latest versions. 

For example, older versions of the BIOS for the Adaptec 2940 controller card are 
not compatible with Norton Ghost. 

CD-R/RW disc
The CD disc to which you are writing may have a problem. Check the following:

■ Use an unformatted CD-RW disc.

To write an image to a CD-RW disc that you have already used, use the CD-
RW utility to wipe all information off the disc, including the file system.

■ Try a second disc.

If you have tried one disc only, then you have not eliminated the possibility 
of a damaged disc. Try again, using an unused new disc.

■ Try a different brand of disc.

Some CD-R/RW drives do not work with low quality discs or specific 
manufacture of discs. Use a different brand.

■ Use a standard 650 MB CD-R/RW disc.

Norton Ghost or the CD-R/RW drive may have problems with high speed 
discs or with discs that record more information. 
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Using the correct boot disk
Do not use the CD/DVD Startup Disk with Ghost boot disk to start a computer 
when you intend to save image files to the CD-R/RW drive. If you have started 
your computer with a CD/DVD Startup Disk with Ghost boot disk, Norton 
Ghost attempts to load the CD-R/RW drivers. Loading unnecessary drivers can 
cause problems. 

Use a bootable floppy disk that contains the Ghost executable to start your 
computer.

Loading CD-R/RW drivers
You do not need to load CD-R/RW drivers when you start your computer. 
Ensure that Config.sys and Autoexec.bat on the floppy disk or installed in the 
Virtual Partition do not load CD-R/RW driver files. 

For example, Cdrom.sys and Mscdex.exe should not be loaded when the 
computer starts.

If the CD-R/RW does not appear in the list of destination drives
It can take time for Norton Ghost to identify and list the CD-R/RW drive in the 
Destination Drive window. To eliminate this as is a problem, wait five minutes to 
see if the drive appears.

Loading Ghost.exe from the floppy disk drive
If you are loading Ghost.exe from a floppy disk, a problem can be resolved by 
loading Norton Ghost from the hard drive instead. 

For example, if you are creating an image file of the first partition, copy Ghost.exe 
to the second partition. Edit Autoexec.bat to start Norton Ghost from the second 
partition as follows:

d:\ghost.exe

Do not load Ghost.exe from the partition that is being cloned.

Outdated computer BIOS
Your computer might have an old BIOS version. Try updating the BIOS.



200 Troubleshooting
Writing to a recordable CD or DVD
Outdated CD-R/RW drive BIOS
The CD-R/RW drive might have an old BIOS version. An update to the BIOS 
often fixes problems. Check the manufacturer’s Web site for an update. 

Using PC-DOS or MS-DOS
If you put PC-DOS system files on the boot disk, replace them with MS-DOS 
system files. You can choose MS-DOS while creating the boot disk.

See “Providing MS-DOS” on page 89.

High compression
Try using a lower or no compression when creating the image file.

Using third-party software to write to the CD-R/RW disc
If you are unable to write directly to a CD-R/RW disc using Norton Ghost, you 
can create the Ghost image and then use third-party software to write to the CD-
R/RW disc. 

To write an image to CD using third-party software

1 Create the Ghost image file and save it to a temporary location.

2 Collect and edit the other required files.

3 Use third-party software to save the image file and other required files to the 
CD-R/RW disk.

4 Make the CD bootable.

If you use software to write an image file directly to the CD, you may experience 
problems when restoring the image file. Software designed to write directly to a 
CD, such as Adaptec Direct CD, uses a different file format. Therefore the copied 
files are not recognized by Ghost.

If you are writing directly to a CD using third-party software, use a program that 
lays out the format of the disc before it writes it, such as Adaptec E-Z CD Creator.

Norton Ghost does not provide technical support for third-party software, but 
details on this method can be found in the knowledge base on the Symantec 
Support Web site.
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Hard drive detection and diagnostic information
Norton Ghost can generate diagnostic reports that outline the hard drive devices 
detected, other system-related information, and error conditions when they are 
detected.

View Log
If you are running tasks from the wizards, a task log may be generated. This can 
help in diagnosing problems.

See “Viewing the task log” on page 59.

Abort error file (Ghosterr.txt)
An error message consists of an error number, a description, and possibly a 
suggestion of how to remedy the problem.

The Norton Ghost abort error file includes these details along with additional 
drive diagnostics and details required to assist Technical Support in diagnosing 
the cause of the problem.

The Norton Ghost abort error file is generated when Norton Ghost detects an 
erroneous condition that Norton Ghost is unable to recover from or work 
around. The Ghosterr.txt file is generated in the current directory. If this location 
is read-only, the Ghosterr.txt file output location should be redirected. The 
location and file name of the abort file generated by Norton Ghost during an 
abort can be altered using the -afile=drive:\path\filename command-line switch.

See “Troubleshooting” on page 191.

Creating a full diagnostic statistics dump summary
A full diagnostic statistics dump summary file contains the detected hard disk 
geometry details along with other Norton Ghost statistics. The full Norton Ghost 
diagnostic statistics dump can be created using the command-line switch -dd. 
The default statistics dump file name is Ghststat.txt. You can alter the location 
and file name of a file generated by Norton Ghost by adding the 
-dfile=drive:\path\filename command-line switch. For example:

ghost.exe -dd -dfile=c:\diagnose\log.txt
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Testing TCP/IP functionality
There are several testing utilities available in the Microsoft TCP/IP application 
suite. Examples of the output of two Windows 95 TCP/IP utilities, Ping.exe and 
Winipcfg.exe, are included below. On Windows NT/2000/XP, the equivalent 
utilities are Ping.exe and Ipconfig.exe.

The Ping.exe utility shows TCP/IP networking response and can be used to show 
connectivity between computers. For a mapped network volume connection, a 
client can ping the server and vice versa to check that they have basic connectivity 
at any time.

Pinging a local host shows basic local TCP/IP functionality. The address used in 
the following example identifies the local host on the network. 

Pinging a local host
In a Windows DOS prompt dialog box on a Windows 95 computer with a 
computer name Win95PC1, the following command is entered:

c:\> ping LocalHost

This gives the following results:

Pinging Win95PC1 [127.0.0.1] with 32 bytes of data:
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128

This test indicates that the TCP/IP stack is installed and operating.
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 H
Installing Norton Ghost 
from the command line

This chapter includes the following topics:

■ Choosing an interface type for installation

■ Choosing an installation mode

■ Installing from the command line

■ Uninstalling from the command line
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Choosing an interface type for installation
Choosing an interface type for installation
Microsoft Windows Installer lets you choose the interface that you see during 
installation. If you are installing in Basic or Silent mode, you must run the 
installation from the command line. If you are using a Windows 9x or Windows 
NT computer, then you must run the installation from a setup file. 

The interface modes are as follows:

■ The Full interface mode guides you through a series of dialog boxes to install 
Norton Ghost, letting you change settings, such as selecting components and 
changing directories. This mode does not require passing parameters from 
the command line.

■ The Basic interface mode shows a progress bar and any system level error 
messages. If you alter any default settings, you must pass this information 
through as parameters from the command line. The syntax for this 
installation is as follows:

msiexec /i “c:\temp\Norton Ghost.msi” /qb

■ The Silent interface mode does not show any dialog boxes or error messages. 
If you alter any default settings, you must pass this information through as 
parameters from the command line. To install Norton Ghost, the syntax is as 
follows:

msiexec /i "c:\temp\Norton Ghost.msi" /q

Choosing an installation mode
Microsoft Windows Installer lets you choose the way you install Norton Ghost. 
Unless you choose a Normal installation, run the installation from the command 
line. The installation modes are as follows:

■ The Normal installation mode provides dialog boxes to guide you through 
installation. It lets you install Norton Ghost on the target computer by 
selecting the location and the required components.

■ The Administrative installation mode installs the entire installation package 
to a network location. All installation files are copied from the CD to the 
specified location.This lets users with access to the network location to install 
Norton Ghost from this location. This installation requires administrative 
privileges. The syntax for this installation is as follows:

msiexec /a “c:\temp\Norton Ghost.msi”
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Installing from the command line
■ The Repair installation lets you repair the current installation. It is accessed 
once Norton Ghost is installed on your computer. You can activate this by 
clicking Add/Remove Programs in the Control Panel and clicking Ghost. You 
can also run this mode from the command line. The syntax is as follows:

msiexec /f “c:\temp\Norton Ghost.msi”

The switch /fa reinstalls all files, /fu rewrites all required user registry entries, 
and /fs overwrites any existing shortcuts.

Installing from the command line
You can specify parameters when installing Norton Ghost from the command 
line by setting installer packages. The syntax for these packages is as follows:

msiexec /i “c:\temp\Norton Ghost.msi” /q PROPERTY = VALUE

The property name must be in upper case, and the value is case-sensitive.

On Windows 2000/XP computers, Msiexec.exe is in the path by default, so it can 
be called from any directory. On Windows NT computers with Installer V2 
installed, Msiexec.exe is in the path by default. On Windows 9x computers, 
Msiexec.exe is not in the path. It is always located in the Windows\System 
directory on Windows 9x systems, and in Winnt\System32 on Windows NT 
systems.

If you are not running Windows XP and you do not have Windows Installer V2 
installed, then the installation must be performed through a setup file. Setup.exe 
is located in the same directory as Norton Ghost.msi. 

If you are installing in Administration mode, you do not need to set these 
properties as you are copying the installation package to a location on the 
network. Set these properties once you run the installation from the network 
location.

Table H-1 shows the package properties that can be set from the command line.

Table H-1 Package properties

Property Default value Description

INSTALLDIR Program 
files\Symantec\Ghost

Destination directory

USERNAME Registered user User name

COMPANYNAME Registered company Company name
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Table H-2 contains the switches that can be used with Setup.exe.

The /v switch is used to pass the parameters to the installation. All of the 
parameters must be enclosed in quotation marks and the opening quotation 
mark must immediately follow the /v switch. Any other quotation marks must be 
preceded by a backslash.

The following command line installs Norton Ghost in a specified folder, 
registering Norton Ghost with the user name in silent mode:

setup.exe /v"USERNAME=\"Me\" INSTALLDIR=\"c:\temp\" /qn"

Uninstalling from the command line
You can uninstall Norton Ghost from the command line using Microsoft 
Installer.

To uninstall Norton Ghost from the command line

◆ In DOS, type the following command:

Msiexec /x "<path to msi package> \Norton Ghost.msi” 
[/q or /qb]

The switches /q and /qb are optional.

See “Installing from the command line” on page 207.

Table H-2 Setup.exe switches

Switch Description

/s Runs installation in Silent installation mode

/a Runs installation in Administrative installation mode

/s Runs installation in Silent installation mode

/x Uninstalls the application
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Service and support 
solutions

Service and support information is available from the Help system of your 
Symantec product. Click the Service and Support topic in the Help index.

Technical support
Symantec offers two technical support options:

■ Online Service and Support

Connect to the Symantec Service & Support Web site at
http://service.symantec.com, select your user type, and then select your 
product and version. This gives you access to current hot topics, knowledge 
bases, file download pages, multimedia tutorials, contact options, and more.

■ PriorityCare telephone support

PriorityCare fee-based telephone support services are available to all 
registered customers. You can access the PriorityCare number for your 
product through the Service & Support Web site. You’ll be led through the 
online options first, and then to the telephone contact options available for 
your product and version.

Support for old and discontinued versions
When a new version of this software is released, registered users will receive 
upgrade information in the mail. Telephone support will be provided for the old 
version for up to twelve months after the release of the new version. Technical 
information may still be available through the Service & Support Web site (http:/
/service.symantec.com).
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Customer service
When Symantec announces that a product will no longer be marketed or sold, 
telephone support will be discontinued 60 days later. Support will be available for 
discontinued products from the Service & Support Web site only.

Customer service
Access customer service options through the Service & Support Web site at http:/
/service.symantec.com. From this site, you can receive assistance with non-
technical questions, and for information on how to do the following:

■ Subscribe to the Symantec Support Solution of your choice.

■ Obtain product literature or trialware.

■ Locate resellers and consultants in your area.

■ Replace missing or defective CD-ROMS, disks, manuals, and so on.

■ Update your product registration with address or name changes.

■ Get order, return, or rebate status information.

■ Access customer service FAQs.

■ Post a question to a Customer Service representative.

For upgrade orders, visit the online upgrade center at:
http://www.symantecstore.com

Worldwide service and support
Technical support and customer service solutions vary by country. For 
information on Symantec and International Partner locations outside of the 
United States, please contact one of the service and support offices listed below, 
or connect to http://service.symantec.com and select your region under the 
Global Service and Support.
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Worldwide service and support
Service and support offices

North America

Symantec Corporation
555 International Way
Springfield, OR 97477
U.S.A.

http://www.symantec.com/

Argentina and Uruguay

Symantec Region Sur
Cerrito 1054 - Piso 9
1010 Buenos Aires
Argentina

http://www.service.symantec.com/mx
+54 (11) 5382-3802

Asia/Pacific Ring

Symantec Australia
Level 2, 1 Julius Avenue
North Ryde, NSW 2113
Sydney
Australia

http://www.symantec.com/region/reg_ap/
+61 (2) 8879-1000
Fax: +61 (2) 8879-1001

Brazil

Symantec Brasil
Market Place Tower
Av. Dr. Chucri Zaidan, 920
12° andar
São Paulo - SP
CEP: 04583-904
Brasil, SA

http://www.service.symantec.com/br
+55 (11) 5189-6300
Fax: +55 (11) 5189-6210

Europe, Middle East, and 
Africa

Symantec Customer Service 
Center
P.O. Box 5689
Dublin 15
Ireland

http://www.symantec.com/region/reg_eu/
+353 (1) 811 8032
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Subscription policy
Subscription policy
If your Symantec product includes virus, firewall, or web content protection, you 
might be entitled to receive protection updates via LiveUpdate. The length of the 
subscription could vary by Symantec product.

When you near the end of your subscription, you will be prompted to subscribe 
when you start LiveUpdate. Simply follow the instructions on the screen. After 
your initial subscription ends, you must renew your subscription before you can 
update your virus, firewall, or web content protection. Without these updates, 
your vulnerability to attack increases. Renewal subscriptions are available for a 
nominal charge.

Every effort has been made to ensure the accuracy of this information. However, 
the information contained herein is subject to change without notice. Symantec 
Corporation reserves the right for such change without prior notice.

January 15, 2002

Mexico

Symantec Mexico
Blvd Adolfo Ruiz Cortines,
No. 3642 Piso 14
Col. Jardines del Pedregal
Ciudad de México, D.F.
C.P. 01900
México

http://www.service.symantec.com/mx
+52 (5) 661-6120

Other Latin America

Symantec Corporation
9100 South Dadeland Blvd.
Suite 1810
Miami, FL 33156
U.S.A.

http://www.service.symantec.com/mx



Glossary
boot disk A disk that contains the Norton Ghost executable and any necessary drivers. 
You start a computer from the boot disk and start Norton Ghost to perform 
a cloning operation. Any drivers required to run supported hardware can be 
saved onto the boot disk.

cloning Creating a replica of a specified hard disk of a computer.

command line The direct DOS interface that lets you type commands to be executed.

create To copy the contents of a hard disk or partition to an image file. This 
includes the disk system area (for example, the partition table) and the data 
contents. To create an image file of a computer. In Norton Ghost, this 
equates to the terms backup and dump.

DHCP Dynamic Host Configuration Protocol. This program is used on client-
server networks, as opposed to peer-to-peer networks. When a network uses 
DHCP, the network includes a DHCP server that automatically assigns IP 
addresses to computers on the network as needed. Each time that a 
computer disconnects from the network and then reconnects, the DHCP 
server assigns a new IP address. Most client-server networks have either a 
DHCP server or a Bootp server. Bootp is a program that performs the same 
function as DHCP. When a computer is not on a network, or the network 
does not have a DHCP server or similar server, then the computer uses a 
static IP address. The computer static IP address does not change until is it 
changed manually. A static IP address is retained during a system restart.

DOS Disk Operating System. DOS can be run from within Windows from a 
command shell, but you cannot run Norton Ghost from a command shell. 
A Windows 9x computer can be restarted into DOS. Windows NT/Me/XP/
2000 computers cannot be restarted into DOS except with the use of a boot 
disk containing DOS.

dump See create.

dynamic disk A proprietary disk partitioning structure used by Microsoft Windows 2000/
XP. Dynamic disks can be created and deleted within the operating system 
without having to reboot. Dynamic disks cannot be accessed by other 
operating systems.
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external mass storage device A device that is attached to your computer with a network or cable. that is 
capable of storing large amounts of data. For example, a hard disk attached 
to a computer with a USB or FireWire cable. 

hard disk A physical disk in your computer or attached as a external device.

image file A file created using Norton Ghost. An image file of a disk or partition is 
created and is used to create exact duplicates of the original disk or 
partition.

IP address Internet Protocol Address. This term refers to a number that uniquely 
identifies a computer on a network or on the Internet. IP addresses for 
computers on a client-server network might change daily or more often. 
The address for a computer must be unique within a network.

load See restore.

native copy Copies only the disk structure information and the files, rather than all 
sectors on the disk. In addition, on FAT partitions, native cloning saves the 
files contiguously. That is, when you write the image to the destination 
drive, the files are no longer fragmented.

NIC Network Interface Card. The NIC is a physical device inside a computer 
which coordinates communications between the computer and a network

partition A divided part of a hard disk. An operating system sees a partition as a 
separate disk if it recognizes the file system.

primary partition A hard disk can contain up to four primary partitions, or up to three 
primary partitions and one extended partition. Most hard disks have this 
partitioning structure.

restore Overwrite all existing data on a computer either with an image file or 
directly with a copy of another computer. To write information to a disk or 
partition. In Norton Ghost, this equates to the term load.

sector copy A copy of an entire disk, including the boot track, all sectors, and 
unpartitioned space. A sector copy does not filter extraneous or erroneous 
information from the boot track. 

Virtual Partition A partition that is created when you perform a backup, restore, clone, or 
other Norton Ghost operation from Windows. The Ghost operation is 
performed from the Virtual Partition.
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Symbols
? switch 158
@filename switch 154

A
abort log 155, 192, 202
abort operation 195
advanced options 46
afile=filename switch 155
ASPI driver 157, 158, 161, 164, 179
auto switch 155
Autoexec.bat 56
automation

clone switch and examples 166, 170-172
close on completion 158
quiet mode 162
remove confirmation 163
restart on completion 162
version checking 165

B
back up

to a CD-R/RW 113
backup

Ghost.exe 97, 99
Norton Ghost 36

Backup Wizard 17, 36
bad sectors 155, 158
batch switch 155
bfc=x switch 155
BIOS 159, 193, 199
blue screen 194
boot

menu 138
sector 158
track 158

boot disk 72, 75, 94, 199, 213
creating 72, 74
files included 73
PC-DOS 73
setup 72

bootable CD 155
bootcd switch 155
buffersize switch 155

C
cables 182
cancel operation 195
CD drive

assign a drive letter 47
drive letter 47

CD writers 112, 113
CD-R/RW

back up to 113
making bootable 155
supported 112
writing to 76

CD-ROM 179
opening 29
support 81

Cdrom.sys 199
chkdsk 161
chkimg,filename switch 155
clone 39, 213

compression 63
Ghost.exe 104
speed 62, 63
switch 155, 166
Windows 2000 68

clone switch 155
Clone Wizard 17, 39
cns switch 155
command line 47

examples 170-174
text file 154
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compression 62, 63, 97, 200
computer

restarting in Windows 58
computer identification

details 147
Config.sys 56
conversion

file system 157
copy command 166
CRC 157
CRC32 switch 63, 157, 172
crcignore switch 156
creating

partition 131
cvtarea switch 156

D
data checking 63
data compression 62
dd switch 156
defaults 46
deleting, partitions 135
DHCP 54
diagnostics 202-203
disaster recovery warning 48
disk

backup 36
clone 39
dynamic 68
large 142
marking 94
restore 37
status 133

DOS 200
boot disk 73
IBM DOS 73
MS-DOS 73, 89
PC-DOS 89
version 49

drive letters
mapping 54

drive, large 64
drivers 53
dst switch 169
dump

command 166
log file 156

DVD
supported media 112
writing to 112

dynamic disks 68

E
error log file 155
extended disk access 157

F
FAT clusters 155
FAT file system See file system
fatlimit switch 157
fcr switch 157
femax switch 157
ffi switch 157
ffs switch 157
ffx switch 157
file system

FAT partition id 157
FAT12 118
FAT16 118, 157

Windows NT 135, 157
FAT32 118, 156

conversion from FAT16 157
Linux Ext2/3 118, 132
NTFS 156, 161

partition 193
resizing 157

file-by-file copy 161
files, skipping 163
finger switch 158
fingerprint 36, 37, 39, 158
FireWire drivers 54
firmware 197
fis switch 158
fni switch 158
fns switch 158
fnx switch 158
fro switch 158
fx switch 158
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G
GDisk 128

batch mode 134
large hard disks 142
switches 129-141

GDisk32 128
modifying boot menu 138

Ghost Boot Wizard 17
starting 74
writing to a CD 112

Ghost Explorer 22
command line 123
switches 123

Ghost Walker 146
command line 148
switches 148

Ghost.exe 22, 92
cancelling 195
starting 59

Ghost.exe operation 94
Ghosterr.txt. See abort log
Ghreboot.exe 57, 58

restart
Windows 195

GoBack 67

H
h switch 158
hard disk

active 129
batch 129
creating 129
deleting 129, 135
entire copy 159
hiding partitions 129
large drives 142
MBR 129
number of 157
space 158
status 129
wiping 135

hibernation file 69, 194
hiding partitions 137

I
ia switch 158

ial switch 158
ib switch 158
id switch 159
IDE hard disk 157
image file

description 159
integrity check 51, 58
naming 160
password 46
spanned 160
verifying 58

image files 214
CD writers 112
compression 62, 98
crc. See CRC32
creating 65, 104

insufficient space 65
description 159
extracting 120
file list 121
integrity 155
loading 65
lock 160
modification 120
multisegment 155, 163
password 161
restoring 119, 120
selection box 160
size limited 64
split. See image files, size limited
standard 63
tape drives 66
viewing contents 119

image files, spanned 63, 64-65, 121, 155, 163
information window 48
INT13 support 158
integrity

volume 161
integrity check 51, 58
internal drives 180
ir switch 159

J
jl x=filename switch 159
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L
large drives 64
LILO boot loader 161
Linux 93, 105, 118, 132, 158
load command 166
lockinfo switch 159
locktype=type switch 160
log file 59, 155
lpm switch 160
lps switch 160
LPT

drivers 55
peer-to-peer 95, 160
port 79, 178

M
map a drive 47
map a drive letter 47
mapping network drives 47, 82
master mode 95, 164
MBR 161

reinitializing 130
memcheck switch 160
mode switch 166
Mscdex.exe 199
MS-DOS 49, 73, 89, 200

uninstalling 90
multicast 79

N
network drives, mapping 82
network, performance 63
noauto switch 160
nofile switch 160
nolilo switch 161
Norton Ghost

adding command-line switches 47
display options 48
fingerprint 158
starting 34
starting from Virtual Partition 57

noscsi switch 161
ntchkdsk switch 161
NTFS See file system
ntic switch 161

ntiid switch 161
ntil switch 161

O
options 47
options, Norton Ghost 48
or switch 161

P
parallel port transfer

automation 160, 165
setup 95

partition 128
backup 36
cloning 39, 106
cloning mirrored 161
creating 131, 158
extended 157
extended partition tables 159
FAT id 157
hiding 137
restore 37
size 164
status 133

password 46, 145, 146, 161
PC-DOS 49, 89, 200
pcopy command 166
pdump command 166
peer-to-peer 55, 95

connections 178
TCP/IP 54

performance network 63
ping utility 203
pload command 166
pmbr switch 161
procedures

disk cloning 104
from image file 102
to disk 105
to image file 98

partition cloning 106
from image file 103
to image file 99
to partition 106

pwd, -pwd=x switch 161
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Q
quiet switch 162

R
RAID 68, 161
rb switch 162
rebooting 195
restore

Ghost.exe 101, 103
Norton Ghost 37

Restore Wizard 37

S
script switch 162
SCSI 161

drivers 53, 157, 158
Adaptec 77

tape
drives 66
setup 179
switches 164

sector, bad 155, 158, 165
sector-by-sector copy 158
Service and Support 209
setup 180

See also SCSI tape
signature bytes 157
skip=x switch 163
skipping files 69
slave mode 95, 165
source switch 167
span switch 163
spanning 64-65, 68

avoiding user prompt 155
list of drives to search 157
naming 155, 160
override 161
to a CD-R/RW 113

split=x switch 163
starting in 57
sure switch 163
swap files 69
sze switch 170

T
tape block size 164
tape drives 66, 164
tape speed 164
tapebsize switch 164
tapebuffered switch 164
tapeeject switch 164
tapesafe switch 164
tapespeed=x switch 164
tapeunbuffered switch 164
task log 59
TCP/IP 79, 164, 165, 178

drivers 54
peer-to-peer 95

tcpm switch 164
tcps switch 165
Technical Support 209
tray icon 48

U
update

SID 147
updating

computer name 147
USB

drivers 54
peer-to-peer 95
port 178
support 79

usb switch 165
usbm switch 165
usbs switch 165

V
vdw switch 165
ver switch 165
verify 165
vexcept switch 174
Virtual Partition 15, 49, 52, 57, 193, 195
volume integrity 161
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W
Windows

2000 68
boot menu 138
running Ghost.exe 94

wiping
disks 135
partitions 135

writing to a CD-R/RW 112, 113

Z
z switch 165



Norton Ghost™
CD Replacement Form

FOR CD REPLACEMENT

Please send me:    ___ CD Replacement

Name __________________________________________________________________________________________________

Company Name __________________________________________________________________________________________

Street Address (No P.O. Boxes, Please)_________________________________________________________________________

City_________________________________________________________ State _______ Zip/Postal Code _________________

Country* ___________________________________________Daytime Phone _______________________________________

Software Purchase Date ____________________________________________________________________________________

*This offer limited to U.S., Canada, and Mexico. Outside North America, contact your local Symantec office or distributor.

Briefly describe the problem: ________________________________________________________________________________

FORM OF PAYMENT ** (CHECK ONE):

___  Check (Payable to Symantec)  Amount Enclosed  $ _________ __ Visa       __ Mastercard      __  AMEX

Credit Card Number _____________________________________________________________________ Expires __________

Name on Card (please print) ____________________________________ Signature ___________________________________

**U.S. Dollars. Payment must be made in U.S. dollars drawn on a U.S. bank.

MAIL YOUR CD REPLACEMENT ORDER TO:
Symantec Corporation

Attention:  Order Processing

555 International Way

Springfield, OR 97477 (800) 441-7234

Please allow 2-3 weeks for delivery within the U.S.
Symantec and Norton Ghost are trademarks of Symantec Corporation.
Other brands and products are trademarks of their respective holder/s.
© 2002 Symantec Corporation. All rights reserved. Printed in the U.S.A.

CD REPLACEMENT: After your 60-Day Limited Warranty, if your CD becomes unusable, fill out and return 1) this form, 2)
your damaged CD, and 3) your payment (see pricing below, add sales tax if applicable), to the address below to receive
replacement CD. DURING THE 60-DAY LIMITED WARRANTY PERIOD, THIS SERVICE IS FREE.  You must be a registered
customer in order to receive CD replacements.

CD Replacement Price   $ 10.00
Sales Tax (See Table) ______
Shipping & Handling $   9.95

TOTAL DUE ______

SALES TAX TABLE: AZ (5%), CA (7.25%), CO (3%), CT (6%), DC (5.75%), FL (6%), GA (4%), IA (5%), 
IL (6.25%), IN (5%), KS (4.9%), LA (4%), MA (5%), MD (5%), ME (6%), MI (6%), MN (6.5%), MO 
(4.225%), NC (6%), NJ (6%), NY (4%), OH (5%), OK (4.5%), PA (6%), SC (5%), TN (6%), TX (6.25%), 
VA (4.5%), WA (6.5%), WI (5%). Please add local sales tax (as well as state sales tax) in AZ, CA, FL, GA, 
MO, NY, OH, OK, SC, TN, TX, WA, WI. 


	Norton Ghost™ User’s Guide
	Contents
	1. About Norton Ghost
	Introducing Norton Ghost
	What’s new in Norton Ghost 2003
	How Norton Ghost works
	Virtual Partition
	Hardware restrictions
	Preparing for an emergency

	Norton Ghost components
	Norton Ghost wizards
	Norton Ghost executable
	Ghost Boot Wizard
	Ghost Explorer
	GDisk
	Ghost Walker


	2. Installing Norton Ghost
	Minimum system requirements
	Ghost.exe
	CD and DVD writing
	Supported backup media
	File systems supported for backup, restore, and cloning tasks
	Disaster recovery requirements

	Installing Norton Ghost
	Installing Norton Ghost if purchased with Norton SystemWorks Pro
	Installing Norton Ghost
	If the opening screen does not appear
	Registering Norton Ghost

	Updating Norton Ghost
	Uninstalling Norton Ghost

	3. Backing up, restoring, and cloning from Norton Ghost
	When to use Norton Ghost in Windows
	Starting Norton Ghost in Windows
	Starting Norton Ghost from the tray icon

	Creating a backup image file
	Restoring your computer from an image file
	Cloning a hard disk or partition
	Launching Ghost.exe peer-to-peer
	Identifying a hard disk

	4. Setting options and defaults
	Setting Norton Ghost options and defaults
	Adding command-line switches to a task
	Assigning a drive letter to a CD/DVD drive
	Setting the options for a mapped network drive
	Setting display options
	Setting the DOS version
	Setting the image integrity check default
	Setting a compression level
	Assigning a password to an image file
	Adding free space to the Virtual Partition
	Installing SCSI drivers
	Setting external storage device drivers
	Setting TCP/IP drivers
	Setting LPT peer-to-peer drivers
	Installing extra drivers
	Installing USB peer-to-peer drivers

	Running your computer from the Virtual Partition
	Restarting your computer from the Virtual Partition

	Checking the integrity of an image file
	Viewing the task log
	Starting Ghost.exe
	What to do if a task fails

	5. Image file options
	About Norton Ghost image files
	Image files and compression
	Performance expectations on a network

	Image files and CRC32
	Image files and volume spanning
	Standard image files
	Limitations on the image file size
	Size-limited image files
	Spanned image files
	Spanning across multiple volumes and limiting span sizes
	Restoring from a spanned image

	Image files and tape drives
	GoBack and Norton Ghost
	GoBack and Ghost.exe

	Dynamic disks in Windows 2000/XP
	Hibernation and swap files

	6. Creating boot disks with the Ghost Boot Wizard
	Introducing the Norton Ghost Boot Wizard
	What is a Ghost boot disk
	When to create a Ghost boot disk
	How to use a Ghost boot disk
	Files included on a Ghost boot disk
	When to include MS-DOS on a boot disk

	Creating a recovery boot disk
	Opening the Ghost Boot Wizard
	Creating boot disks and boot images
	Standard boot disks
	Boot disks with network support
	Boot disks with CD-ROM and DVD support
	Boot disks with drive mapping network support

	Selecting a template
	Multicard templates and the boot disk
	Adding network drivers to the Ghost Boot Wizard
	Adding packet drivers to the Ghost Boot Wizard
	Adding NDIS2 drivers to the Ghost Boot Wizard
	Customizing the template

	Adding command-line parameters to a boot package
	Providing MS-DOS

	7. Backing up, restoring, and cloning from DOS
	An overview of using Ghost.exe
	Starting the Norton Ghost executable
	Marking your disks

	Navigating without a mouse
	Establishing a peer-to-peer connection with Ghost.exe
	Creating a backup image file
	Backing up a hard disk to an image file
	Backing up a partition to an image file

	Restoring from an image file
	Restoring a hard disk from an image file
	Restoring a partition from an image file

	Cloning disks and partitions
	Cloning disk to disk
	Cloning partition to partition

	Verifying image integrity
	Adding switches to your Ghost operation

	8. Backing up and restoring with CD-R/RW and DVD- R/RW
	Image files and CD/DVD writers
	Saving an image file directly to a CD-R/RW or DVD- R/RW drive
	Saving an image file to an unsupported CD-R/RW or DVD-R/RW drive
	Splitting an image file during a backup


	9. Using Ghost Explorer to modify image file contents
	Understanding Ghost Explorer
	Viewing image files
	Launching a file
	Extracting a file or directory from an image file
	Modifying image files in Ghost Explorer
	Adding, moving, and deleting files

	Listing the contents of an image file
	Setting span file sizes
	Splitting an image file
	Compiling a file
	Determining Norton Ghost image file version
	Using Ghost Explorer from the command line
	Using Ghost Explorer with long file names


	10. Managing partitions using GDisk
	Introducing GDisk
	Running GDisk
	Overview of main command-line switches
	Online Help for command-line switches
	Switches common to all GDisk commands

	Creating a partition
	Reinitializing the Master Boot Record
	Showing information about disks
	Performing multiple GDisk operations using batch mode
	FAT16 partitions in Windows NT
	Deleting and wiping your disk
	Activating or deactivating a partition
	Hiding or unhiding a partition
	Modifying the Windows NT/2000/XP boot menu
	Specifying the boot.ini path and file name
	Displaying the list of current boot entries
	Adding an entry to Boot.ini
	Removing an entry from Boot.ini
	Setting the default boot option and timeout

	Support for Large Hard Disks

	11. Updating Security Identifiers (SIDs) and computer names
	Making SID changes with Ghost Walker on Windows NT-based clients
	Norton Ghost Walker capabilities
	Norton Ghost Walker limitations
	SID changing limitations

	Loss of access to external data objects
	Identical user names and passwords across workstations
	Using Ghost Walker
	Running Ghost Walker from the command line


	A. Command-line switches
	Using Norton Ghost with switches
	Command-line switches
	Clone switch usage
	Defining the type of clone command
	Setting a source for the clone switch
	Setting a destination for the clone switch
	Setting a destination size for the clone switch
	Examples of clone switch usage

	-CRC32 switch usage
	Examples of -CRC32 usage
	Files not checked with CRC

	Ghost.exe and the Virtual Partition

	B. Transfer methods and hardware setup
	Transfer and hardware requirements
	Peer-to-peer connections
	SCSI tape drives
	Removable media
	CD/DVD usage
	Internal drives
	Third-party devices


	C. USB and DirectParallel Cables
	Parallel Technologies cables
	Other USB cables

	D. The Wattcp.cfg network configuration file
	The Wattcp.cfg configuration file
	Wattcp.cfg key words

	E. Cloning with Linux
	Supported configurations
	Position of disk
	Boot configuration
	Norton Ghost utility support

	F. Troubleshooting
	Ghost.exe error messages
	Problems running Norton Ghost
	Card not found/Card not installed
	Creating an image on an NTFS partition
	Cannot start from drive A
	Windows NT blue screen
	Missing hibernation file
	Computer fails to restart
	Getting out of the Virtual Partition
	Cancelling a Ghost.exe operation
	Installing and uninstalling Norton Ghost
	Connecting using USB peer-to-peer

	Writing to a recordable CD or DVD
	Supported CD-R/RW and DVD drives
	Inaccessible CD-ROM drive
	CD-R/RW disc
	Using the correct boot disk
	Loading CD-R/RW drivers
	If the CD-R/RW does not appear in the list of destination drives
	Loading Ghost.exe from the floppy disk drive
	Outdated computer BIOS
	Outdated CD-R/RW drive BIOS
	Using PC-DOS or MS-DOS
	High compression
	Using third-party software to write to the CD-R/RW disc


	G. Diagnostics
	Hard drive detection and diagnostic information
	View Log
	Abort error file (Ghosterr.txt)
	Creating a full diagnostic statistics dump summary

	Testing TCP/IP functionality

	H. Installing Norton Ghost from the command line
	Choosing an interface type for installation
	Choosing an installation mode
	Installing from the command line
	Uninstalling from the command line

	Service and support solutions
	Glossary
	Index
	CD Replacement Form



